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Chapter 1

Introduction to SALSA

Welcome to SALSA! This short chapter introduces SALSA and the problem domain it
is intended to address.

What is SALSA? Well, it could be a delicious spicy tomato-based sauce, or it may refer
to an energetic Afro-Cuban inspired type of dance, but in this case SALSA stands
for the Surveyor’s Applications for Least Squares Adjustment. (Please accept our
apologies if that’s not what you were hoping for in this user guide.) A “survey,” in
very general terms, is a set of spatial measurements that are conducted in order to
estimate the relative positions of some number of physical locations, or points. These
spatial measurements may include distances, vertical and horizontal angles, height
differences, and 3-D vectors as can be obtained using Global Navigation Satellite
Systems (GNSS) data.

The surveyor develops a plan for the collection of these measurements with the ob-
jective of obtaining that data which are sufficient to estimate the relative positions
of points of interest to a level of precision and a level of confidence as mandated by
the particular application. In general, this plan will include redundancy, for three
reasons. First, repeated measurements of the same quantity (e.g., a distance be-
tween two points) will improve the precision of one’s estimate of that quantity, per
the central limit theorem. Second, redundant measurements equip us to gauge the
self-consistency of the measurements and therefore to make assertions about the un-
certainties in our final solution. Third, redundancy in our measurement design allows
us to identify highly discrepant measurements, i.e., blunders, so that we can correct
the blunder or exclude it from our solution.

The fact that a survey will include redundancy, and the fact that all measurements
include some error, means that our measurements will not agree exactly. We need
a strategy to arrive at a solution (estimates of the locations of our points) that is a
“best fit” to our measurement data. This raises two important questions: how are
dissimilar measurement types combined, and what constitutes a “best fit?”

The short list of measurement types mentioned above vary in dimensionality, e.g.,

1



2 CHAPTER 1. INTRODUCTION TO SALSA

distances which are 1-dimensional vs. GNSS vectors which are 3-dimensional, as
well as in their native frames of reference, e.g., vertical or zenith angles which are
measured relative to the local gravity vector vs. GNSS vectors which are computed
and expressed in an Earth-centered Earth-fixed (ECEF) Cartesian reference frame. We
must decide on a common reference frame and then work through the math to express
these measurements in this common frame – a process of rotation and linearization.
Once we build a linear set of equations describing our measurement network, we
develop a solution using the principles of least squares. That is, we minimize the
sums of the squares of our (weighted) measurement residuals. The optimality of the
least squares solution is well known, dating to work by Carl Gauss in the early 1800s.
Hence, linearized least squares is in fact the strategy to achieve that “best fit” in our
complicated nonlinear survey problem.

While the fundamental principles of least squares have not changed in over 200 years,
our technology sure has. Even one generation ago, desktop computers were not pow-
erful enough to compute 3-D least squares solutions for large networks (i.e., hundreds
of points). Instead, adjustments were often reduced to 2-D horizontal solutions and
separate 1-D vertical solutions which were then combined in some fashion. The ad-
vent of GPS (yielding inherently 3-D information) and advances in computing power
have changed the landscape such that today any modern, rigorous, geodetic least
squares adjustment software should execute the solution in 3-D. SALSA does so, us-
ing the Earth-centered Earth-fixed (ECEF) Cartesian frame. The WGS 84 ellipsoid
parameters are used for all conversions between geodetic (latitude, longitude, ellip-
soid height) and Cartesian (X, Y, Z) expressions of coordinates. Chapter 4 goes into
more detail on how the core LSA solver in SALSA, called lsasolver, operates.

Before we leave this short introductory section, we acknowledge there are many useful
references on least squares and geodetic surveying, but there is one in particular that
we have found very comprehensive and well written: Adjustment Computations by
Charles Ghilani ([1]). We will cite it often, and we commend it to our readers who wish
to gain a deeper understanding of the principles of geodetic least squares adjustment.

Approved for public release, NGA-U-2025-01219



Chapter 2

SALSA Components and
Installation

“SALSA” is a collection of programs that work together to enable users to execute the
geodetic least squares adjustment process. This chapter introduces these programs
and provides a brief explanation of how they work together. This chapter also explains
how to install SALSA on your computer.

2.1 SALSA Components

A graphical user interface (GUI) called salsa is the primary interface to this software
suite, and the authors’ vision is that most users will only interact directly with this
program. That said, some users may find cases when it is convenient or even nec-
essary to execute some of the other programs directly, using their command-line
interfaces (CLIs). Even if you have no intentions of running CLI applications, under-
standing a little bit about what each one does and how the salsa GUI interacts with
them will be very helpful in understanding how the overall process works and equip
you to troubleshoot when something fails.

Figure 2.1 illustrates the SALSA programs and some of the files that represent in-
terfaces between them. Programs are represented as boxes with the program names
in them (in Microsoft Windows these executable files will have .exe extensions), and
files are represented as document icons (boxes with wavy lines forming their lower
edge) with the three-letter extensions that are typically used in naming each of these
file types.

As noted earlier, salsa is the main GUI program that will be the focus of most users’
interactions. The GUI writes to – and reads from – a project file (.proj) that fully de-
scribes the least squares problem (either alone or by including references to other
.lsa files). The .proj and .lsa formats are identical; .proj is simply chosen

3



4 CHAPTER 2. SALSA COMPONENTS AND INSTALLATION

Figure 2.1: Components of the SALSA suite.
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2.1. SALSA COMPONENTS 5

as a convention to signify the main project file. See Chapter 12 for details on the
.lsa/.proj file format. The emphasis of Chapter 3 is how to use salsa to build and
manipulate the least squares project (i.e., the .lsa files).

Once the least squares problem is set up, and the user initiates a solution, several CLI
applications are executed in the background. The first of these is lsapreprocessor (LSA
pre-processor). This application ‘flattens’ the input .lsa files (which are relatively
easy for a human to read and edit) into a single .dat file (which is more difficult for
a human to read or edit but easy for a computer). The main least squares solver
application (lsasolver) is then called with the dat file as its input. The solver produces
two important output files: a binary file (.bin) containing the LSA solution state, and
a log file with a .out extension.

The .bin file is not human-readable, and in fact is a custom format that only the salsa
applications can read and write. However, the application lsapost ingests the contents
of the .bin file, along with information from the .dat and .out files, and creates
a more user-accessible output file adhering to the Hierarchical Data Format (HDF)
standard with a .h5 extension. Refer to Section 2.3 for instructions on obtaining a
viewer for this file.

The .h5 file has another important ‘audience’ which is the GUI. The salsa GUI reads
output from the .h5 file to provide feedback to the user and help him or her under-
stand the results of the network adjustment.

Finally, each time a salsa project is processed, Python scripts read the .h5 file and
create two additional output files: a comma-separated values file (.csv), and a simple
text file listing the adjusted coordinates (extension .pts). The .csv file can be opened
in a spreadsheet program to support analyses outside of SALSA and/or for copying
and pasting results into a publication, and the .pts file facilitates quick review of
the adjusted coordinates each time a solution is generated. Additional scripts may be
developed and deployed to produce other reports using the .h5 file as the source.

To this point, we have been outlining a linear process that starts with the user work-
ing with the salsa interface to build and manipulate the project as captured in .lsa
format. Another important part of most users’ workflows will be introducing measure-
ment data that are stored in other formats. At time of writing, many of our users have
measurement data stored in the .iob format which is used by the program GeoLab.
Therefore SALSA includes a CLI application called iob2lsa that can be invoked from
the salsa GUI to convert .iob files to .lsa format. Several other converters are bun-
dled with SALSA to provide direct conversion from vendors’ instrument formats into
.lsa; see the appendix “Conversion of Instrumentation Output” for more information
and a list of supported file types.

Approved for public release, NGA-U-2025-01219



6 CHAPTER 2. SALSA COMPONENTS AND INSTALLATION

2.2 Installation

SALSA has been developed as a cross-platform application and is currently tested on
Linux and Windows platforms. However, since all of our users outside the develop-
ment team use Microsoft Windows, we will limit the scope of this section to installing
SALSA on Windows.

We have built SALSA for Microsoft Windows 10 64-bit. While Salsa will likely install
and run on other versions of the Windows 64-bit operating system without issue, the
development team currently limits testing to Windows 10. We have not compiled a
list of “minimum system requirements.” Instead, we offer the following guidance. Any
computer that meets the specifications for Windows 10 64-bit should support SALSA
just fine. If, however, you are solving very large problems that take more than a few
seconds of processing time, your experience will likely improve if you migrate to a
more powerful machine.

Installation is very simple and follows the same pattern as other applications you’ve
likely installed before. This section is less of a “how to” and is more about what gets
installed, where it goes, and why it may matter.

The SALSA installer for Windows is provided as an .msi file. We use the naming
convention SALSA-<version>.msi, e.g., SALSA-1.1.0.msi. Most users will simply
wish to double-click the .msi file and accept default options to install the program
suite. This process will place the executables, related library files, and geoid data
files into the Applications path (discussed below), will add salsa to the Windows Start
menu, and will add a shortcut onto your desktop (which you are welcome to delete).

The default paths for installed files are as shown in figure 2.2. At time of writing
it is necessary to preserve the relative path structure between the bin and data
directories, which will be the default state unless you manually move some of these
files. For example, the salsa executable (salsa.exe) will attempt to invoke the CLI
applications (the other .exe files in the bin directory) on the assumption they exist
alongside salsa.exe. Similarly, salsa will expect that the geoid files exist in the
adjacent data directory, specifically ../data/geoid/<geoid_file>.

As noted above, the installer will place the SALSA executables, library files (.dll),
geoid files, documentation, and examples under the Applications folder. One file not
yet addressed is default.cfg. This file contains installation-level default options
germane to SALSA operation. This file will be copied into any new LSA project created
on this computer. Of course, a user may make changes to the copied file once it is
referenced in their project; the important point we wish to make here is that any con-
figuration options that should apply to all users, for all future LSA projects created on
this computer, should be done by editing default.cfg in this installation directory.
Doing so will require the same privileges as whoever installed SALSA.
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C:/
Program Files/

SALSA/
bin/

platforms/
iob2lsa.exe
lsapost.exe
lsapreprocessor.exe
lsasolver.exe
salsa.exe
<lots of .dll files>

data/
geoid/

egm1996 2.5m.und
egm2008 2.5m.und

marble/
default.cfg

doc/
SalsaUserManual.pdf

examples/
lib/

lsawrappers.dll
plugins/

marble/
python/

python.exe
<.dll files>
<subdirectories>

scripts/
converters/

wrappers/
<python lsa wrappers>

converterlauncher.py
LeicaTotalStation.py
lsaconverter.py
PPPToLSA.py
TribmbleToLSA.py

Figure 2.2: Default installed locations of key SALSA components.
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8 CHAPTER 2. SALSA COMPONENTS AND INSTALLATION

2.3 Obtaining HDFView

Data files in SALSA are written to an HDF5 file format. An advantage of these files is
that they are easily readable with the proper HDF viewer. We recommend using the
viewer HDFView which may be obtained from The HDF Group website [2]. To open
an HDF5 data file which is generated by SALSA (typically, the file extension will be
“*.h5”), the user may simply double click on the file. Alternatively the user may open
HDFView and navigate to the file using File→Open.

2.4 Program Removal

To remove SALSA, use the Windows Control Panel: Start → Control Panel → Programs
→ Uninstall a program, [right-click] SALSA → Uninstall.
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Chapter 3

How to Use the salsa Interface

Recall that SALSA is a suite of applications and that the graphical user interface is
called salsa. This is the application that will be invoked when the user launches salsa
from the Start menu using the cute chips-and-salsa icon, and it is the subject of this
chapter.

There are three paths we can take to get LSA information into the salsa interface:

1. We can create a new LSA project.

2. We can open an existing LSA project.

3. We can import a GeoLab IOB file as a new LSA project.

Before we explore those paths, let us introduce the salsa interface and point out the
main parts of the interface that we’ll be referencing in the following sections. Figure
3.1 shows the salsa interface with an LSA project already loaded. The upper-left
quadrant of the interface is devoted to what we call the “Project Navigator” which is
designed to help a user view and organize all the inputs going into the least squares
solution. Since this information may be distributed across several input files, this
interface employs a “tree” style representation of the file hierarchy, allowing the user
to quickly collapse and expand each file’s content.

To the right of the Project Navigator is the Record Editor. This interface shows the
details of the currently-selected record; these details can be edited directly in this
interface.

The area below the Project Navigator contains several output frames (they will be
empty prior to running an adjustment). These indicators and tables summarize the
performance of the least squares adjustment and provide the user with important
details when something goes wrong. Example 1 of this user manual illustrates the
utility of these indicators as a user diagnoses a problematic adjustment.

At the bottom-left of the salsa interface is the Status Window. The Status Window

9
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Program Menu Record Editor

Project
Navigator

Status Window Map

Adjustment 
Summaries

Figure 3.1: salsa GUI elements.
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3.1. CREATING A LSA PROJECT 11

shows output from the CLI applications that run in the background as files are opened
and parsed, and as the solver runs. For example, this window will show the iteration
count and convergence level while the solver executes. Keep an eye out for orange
text, which indicates some kind of warning, and red text, which indicates an error.

The bottom-right quadrant of the salsa interface contains an interactive map of the
survey network. The map can render either the inputs to the LSA problem or the
solution. Example 1 of this user manual explains the map behavior in some detail and
shows how the map can be helpful in understanding the LSA problem and interpreting
LSA results.

At the top of the salsa interface we have the Program Menu that is typical of most
graphical programs. We’ll go into each menu item in later sections.

Note that the user can adjust the relative size of each portion of the salsa interface, us-
ing the slider handles between them. Also, the Record Editor and Map are ‘dockable’
which means that in addition to being resizeable, they can be dragged off the salsa
interface altogether to suit the user’s screen size and preferences. (A menu option
View → Reset Windows will restore the docks to their default geometry.)

Having introduced these main parts of the salsa interface, let’s outline the three paths
for building an LSA project. . .

3.1 Creating a LSA Project

The first path we’ll explain is the process of creating a new LSA project from scratch.
When first launched, the salsa interface is pretty plain, as shown in Figure 3.2.

The process of creating a new project is trivial; go to Project → New.... That will
yield a file selector dialogue allowing you to navigate to a directory of your choosing
(optionally creating a new one if needed) and specifying the name of the new project
file. If you don’t type an extension, salsa will use .proj. When the .proj file is
created, the file default.cfg will be copied from the SALSA installation directory
into the same folder containing the new .proj file and given the same name as the
.proj file but preserving the .cfg extension. For example, if a user creates the new
LSA project called newproject.proj, the default configuration file will be copied to
that same location and given the name newproject.cfg.

When the new LSA project is created, the Project Navigator will show the name of this
new top-level project file and its contents, which at first will be limited to a single
comment indicating the date and time the project was created. From this point,
the user can start adding survey records or other files containing survey records.
Reference Example 1 of this user manual for a complete illustration of this path.
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12 CHAPTER 3. HOW TO USE THE SALSA INTERFACE

Figure 3.2: salsa interface on startup.

3.2 Opening an Existing LSA Project

An existing project can be opened via the menu option Project→ Open LSA.... This
will present a file browser prompting the user to identify an existing .proj or .lsa
file to load. Any existing content in the salsa interface will be cleared, and this file will
be treated as the top-level project file. If a SALSA configuration file by the same name
(but with .cfg extension) does not already exist at this location, it will be copied from
the SALSA installation directory.

When a .proj or .lsa file is opened, all records in the file are parsed and displayed
in the Project Navigator. This includes any included files and their records (and their
included files, etc.).

As those lsa-formatted files are opened and parsed, any problems will be reported in
the Status Window at the bottom of the salsa interface.

Note that opening an LSA project file (.proj or .lsa) is not the same as including
an LSA file within an existing project. Example 1 of this user manual involves the
inclusion of .lsa files into an existing project.

3.3 Importing a GeoLab IOB Project

salsa also provides support for loading an LSA project from GeoLab *.iob format.
This action is initiated via the menu option Project → Open Geolab Project...
which will prompt the user to select the top-level GeoLab project (likely named *.iob)
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3.4. DROPPING DATA IN THE PROJECT NAVIGATOR 13

and will then perform the following actions:

1. salsa will set the new LSA project directory to the location of the specified *.iob
project file.

2. salsa will convert the top-level *.iob file into LSA format, giving it the extension
.proj.

3. default.cfg is copied into the project directory just as is done when a new LSA
project is created.

4. Any files that were included (#INCLUDE) in the imported *.iob file will also
be converted into .lsa format, yielding a project structure in LSA format that
should closely match the original IOB organization.

3.4 Dropping Data in the Project Navigator

As an alternative to opening files as described in section 3.2, users can also drag
files from outside of salsa and drop them into the Project Navigator to include them
in the current project. Conveniently, if a file is not already a .lsa or .proj file, salsa
will attempt to determine the file’s type and use the appropriate built-in file converter
to include it into the current project. Avoid dropping files which would already be
included as a child of another file being dropped.

salsa can also open a dropped file as the top-level project if there is not one already
open. In the case that more than one file is dropped on an empty Project Navigator,
the user will be prompted to create a new .proj. This will become the top-level project
for the files being dropped.

Plain text can also be dragged and dropped onto the Project Navigator if there is
already a project open. This is especially useful when the user wants to take records
from one project open in a text editor and duplicate them in a project open in salsa.
The records are added on a line-by-line basis. If the line is not a file include (--include
filename) or does not begin with an appropriate record tag (e.g. POSG, AZIM, etc.
See chapter 12), it will be added as a comment. When dropping an include as text
(--include filename), the file specified by filename must be in the currently opened top-
level project’s directory, or filename must contain the relative filepath (e.g. --include
subDir/filename).

3.5 Editing Records

When a record is selected in the Project Navigator, the Record Editor is populated with
the information contained in that record, and many of the controls are user-editable.
The appearance of the Record Editor will vary based on the type of record selected, of
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14 CHAPTER 3. HOW TO USE THE SALSA INTERFACE

course, because different record types contain different information. The developers
hope that these interfaces are sufficiently intuitive that we need not bloat this user
manual with field-by-field explanations and screen shots for each record type. That
said, some records exhibit behavior that may not be obvious to all users, so we feel
compelled to explain the design choices and program behavior in these cases.

3.6 Find/Filter Records

The user may find that they want to select only AZIM records in a large project. It
would be tedious to scroll through all of the records and through all of the includes.
This is where the Find/Filter widget comes in handy. To open this widget, click
Record→Find/Filter... (or Ctrl+F) with a project already open.

Notice that the Find/Filter widget has a Find row and a Filter row. Each of these sport
their own text field, in which the user can specify their search terms. There can be
multiple search terms simultaneously, each separated by a space. Terms surrounded
by quotes are considered as one term, regardless of spaces within. The interpretation
of the search terms can be manipulated by the ’exact match‘ checkboxes. When
checked, the results will only include records which match exactly. For example, if
the user searches for ”TGT01”, records which contain ”TGT01” would be returned
but not those containing ”TGT011”. Find and Filter both have ANY/ALL dropdowns,
which are useful for specifying how multiple search terms should be handled. If the
user selects ANY, then a given record is included if at least one of the search terms
match. Conversely, the ALL option ensures that only records which match all search
terms are included.

The Filter option has another dropdown with a default value of ’All Records’. The
options in the dropdown are simply a quick way to filter based on a record type
or other common feature of a record (e.g. enabled or disabled). The Find row of
the widget provides an ’All’ button. This button will select all records in the Project
Navigator which match the search. The arrow buttons will singly select the next or
previous record which matches the search. Finally, the warnings button will change
the user’s selection to the next record which has a warning.

Note that the Filter and Find functionality can be used in conjunction: the Find
feature will only select records which are available after the Filter has been applied.

3.7 Record Modifiers

There is a class of records that we call “modifiers” because they affect other records.
Thus, there are some design choices embodied in salsa that users should understand.
These “modifier” record types include the following:
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• HGHT (Height of Instrument/Target)

• VSCA (Variance Scaling)

• UNCR (Uncertainty Model)

• DGRP (Direction Group)

In general, when the value of a modifier is changed, that change will immediately
apply to any records referencing that modifier. For example, suppose we create a
height of instrument record (HGHT) for station TP02 for a set of morning total sta-
tion observations, and we give it the label “TP02-morn” and the value of 1.550 m.
Measurement records collected with that configuration will specify TP02-morn for the
corresponding height of instrument, and the value 1.550 m will be displayed in the
record editor. Reference Figure 3.3. Suppose however that we realize 1.550 was the
height measurement made for an afternoon observation set, and the morning height
was actually 1.402. We can correct the TP02-morn HGHT record to reflect that value;
at this point the corrected value of 1.402 m will be effective for all measurements
referencing the TP02-morn height record.

Similarly, changing a modifier label will immediately apply to all records referenc-
ing that label. Working with the previous example, if we change the HGHT record
label from “TP02-morn” to “TP02-morning” all records referencing “TP02-morn” will
immediately be updated to reference “TP02-morning.”

Table 3.1 lists common edits one might make to a modifier record and the correspond-
ing result of that edit.

3.8 Project Configuration

When a new LSA project is created, a default configuration file is copied from the
salsa installation directory into the project directory. This file is used by the solver
to determine, among other things, the formatting of the output. It is also used by
the post-processor. If the user wishes to change the way that output is formatted,
for example, this default configuration may be altered by selecting the Project →
Configure... menu option. This will display the Project Configuration panel.

The user may also change the default configuration that is used when converting
instrumentation output into the LSA format. To do this, press the Configure button
from the Input File Conversion section of the Project Configuration panel. This will
bring up the LSA Converter Measurement Uncertainty Configuration panel.
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HGHT record
‘HGHT_TP1-morn’
With value 1.550 m

Selected ZANG
record reflects

‘HGHT_TP1-morn’
value of 1.550 m

Figure 3.3: The numerical value for a modifier, such as height of instrument/target
(HGHT), will immediately reflect any changes made to that modifier record.
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Figure 3.4: Default configuration for a priori position generation, solver options, and
output customization.
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Table 3.1: Effects of Editing Modifier Records

Action Result

Alter the value of a modifier
(HGHT, VSCA, UNCR)

The new value becomes effective in all
records referencing this modifier.

Alter the name/label of a mod-
ifier

All references in the project to the old
label will be updated to reflect the
new label.

Delete a modifier (HGHT,
VSCA, UNCR)

All references in the project to the
deleted modifier will be removed, e.g.,
a reference to a HGHT record will be-
come None and assume a value of
zero.

Delete a Direction Group
(DGRP)

The Direction Group and all children
(horizontal directions referencing the
group) will be deleted.

3.8.1 Converter Configuration

Just as there is a configuration file that is used by the solver and post-processor
to determine the format of the output of those programs, among other things, there
is also a configuration file, converter.cfg, that is used to determine the output of
the instrument output-to-LSA converters. This file determines the centering error
values for UNCR records associated with particular measurement types for particular
instrument types, as well as the sigma values to assign to different measurement
types.

Figure 3.5: Default configuration of UNCR records and measurement sigmas when
converting instrument output to the .lsa format.

Approved for public release, NGA-U-2025-01219



3.8. PROJECT CONFIGURATION 19

The default values for these UNCR records may be changed by changing the setup
types for the FROM and TO stations of a particular measurement in the LSA Con-
verter Measurement Uncertainty Configuration panel. The hardware-dependent de-
fault sigmas and centering errors are defined in the following table. The user is also
able to enter their own centering errors by selecting the Custom setup option from
the respective combobox.

Table 3.2: Setup-dependent centering errors

Setup Type Centering Error (m)

Forced Centering Plate 0.0

Range Pole 0.004

Tripod 0.001

Vertical Collimator 0.0005

Similarly, the user may change the default sigmas assigned to particular measure-
ment types by changing the sigma source from Defaults to Instrument, which uses
the instrument-reported sigma values, or Custom, which allows the user to enter their
own sigma values to assign. The sigma defaults are defined in the following table.

The user may use this panel to set up their own defaults that will persist from project
to project by pressing the Save As User Defaults button. To save the configuration just
for the open project, without modifying the user defaults, press the Save As Project
Config button. To restore the panel to the factory defaults, press the Load Factory
Defaults button. The Save As Project Config button should be pressed to generate the
converter.cfg file prior to importing the instrument output files.
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Table 3.3: Default Sigmas by Measurement Type

Measure-
ment Type

Technique Sigma (m
or soa)

Differential
Levels

Digital +
Precise Rods

0.0003

Differential
Levels

Digital +
Standard Rods

0.0006

Differential
Levels

Spirit +
Standard Rods

0.001

Distances Total Station
Infrared

0.001

Distances Total Station
Red

0.002

Distances Total Station
No EDM

0.003

Horizontal
Angles

Total Station 5.0

Vertical
Angles

Total Station 10.0

Elevation
Differences

Total Station 0.01

Instrument
Height

Measuring Rod 0.001

Instrument
Height

Measuring
Tape

0.001
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Chapter 4

Understanding the Solver

This chapter describes the command line program lsasolver (“the solver”) that serves
as the estimation engine of SALSA, what it does, and (briefly) how to understand
the output. The solver was developed using [1] as the primary reference; this is an
excellent reference and the user interested in more detail on the topics discussed here
is referred there and to [3].

4.1 What the solver does

The solver performs the fundamental task of using the input measurement and initial
position data to find an optimal solution (adjustment) for the positions. In addition it
finds an initial position for unknown sites, performs quality assurance and statistical
tests on the data and the adjustment, and does geoid computations.

The solver input data is contained in a flat text file (the “DAT file,” usually with exten-
sion .dat) with its own format as documented in Chapter 13, “The *.dat File Format
Specification.” The format is quite simple and consists of one complete position or
measurement per line.

salsa automatically uses the lsapreprocessor program to generate this file, and then
passes it as input to the solver, behind the scenes, whenever it is directed to run a
computation. However the file may be edited or even created in a text editor and then
given as input to the solver being run on the command line.

The solver begins by parsing the input DAT file and collecting positions and measure-
ments. Any error in the DAT format yields an Error message in the solver output,
indicating that a record (line) could not be parsed (but the solver does not abort).

Each site must have a unique label, given either in the POS record for that site (con-
taining an initial value for the site’s position), or as it is used in one or more measure-
ment records. Each site also has a type, which is one of the following.
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22 CHAPTER 4. UNDERSTANDING THE SOLVER

Fixed Generally some, but not all, sites are fixed (“control points”); these sites’ coor-
dinates are held fixed in the network adjustment.

Estimated These sites’ coordinates float and will be estimated in the adjustment.

Adjusted These sites can serve as control points in the network, but their position
will be adjusted in the estimation, using the given a priori position as data; this
option is often used for GNSS-determined point positions. POS records that are
to be adjusted must have a non-zero covariance.

Unknown Other sites lacking POS records but encountered in the network (i.e., be-
cause they are referenced by one or more measurements) will be initially “un-
known.” Once initial coordinate estimates are generated (using methods de-
scribed below), these points will be treated as Estimated.

The first task for the solver, after reading the input, is to compute initial estimates,
or a priori positions for all the unknown sites. (These positions are required because
the least squares problem is non-linear and so must be iterated, which requires a
starting value for all the positions; see Section 4.3 below.) The algorithm for doing
this depends on what data are available that involve the unknown site. The solver
tries to use each of ten different algorithms and all the measurements in the input to
find each unknown site’s a priori positions. All the successful results for that site are
then averaged to give the final a priori position. The type indicator for the site is then
changed from “unknown” to “to be estimated.” If an a priori position for any site(s)
cannot be found, then the solver must terminate with an error, since the adjustment
cannot be performed. The ten a priori algorithms are documented below in Section
4.3.2.

The solver computes a weighted least squares solution to the adjustment problem
using all of the measurement data, with measurement covariance, and perhaps with
constraints. This is a full 3-dimensional computation in the WGS84 geodetic frame
using Earth-Centered Earth-Fixed Cartesian coordinates (ECEF XYZ). Control sites
with type “to be adjusted” are used to generate pseudo-data that allows the given
position to be included in the estimation. Constraints may be applied prior to the
estimation computation; that is, sites may be constrained to remain fixed in any
combination of (one or two) components North, East and Vertical (see the POS record
“CONS” documentation in the DAT file specification in Chapter 13).

The least squares estimation yields not only an optimal estimate of the adjusted po-
sitions, but also (assuming degrees of freedom greater than zero, see Section 4.2) an
estimate of the uncertainty on these results. Statistical tests can be performed on the
results to give an indication of the quality of the adjustment, which is determined by
the quality and quantity of the data. These statistical tests can be used to determine
if the relative weighting of data should be adjusted or if the data or control points
contain blunders or improper initial uncertainty estimates.

The solver presents all of this information in a human-readable flat text output file,
including tables of residuals, statistics, and adjustments with their uncertainties and
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covariances.

4.2 Least squares

The estimation algorithm used by the solver is “iterative linearized weighted least
squares;” this section attempts to explain all of that. Basic weighted least squares is
described first, followed by the statistical results and tests that can be derived from
it. Next the iterative solution of the full non-linear adjustment problem is described.

4.2.1 Basic least squares

The least squares method solves the linear algebra problem of several equations re-
lating unknowns (the state vector) to measurements (the data vector). If a covari-
ance matrix (measurement uncertainties) for the data is available, the solution can
be weighted, which means varying degrees of importance are given to different data
elements, potentially yielding a better solution.

When employing a least squares method, there must be the same amount or more
data than there are unknowns for a solution to exist, and more data than there are
unknowns for a covariance to exist. The number of degrees of freedom is

N(dof) = N(data)−N(unknowns) (4.1)

If the degrees of freedom is negative, the problem is under determined and there is no
solution, if it is zero the problem is evenly determined and there is a solution but it
is exact and residuals are all zero (statistics cannot be computed); all of the measure-
ment noise is passed through to the solution. Least squares estimation methods are
typically employed for over determined problems (i.e. the number of degrees of free-
dom is positive). More degrees of freedom generally yeilds a better solution because
there is more input information (measurements) and noise in the solution is reduced
(think of averaging).

In the case of the solver, the set of equations to be solved is simply the set that
relates all of the measurements (angles, distances, 3-D deltas, heights, etc) to the
coordinates of the sites involved in the measurement [1] [3]. These equations are
written as a matrix equation relating the state X (a vector of all the coordinates of
all the non-fixed site positions) to the data d (a vector of all the measurements). The
matrix is called a “partials matrix” P (for a reason to be given below). Thus the matrix
equation to be solved is

P ·X = d (4.2)

The solution to this problem is simply

Cov = (P T · P )−1

X = Cov · P T · d
(4.3)
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where Cov is the covariance of the solution X. A vector of data residuals is simply

R = d− d̂ = d− P · X̂ (4.4)

These residuals are the difference of the measured data and the value that would be
computed from the solution for the final adjusted positions. Generally if a residual is
larger than the uncertainty in the data that was input to the problem, then either the
measurement is bad or the uncertainty is too small.

In weighted least squares, the equations are multiplied by a weighting matrix W (usu-
ally W is equal to the inverse of the measurement covariance matrix MCov) before the
solution is formed, so then the result is

W = (MCov)−1

Cov = (P T ·W · P )−1

X = Cov · P T ·W · d
(4.5)

The weighting has the effect of changing the relative strength of the data in the es-
timation; that is, data with a larger weight (smaller measurement variance) has a
stronger influence in the determination of a solution. Note that the word “relative” is
crucial in the previous sentence; in fact if the entire measurement covariance matrix
MCov is scaled, this same scale multiplies the resulting solution covariance Cov but
has no effect at all on the solution vector X.

4.2.2 Statistics: APV and Chi-squared

[Note this section and the next assume degrees of freedom greater than zero.]

The fact that least squares is insensitive to the overall scale of the covariances (mea-
surement and solution) would seem to imply that this overall scale must remain un-
known. This is not the case; one of the marvelous things about least squares is that
it yields not only a solution with (relative) covariance, but also an optimal estimate
of the overall scale of the solution covariance. This scale is called the “a posteriori
variance of unit weight” or APV.

The APV is the ratio of the overall scale of the solution and measurement covariances;
it is computed using the RMS relative residual and the degrees of freedom. The full,
properly scaled solution covariance is thus APV · Cov. Ideally the APV should turn
out to be 1. If the APV is 1.0, the problem is weighted correctly and so the solution
is optimal. If it is too large, then some or all of the measurement uncertainties are
too large, and a somewhat sub-optimal solution has been produced. If it is too small,
then the measurement uncertainties are too small (this is discussed further below).

The APV and degrees of freedom are used in a statistical test of the correctness of
the adjustment, the χ2 or Chi-squared test. The test statistic is equal to the APV
multiplied by the degrees of freedom, and the test is to compare it to the value of
the χ2 inverse cumulative distribution [4] function (or just χ2 function). This is a well
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known special function in mathematics [1] [5] [4] that depends on both the degrees of
freedom and a confidence level α.

The confidence level is a probability, so 0 ≤ α ≤ 1; usually α is expressed as a per-
centage. The statement of the Chi-squared test is “if the test statistic is less that the
Chi-squared function with n degrees of freedom and confidence α, then the adjust-
ment is optimal with confidence α” [1] [3]. (Note that the solver output shows the
Chi-squared test with the the degrees of freedom divided out; it does this just to keep
the numbers relatively small.)

The test is basically to see if the solution lies within the tails of the Chi-squared
function. This can be done at the upper tail (α is large, say 95%) or the lower tail (α
small, say 5%). A “two-sided test” can also be performed, in which the confidence is
split between the two tails and both tests are shown.

4.2.3 The problem is non-linear

The diligent reader may have noticed that in fact the measurement equations cannot
be written as above, P · X = d, because they are non-linear in the site coordinates.
This is true; the adjustment problem is actually a non-linear one, f(X) = d, where
the function f(X) is non-linear, and so basic least squares does not apply. However
non-linear problems can be still be solved with least squares; the procedure is to first
linearize the problem, then iterate the basic least squares algorithm until it converges
to a final solution.

The non-linear equations are linearized by starting with an initial, or a priori, solution
(maybe just a guess). An initial state vector is required for non-linear problems; it
should be as accurate as possible (but many inaccuracies can be made up for by
more iterations).

Call this initial state X0, and write the non-linear function as a Taylor expansion
about this initial value, as follows.

f(X) = f(X0) +
∂f

∂X
|X0 · △X +O(△X2) = d (4.6)

Assume that the change in state △X is small, and so keep only the linear term in the
expansion; then the equation f(X) = d becomes

∂f

∂X
|X0 · △X = d− f(X0) (4.7)

But this is now of the form of the basic least squares linear equation, with partials
matrix P = ∂f

∂X |X0 and new data vector d − f(X0). (This is why it is called the partials
matrix, because it is a matrix of partial derivatives.)

We can now solve for the change in state using ordinary weighted least squares. But
because the change in state △X has been assumed to be small, we must iterate this
process until it converges, meaning until the change in state is very small. Thus the
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final solution is obtained via an iterative, linearized, weighted least squares algorithm,
as follows.

1. Obtain an a priori solution X0 for the unknown sites, along with data and mea-
surement covariance, and set i = 0.

2. Compute the partials matrix at X = Xi and the data vector d− f(Xi).

3. Use weighted least squares to solve the linearized equation for the change in
state, △X.

4. Test the size of △X; if it is very small, quit with success. Xi is the solution, with
covariance Cov = (P T ·W · P )−1.

5. If the number of iterations becomes large, or if △X starts to grow, quit with
failure.

6. Replace Xi with Xi+1 = Xi +△X, increment i and go to step 2.

There are many ways to implement and solve the least squares equation, some more
stable and efficient that others. Simple matrix multiplication and inversion is not the
best way. The solver provides the flexibility to use methods optimized for speed, or
the most stable algorithm known, which involves Cholesky decomposition or matrix
square roots and the Householder algorithm [6].

4.2.4 Constraints

The position of any site can be fixed via the keyword FIX of the POS record in the DAT
file; this means the site is not adjusted. Alternatively, just one or two of the compo-
nents (North, East, Vertical) may be fixed, and the other(s) left free to be adjusted, by
using the keyword EST (to be estimated) and adding constraints in the POS record
using the keyword CONS (cf.Chapter 13).

Constraints actually strengthen the estimation, by adding information in the form of
constraint equations. This is apparent in the degrees of freedom, which becomes, in
the presence of constraints on some number of components,

N(dof) = N(data)−N(unknowns) +N(constraints) (4.8)

A constrained adjustment will yield not only a zero adjustment, of course, but also
a zero uncertainty, for the constrained component(s). Thus in the Final tables of
adjusted positions (see below), the sigma for the constrained component will read
zero or extremely small, and the covariance matrix for the constrained position will
be singular (the XYZ covariance will probably not have zeroes in it, but will in fact be
singular).
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These constraints are implemented in a strictly rigorous way using matrix decom-
position and projection. This has the effect of limiting the vector space of the least
squares solution to the subspace in which the constraints are exactly satisfied. This is
unlike other techniques for applying constraints that use “overweighting” or pseudo-
data with zero covariance to force the least squares solution to hold components fixed
[1]; these methods are inexact and run the risk of destabilizing the problem and even
making it singular.

4.3 A priori computations

The solver makes use of ten different algorithms that can possibly determine an initial
or a priori position for an unknown site. Each algorithm first attempts to find certain
data in the measurement set that involve both the unknown site and other, known,
sites. If these exist, the algorithm is applied to get an estimate for the unknown
position. After attempting all the algorithms, the solver averages whatever results
were obtained to find the best estimate of the unknown position. If the solver is not
able to find an estimate, it must abort, as no linearized least squares solution can be
found without an initial state (see above).

4.3.1 Preliminaries

In the following, U labels the unknown site, and A, B, C and D are known sites. The
tags from the DAT file format (Chapter 13) are used for convenience, e.g. AZM for
azimuth, HAN for horizontal angle, etc.; meanings should be clear. All the algorithms
operate in the local level (North-East) plane; no attempt is made to determine the
height of U other than as a simple average of the known sites’ heights.

The algorithms make use of a few facts and mathematical identities that will be men-
tioned here. First, azimuth (AZM) measurements are signed, meaning they can be
positive or negative, because azimuth is defined as zero at North, and positive as
it moves toward East. Horizontal angles (HAN) are signed too; they are defined as
the difference of two azimuths. It follows that the order of the three sites in a HAN
(From-At-To) matters.

All of the measurement data can be used immediately in the computation except
directions. Directions are not useful to the computation because they are biased
azimuths, with a single unknown bias for each direction set. However the difference
of directions within the same direction set yields a horizontal angle (with no bias),
and HANs can be used. Thus a preliminary step in the a priori computation is to
form a non-redundant set of HANs from each direction set; this are discarded at the
completion of the a priori calculation.

The following are identities [1]; of course all angles are valid modulo 2π. These are
used whenever needed by the solver to find data useful to the various algorithms.
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HAN(UAB) = AZM(AB) - AZM(AU)
AZM(AB) = AZM(BA) + π
HAN(UAB) + HAN(BAU) = 2 · π
HAN(AUC) = HAN(AUB) + HAN(BUC)

4.3.2 The a priori Algorithms

Here are the ten algorithms, in the order in which they are attempted. The last
algorithm (Center of mass) is the fall-back; the solver uses it only if none of the others
succeeded (but only if the user allows it with a command line option, see Chapter 15).

1. Delta Addition. Given POS A and 3-D delta DEL AU, simply add the delta to the
position of A to get the position of U. This is very simple, but it is the most often used
algorithm.

Figure 4.1: Delta Addition Algorithm

2. Azimuth Vector Addition. Given POS A, distance DIS AU and azimuth AZM AU,
simply apply trigonometry and vector addition to get the position of U. Note that the
azimuth is signed and always defined as zero at North, increasing toward East, so
there is no ambiguity in quadrants.

Approved for public release, NGA-U-2025-01219



4.3. A PRIORI COMPUTATIONS 29

Figure 4.2: Azimuth Vector Addition Algorithm

3. Horizontal Angle Vector Addition. Given POS A and B, DIS AU and horizontal
angle HAN(BAU), simply apply trigonometry and vector addition to get the unknown
site U. Note that HAN(BAU) is signed.

Figure 4.3: Horizontal Angle Vector Addition Algorithm

4. Triangulation. Given POS A and B and a = HAN(UAB) and b = HAN(UBA), the
triangle formed by A,B,U has two known angles (a,b) and a known side (AB) between
them. The third angle is c = π/2− a− b by identity, and the law of sines will yield the
other two sides (DIS AU and BU). Then take distance AU and azimuth AU and use
algorithm 2, and do the same for B.

Approved for public release, NGA-U-2025-01219



30 CHAPTER 4. UNDERSTANDING THE SOLVER

Figure 4.4: Triangulation Algorithm

5. Two Azimuth Lines. Given POS A and B and AZM(AU) and AZM(BU), two lines are
defined that must meet at a point, which is U. Since A and B are known, DIS(AB) and
AZM(AB) can be computed. Solve for U using simple algebra. Note that there are two
different ways to collect the AZM(AU): (a) AZM(AU) is found in the measurements and
(b) HAN(UAC) and AZM(AC) are found for some POS C (known or not), then HAN(UAC)
= AZM(AC) - AZM(AU) (by identity) and therefore AZM(AU) can be computed.

Figure 4.5: Two Azimuth Lines Algorithm

6. Resection. Given known POS A, B and C, HAN(AUB) and HAN(BUC), solve for U.
This is the 3-point Resection Problem. The algorithm makes use of the fact that for a
given HAN(AUB), points A, B and U all lie on a circle. Thus the given data defines two

Approved for public release, NGA-U-2025-01219



4.3. A PRIORI COMPUTATIONS 31

circles that must meet at two points, B and U, and since B is known this uniquely
determines U. The implementation must handle the case (called semi-singular) where
one of the angles is zero; then the problem reduces to finding the intersection of a
circle and a line (e.g. A,D,B,U in figure 4.6, where HAN(AUD) = 0). See figure 4.6, and
also figure 4.7, which is a real example from the solver, with the two circles and their
origins shown. Ref [1] section 15.5, and [7].

Figure 4.6: Resection Algorithm

Figure 4.7: Example of Resection Computation (with circle origins included)
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7. Ranging. This algorithm is very similar to the GNSS pseudorange-only naviga-
tion solution, and its implementation is based on the Bancroft algebraic solution of
GPS ranging. Given 2 or more points and the distances (ranges) from these points
to the unknown point, a least squares solution can be formed yielding the position
of the unknown. This is a 3-D algorithm; however in this application the positions
typically all lie very nearly in a plane. To avoid the near singularity in the height
that this produces, the data is transformed to the North-East plane before applying a
2-D algorithm. In every case the algorithm yields two different solutions, but inter-
nal consistency allows it to pick the correct one, with one exception. In the case of
only 2 positions and distances, the consistency test does not apply, and some other,
independent, information must be used to determine the correct solution.

8. Leveling Loop Formation. Any points which remained unsolved after iterating
through the previous methods will be inspected to see if they are part of a leveling
loop. Iterating through the list of previously known / estimated points, a starting
point is gathered. All possible loops with the starting point are formed by chaining
together HDIF records using the From and To labels (for more information on HDIF
records refer to chapter 11). The loop is considered complete once a point is found
whose label does not exist as a From point in the set of HDIF records. At this point a
loop from the set is chosen which meets the prioritized conditions below

1. The last To station in the chain must be known / estimated.

2. There are two or more HDIF records in the chain. This prevents the algorithm
providing a loop that just connects two known points with no unknown points
in the middle.

3. The loop’s distance between the first point and last point is minimized.

4. If two or more loops have the same distance between their start and end points,
the loop with the smallest set of HDIF records is chosen.

Once a loop is chosen all temporary points are evenly spaced on the NE plane between
the starting point and the end point. The latitude and longitude for those temporary
points are fixed. This process is iterated over until no more points can be projected in
this manner.

9. Side Shot Handling. If there remain unknown points after checking for leveling
loops, a check for side shots will be performed. This algorithm will search for the
following conditions.

1. A known / estimated point shares the same label as the From label for an HDIF
record.

2. The To label for that HDIF record corresponds to an unknown point.

Approved for public release, NGA-U-2025-01219



4.4. HOW TO READ THE SOLVER OUTPUT FILE 33

If the conditions are met, then the unknown point will have its initial coordinates set
equivalent to the known / estimated point. Additionally, its latitude and longitude
will be fixed.

10. CenterOfMass. This is the default fall-back; if nothing else can determine the
unknown point, then the solver will compute the average of all the known positions
(the centroid of the network) and use that for U. This may or may not cause the solver
to diverge, depending on the problem, but it probably will lead to the solver requiring
a large number of iterations.

4.4 How to read the solver output file

This section discusses, in some detail, what is in the solver output file, what is most
important there, and how to determine what is wrong when an adjustment computa-
tion gives poor results or fails.

4.4.1 What is in the solver output file?

The solver output contains all the information of interest that was either input to, or
is produced by the solver, and so it can be quite long. The output is written during
the operation of the solver, and falls into 6 basic parts, as follows.

• Part 1. Input - echo and summarize input from both DAT file and command line

• Part 2. Compute a priori positions, if needed

• Part 3. Load the geoid file and define constraints, if any

• Part 4. Build the LS problem and print the degrees of freedom, etc.

• Part 5. Results for each iteration (this is the largest part of the output: conver-
gence test, data residuals and diagnostics at every iteration)

• Part 6. Final results - residuals, statistical tests, adjustments, and geoid calcu-
lations.

The input section includes all the data and positions, just as they are in the input.
Any errors encountered in reading the DAT file are shown here as “Error - DAT reader
failed to parse line > ... <”; however the solver will NOT quit. Note that the solver
might terminate after part 2, either because it was unable to find all the a priori
positions, or because the user requested it from the command line.

Part 4 is very brief and shows the number of degrees of freedom, the size of the state
and data vectors, the number of constraints, and all the a priori positions. The solver
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might terminate here if the problem is underdetermined or singular, because then
there is no solution.

Part 5 (once per iteration) first shows the convergence test, which indicates how the
iteration is proceeding. This is followed by the RMS residuals and the APV. (The same
information appears at the command line when the “progress” option is used.) Then
(if the verbose option is on) the current adjustments with their uncertainties, and a
table of all the data residuals, follow; the bulk of this information is not particularly
interesting unless there is a problem.

The final part is of most interest. It includes all the data residuals, with standard
residuals (these are not in the per-iteration results), final RMS residuals, APV and
the Chi-squared tests. Then the final adjustments are presented, both in ECEF XYZ
and in Latitude, Longitude and Height. If a geoid file was input, the geoid is evaluated
at all the sites as well.

4.4.2 What is important?

Some of the information in the solver output file is much more important than the
rest, but this importance can depend on the outcome of the algorithm. The following is
a list of things to look for, in order of importance; however note that there is nothing
absolute or mandatory about this list - it is really just an informal attempt by the
developer to tell the user what to look for, and in what order, in the solver output.

1. Errors. Any fatal error (meaning the solver cannot go on) produces a line in the
output that begins with the word “Error”. Because the solver aborts, this message
is probably near the bottom of the output file. These are critical, far more important
than anything else in the output file. A normal solver output will not have any Error
messages, but if the solver failed for any reason, there will be one. These can be
as simple as “Error - input file not found” or as complex as “Error - the problem is
singular.” (Failing to parse a record the DAT file is also an Error; these appear at the
top of the output file and do not cause an abort.)

[Note. If the user ever encounters a case where the solver fails, perhaps with “Excep-
tion: ...” and no Error message is found, please report this to the developers, and
send along the DAT file.]

2. Warnings. An error that is not fatal, but that is not expected and of concern,
produces a line in the output that begins with the word “Warning.” Many solver runs
will produce no Warnings. Some will point out problems that cause the user to make
changes to the input and re-run the solver, but some may be ignored. These should
at least be considered before going on; most are the result of problems or omissions
in the input.

Probably the most common are the Warnings about “unused positions” and “unused
data.” If any site (POS record) is given in the input, but then that site is never used in
the data, that site’s name is listed as an unused position. Likewise if there is a data
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record that involves only fixed sites, it cannot be used in the estimation, and so it is
an unused datum. Unused positions are innocuous, they are not used by the solver
but are echoed in the final output, and some users don’t mind having them in the
output. Unused data, however, is probably an oversight, perhaps because the wrong
sites are used, or some sites are mistakenly fixed.

3. Statistics. In the absence of Errors and serious Warnings, next look at the post-fit
residuals RMS and the APV. Search for the word “Final” or “APV” to find these values,
which are below the final data residuals and before the final adjustments. An example
from a solver run:

RMS post-fit relative residual (Final) = 8.251e-01
Degrees of freedom = 50; Std dev of unit weight = 1.161; APV = 1.348 (Final)
RMS post-fit raw residual (angles) (Final) = 9.600e-05 rad = 1.980e+01 soa.
RMS post-fit raw residual (length) (Final) = 4.060e-03 m.
Upper Chi-squared test (0.950): 1.35 < 1.35 pass
Lower Chi-squared test (0.050): 0.70 < 1.35 pass
Two-sided Chi-squared test (0.025,0.975): 0.647 < 1.348 < 1.428 pass

The example output shows the post-fit residual RMS (relative, angles, and lengths),
the APV, and the Chi-squared (though actually the APV) test results. The post-fit
residual RMS provides a sense of how well the newly estimated states fit the measure-
ments; the relative residuals are the raw post-fit residuals scaled by the associated
specified measurement uncertainty, and thus the RMS of the relative residuals pro-
vides an indication of the how well the provided measurement uncertainties match
the actual noise of the measurements.

The “Chi-squared test” is actually a test of the APV value, because the solver outputs
limits for this test equal to the χ2 limits for a particular confidence value, divided by
the system degrees of freedom, and thus the limits have the same form as the APV
value. The optimum value for the APV is 1.0, indicating the noise seen in the post-fit
residuals matches well with the provided measurement uncertainties. If the APV is
well over 1.0, the post-fit residuals variance greatly exceeds the provided measure-
ment uncertainties, and vice versa for APV values well under 1.0.

4. How to interpret the “Chi-squared” test. If the solution fails the upper “Chi-
squared” test (i.e. the APV is well over 1.0), the post-fit residuals distribution is
much larger than the provided measurement uncertainties and the results should be
analyzed for possible blunders (see below). If the user is confident there are unlikely
any blunders and the APV still exceeds the upper test value, the overall scale of the
uncertainties may be too low, and the user may want to increase some measurement
uncertainties to move the APV closer to 1.0.

Note that while the user can always make the APV exactly 1.0 by rescaling the entire
measurement covariance matrix, this scaling has no effect on the solution (see section
4.2.1). Rather than scaling the entire measurement covariance, the user may want to
look for any subsets of the data that have larger noise than expected (as determined
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by considering relative or standard residuals), and scale up the provided measure-
ment uncertainties for those particular measurements. Changing only a subset of
the measurement uncertainties changes the relative weighting of the measurements
in the least squares method, and thus the solution is impacted (and if done properly,
improved).

If the solution fails the lower “Chi-squared” test (i.e. the APV is well under 1.0), the
post-fit residuals distribution is much smaller than the provided measurement un-
certainties. In this case, the user may wish to look for any subsets of the data that
have smaller noise than expected (as determined by considering relative or standard
residuals), and scale down the provided measurement uncertainties for those par-
ticular measurements. The solution will be improved if the scaling is done properly.
However, the risk of having a non-optimal solution when the APV is very small is lower
as compared to when the APV is very large, so the user may wish to skip this scaling
down step if time is tight.

Finally, to quote Ghilani ([1] p. 529): “[the chi-squared test does not] reveal the exact
problem in data when the test fails. The chi-sqared test should be viewed as a warning
flag for an adjustment that requires further analysis”.

5. Blunders. Now the user should look at the “Data and residuals (Final)” table,
particularly to look for any potential remaining blunders. The table has in the right-
most two columns the redundancy and the standard residual for each measurement,
both of which are derived in appendix B. In a nutshell, the redundancy is a num-
ber between 0 and 1 that indicates how susceptible the solution is to errors in that
observation, and the standard residual is a further “normalization” of the relative
residual involving the APV and the redundancy of the measurement. The redundancy
indicates whether more observations are needed to safeguard against blunders in a
particular observation. The standard residual provides an indication of whether the
measurement is erroneous, unreasonable, or problematic (e.g. from a user blunder).
The process of reviewing the standard residuals and removing or correcting any prob-
lematic observations is often called “data snooping” in the literature.

Any observations that exceed a threshold based on the tau distribution, as described
in appendix B, are marked with two asterisks: “**”. For convenience, the three lines
with the largest standard residuals are repeated in the subsequent table “Largest 3
standard residuals”. The user may wish to check each of these marked observations
for blunders, with a focus on the data and/or sites involved in that measurement.
Note that one blunder can affect many other quantities in the adjustment (estimated
states and post-fit residuals), so we strongly encourage the user to look for and cor-
rect only one blunder at a time, starting with the largest (likely associated with the
largest standard residual). After fixing that largest blunder, re-run the adjustment
and consider if there are any further blunders via another review of the standard
residuals.

6. Adjustments. Finally, consider the adjustment (or “update”) state vector and
final adjusted positions. All final positions (adjusted, fixed, and unused), along with
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their associated adjustment vector and formal covariance (for adjusted positions), are
provided in three tables corresponding to three different coordinates: “Final Adjusted
Positions XYZ” (for the positions in ECEF), “Final Adjusted Positions LLH” (for the
positions in geodetic latitude, longitude, and height above the WGS-84 ellipsoid), and
“Final Adjusted Positions Astronomic” (for the positions in astronomic coordinates,
along with deflection and undulation values, which required a geoid file be loaded).

4.5 Solution Methods

There are many ways to solve the least squares problem. These methods can be slow
or fast, robust or unstable — in many cases these properties depend on the nature of
the problem. The system of equations for survey adjustments tends to be very large
and sparse; that is, there are many unknown states and mostly zero terms in the
problem. As a result, the system matrix tends to be large, and the computation time
for traditional methods generally increases exponentially with size.

However, since the system matrix is generally sparse, a huge performance gain can be
obtained by cleverly performing operations only on the non-zero elements. lsasolver
offers two different methods to obtain the solution, both of which leverage sparse
matrix strategies to minimize computation time.

4.5.1 Square Root Information Filter

The Square Root Information Filter (SRIF) uses the Householder method mentioned in
Section 4.2.3 and is considered to be extremely robust [6]. SRIF is notable in that the
problem is not squared, the usual operation used to project the data onto the column
space of the system matrix. In general, it is not desirable to square the problem since
this reduces the space of the numeric precision and can lead to instability for poorly
conditioned problems.

Another key feature of the SRIF is that this method allows for easy determination of
certain properties such as the presence and location of a singularity, the condition
number, and the presence of non-positive eigenvalues without needing to perform an-
other computationally expensive operation. However, this is not the fastest available
method and the computation time can be long for large problems. Yet, this method
will produce the most reliable answer and also provides the user with some additional
information which may be helpful in diagnosing issues.

4.5.2 Conjugate Gradient Method

The Conjugate Gradient (CG) method is a departure from the traditional method of
factoring the system matrix. Instead, the CG method reduces the system of equations
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to a multidimensional optimization problem. The quadratic form of the problem is
represented as the following:

f(x) =
1

2
xTAx− bTx (4.9)

This function represents a multidimensional quadratic which may have a minimum
or maximum, depending on whether the system is positive- or negative-definite. The
critical point of this function occurs where its gradient is equal to zero:

(∇f)T =
1

2
(AT +A)x− b = 0 (4.10)

It can be seen that if A is symmetric, this reduces to:

(∇f)T = Ax− b (4.11)

Thus, a converging solution (i.e. one in which the residuals are minimized) to the
problem x can be determined by minimizing f(x) if and only if A is symmetric and
positive-definite.

The current implementation of this method squares the system matrix which reduces
the precision of the solution relative to the SRIF formulation. The following is a rep-
resentation of the weighted, squared problem:

Ax = b

⇓
ATWAx = ATWb

(4.12)

Since the problem was reduced from a factoring operation to an optimization process,
the time per iteration of the non-linear problem is greatly reduced.

Instead of building a custom CG implemenation for lsasolver, the Eigen library is
used to perform this operation [8]. The Eigen library also utilizes many optimizations
depending on the type of matrix used and the matrix operation.

4.5.3 What is the best method?

The default behavior of salsa is to try to use the CG method (because it is very fast)
and fall back to the SRIF only if an error is detected. In general, the CG method will
produce a solution that is equally useful (i.e. precise far beyond significant figures),
but there may be some information lost if there are issues or the problem diverges.

The user may specity which solver method(s) will be applied by lsasolver. Under salsa’s
project configuration options (Project → Configure...), the user may choose one
of three options under “Performance optimization:”
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Allow fast With this option specified, salsa will invoke lsasolver with the command-
line argument --forcefast. If the fast (CG) method fails, salsa will try again,
this time calling lsasolver with the --forcestable argument. This process will
typically be transparent to the user and is the recommended default behavior.

Force fast With this option specified, salsa will invoke lsasolver with the command-
line argument --forcefast. If that fails, an error message will be returned to
the user. This option may be appealing when the survey network is very large,
and the delay in returning a result with the SRIF implementation is unaccept-
able.

Force stable With this option specified, salsa will invoke lsasolver with the command-
line argument --forcestable. This option may be appealing when the network
is unstable, and the diagnostic output from the SRIF implementation is helpful
in diagnosing the issue. For example, if a position in the network lacks any
measurement data to determine the point’s height, the CG method may simply
fail, whereas the SRIF method may be able to report that the problem is singular,
at that specific point.

4.6 Example 0: GPS Only

To help the user understand what outputs are displayed on the screen after calcu-
lating an adjustment, we will begin by considering a simple example which reduces
to a two dimensional problem. The purpose of this example is to explicitly show how
the salsa outputs are computed. To aide with visualizing this example, Figure 4.8
presents the final adjusted network that we will obtain. To follow along, copy and
paste the example00 folder to your desktop. Launch salsa and select Project → Open
LSA and select ex0.proj from inside of the example00 folder. Next, we will ensure
that reliability calculations are enabled for this project. Reliability metrics are a help-
ful tool to diagnose the network’s susceptibility to blunders and are are given in-depth
coverage in example 2 and appendix B. Reliability metrics are enabled by default so
the user should not have to change any settings to perform these calculations. How-
ever, if reliability metrics are not enabled, the following instructions will allow the user
to enable them. To enable reliability calculations, open the Configuration Menu by
selecting the menu action Project → Configure. . . and under the Solver Options box,
select the yes button next to Calculate External Reliability. Press OK at the bottom
of the Configuration Menu to accept the changes and close the window. To see the
final adjusted result select Project → Calculate Adjustment. Interaction with the salsa
interface will be covered in much greater detail in example 1 in chapter 5.

We will place one control station (A) at 0o latitude, 0o longitude and 0 m height. We
will place a second control station (B) about a meter away at 0o latitude, (−9 × 10−6)o

W longitude and 0 m height. The control station coordinates are presented in Table
4.1
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Figure 4.8: Example 0 network.
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Table 4.1: Example 0 Control Network

Site Latitude Longitude Height

A 0o N 0o W 0 m

B 0o N (−9× 10−6)o W 0 m

The GPS measurement data from control station (A) to the floating point (C) is entered
into salsa in ECEF coordinates as (0 m, 1 m, 1 m). The GPS measurement data from
control station (B) to the floating point (C) is (0 m, 0 m, 1 m). Associated with these
measurements is an uncertainty which is entered as a covariance matrix. For sim-
plicity, we will choose both sets of measurements to have the same covariance matrix.
The GPS measurements and the measurement covariance matricies are presented in
Table 4.2.

Table 4.2: Example 0 Measurements

From-To ∆X(m) ∆Y(m) ∆Z(m) QXX(m2) QXY(m2) QXZ(m2)

QYY(m2) QYZ(m2) QZZ(m2)

A-C 0 1 1 10−12 10−12 10−12

10−6 10−7 10−6

B-C 0 0 1 10−12 10−12 10−12

10−6 10−7 10−6

There are in principle six observation equations, one for each measurement. However,
to simplify the presentation we will neglect the observation equations corresponding
to the X coordinate in the ECEF frame (U in the ENU frame). This is valid because the
displacements and covariances have been artificially chosen such that the neglected
axis does not significantly influence the result for the other two axes. Denoting the
residuals by R, the observation equations for our effective 2D system are

RYCA = −YC + (YC +∆YCA)

RZCA = −ZC + (ZC +∆ZCA)

RYCB = −YC + (YC +∆YCB)

RZCB = −ZC + (ZC +∆ZCB)

→


RYCA

RZCA

RYCB

RZCB


︸ ︷︷ ︸

R

= −


1 0

0 1

1 0

0 1


︸ ︷︷ ︸

P

·

 YC

ZC


︸ ︷︷ ︸

X

+


YA +∆YCA

ZA +∆ZCA

YB +∆YCB

ZB +∆ZCB


︸ ︷︷ ︸

d

.

(4.13)
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We have rewritten the observation equations in matrix form by introducing the resid-
ual vector (R), the partials matrix (P), the state vector (X) and the data vector (d).

The approach of least squares analysis allows us to find the most probable state vector
(X) by minimizing a constructed quantity which is a sum of residuals squared. The
quantity we minimize knows about the measurement uncertainties and uses those to
weight the terms in the sum (i.e. minimize Σ(weight)R2). The weight matrix (W) is
given by the inverse of the measurement covariance matrix (MCov)

W = MCov−1 =


10−6 10−7 0 0

10−7 10−6 0 0

0 0 10−6 10−7

0 0 10−7 10−6



−1

m−2 =


106 −105 0 0

−105 106 0 0

0 0 106 −105

0 0 −105 106

m−2.

(4.14)
The quantity to be minimized is

RT ·W ·R = (P ·X− d)T ·W · (P ·X− d). (4.15)

The superscript T denotes the transpose operation. To proceed with the minimization,
the quantity is differentiated with respect to the state vector X. This results in the
equation for the state vector introduced in the previous Chapter

(PT ·W ·P)︸ ︷︷ ︸
Cov−1

·X = PT ·W · d → X = Cov ·PT ·W · d. (4.16)

Note that the solution covariance (Cov) is given by

Cov = (PT ·W ·P)−1 (4.17)

=


 1 0 1 0

0 1 0 1

 ·


106 −105 0 0

−105 106 0 0

0 0 106 −105

0 0 −105 106

 ·


1 0

0 1

1 0

0 1





−1

m2 (4.18)

=

2×

 106 −105

−105 106

−1

m2 = 5×

 10−7 10−8

10−8 10−7

m2. (4.19)
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With our example we may explicitly write out the state vector

X = 5×

 10−7 10−8

10−8 10−7

 ·

 1 0 1 0

0 1 0 1

 ·


106 −105 0 0

−105 106 0 0

0 0 106 −105

0 0 −105 106

 ·


1

1

1

1

m

=

 1

1

m

(4.20)

The residuals are given by

R = −P ·X+ d ≈ −


1 0

0 1

1 0

0 1

 ·

 1

1

m +


1

1

1

1

m
(More precision kept)

≈


−10−3

−10−9

10−3

−10−9

m. (4.21)

These values are reported under |Raw| in the Measurement Residuals table.
In the rightmost column we have written the residuals found if one carries more digits
of precision through the computation.

Note that this entire process can be repeated until the adjustment size at an iteration
is very small (i.e. ∆X is below some limit in meters after rewriting X = Xprevious +∆X
and repeating the process to solve for ∆X). The covergence value displayed under
the heading “Convergence Test” is the root-mean-square (RMS) of the adjustment to
each floating site coordinate (∆XRMS). For this simple example the convergence test
immediately passes, though the convergence criteria may be modified under Project
→ Configure. . . if desired.

We have just computed the residuals which populate the |Raw| column of the Mea-
surement Residuals table depicted in Figure 4.9. We will now present how to obtain
the remaining outputs which appear in the Measurement Residuals table and the
Point Confidence Regions table.

The next column in the Measurement Residuals table is the Relative Residual. The
intuition for this quantity is that it is the size of the residual for a given measurement
divided by the measurement uncertainty (i.e. ∼ Ri/uncertainty). However, since the
measurement covariance matrix (MCov) contains off-diagonal terms we must be care-
ful about how we define scaling by (1/uncertainty). The notation of the “square root”
of the covariance matrix will take the form of a Cholesky decomposition in which the
measurement covariance matrix (MCov) is given as the product of a lower triangular

Approved for public release, NGA-U-2025-01219



44 CHAPTER 4. UNDERSTANDING THE SOLVER

Figure 4.9: salsa interface after calculating adjustment with example 0 data. This sec-
tion describes how to compute the output quantities appearing in the output tables.

matrix (L) and its transpose (MCov = L · LT ),


10−6 10−7 0 0

10−7 10−6 0 0

0 0 10−6 10−7

0 0 10−7 10−6

m2

︸ ︷︷ ︸
MCov

=


10−3 0 0 0

10−4 10−3 0 0

0 0 10−3 0

0 0 10−4 10−3

m

︸ ︷︷ ︸
L

·


10−3 10−4 0 0

0 10−3 0 0

0 0 10−3 10−4

0 0 0 10−3

m

︸ ︷︷ ︸
LT

(4.22)

The notion of “division” is implemented by multiplying with the inverse matrix (RRel =
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L−1 ·R)

RRel =


10−3 0 0 0

10−4 10−3 0 0

0 0 10−3 0

0 0 10−4 10−3



−1

m−1

︸ ︷︷ ︸
L−1

·


−10−3

−10−9

10−3

−10−9

m

︸ ︷︷ ︸
R

(More precision kept)
≈


−0.95

0.095

0.95

−0.095



(4.23)

These values are reported under |Rel| in the Measurement Residuals table.
We again have presented the final result if one keeps more digits of precision. Note
the relative residual has been defined such that it is dimensionless.

Before computing the standard residual, we need to introduce the concept of a pos-
teriori variance (APV). Considerations relating to APV requires that we treat the full
3D nature of our problem since the number of observations is different which in-
fluences the root-mean-square that we will compute shortly. APV is the χ2 value
divided by the number of degrees of freedom. Above the Measurements Residuals
table the number of observation equations (neq) and the number of variables (nvar)
are given, the difference between these two is displayed as the degrees of freedom
(ndof = neq − nvar = 6 − 3 = 3). The χ2 value depends on the RMS of the relative
residuals

RRMS
Rel =

√
1

neq

(
Σ
neq
i=1R

2
Rel,i

)
=

√
1

6
[0 + (0.95)2 + (0.095)2 + 0 + (0.95)2 + (0.095)2] = 0.55.

(4.24)

Note that the XECEF component contributes negligibly to the sum, but the presence
of the two X component observations changes the divisor under the square root. The
value of χ2 is given by square of the previously computed RMS times the number of
equations (χ2 = (RRMS

Rel )2 · neq). The APV is the χ2 per degree of freedom

APV =
χ2

ndof
=

(
RRMS

Rel

)2
·
(
neq

ndof

)
= (0.55)2 ·

(
6

3

)
= 0.6. (4.25)

This value is reported as APV under the “Chi-Squared Test” heading.

The “Chi-Squared Test” heading will display “PASS” if the APV is within an interval
indicated next to the “Chi-Squared:” text above the Point Confidence Regions table.
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The interval that the APV must lie in is set by the number of degrees of freedom
and the desired confidence level. The values are determined by the χ2 percent point
function (ppf).1 The χ2 ppf is the inverse of the cumulative distribution function (cdf)

ppfχ2(cf , ndof) = χ2 such that cdfχ2(χ2, ndof) = cf , where cdfχ2(cf , ndof) =
γinc

(ndof
2 ,

cf
2

)
Γ
(ndof

2

) .

(4.26)
Here cf denotes a confidence factor dependence on the desired confidence level (c), Γ
denotes the usual Gamma function and γinc denotes the lower incomplete Gamma
function. The APV lower bound is determined by evaluating the χ2 ppf with the
confidence factor equal to cf,lower = (1 − c) and dividing by ndof. Likewise, the APV
upper bound is determined by letting cf,upper = c in ppfχ2 and dividing by ndof. In our
example, chi2.ppf(1-0.95,3)/3=0.117 (95% probability to obtain an APV≥ 0.117) and
chi2.ppf(0.95,3)/3=2.605 (95% probability to obtain an APV≤2.605). The .out file lists
intervals for other values of cf . You can adjust the cf used for the interval displayed
in the GUI under Project → Configure. . .

The standard residuals are the relative residuals rescaled by the APV and the redun-
dancy

Rstd =


RRel,1/

√
APV · Rd1

RRel,2/
√

APV · Rd2

RRel,3/
√

APV · Rd3

RRel,4/
√

APV · Rd4

 =


−1.7

0.17

1.7

−0.17

 . (4.27)

These values are reported under |Std| in the Measurement Residuals table.
When the standard residual exceeds a threshold based on a particular confidence
value, as described in appendix B, that measurement may be a blunder.

The redundancy number for a particular observation is a measure of how well blun-
ders can be detected and resolved within a set of observations. A low redundancy may
imply that there is not a sufficient number of observations to determine if a blunder
is present. The effects of low redundancy can be explicitly defined using reliability
metrics, which are shown in the remaining columns in the Measurement Residuals
table. Considerable attention is given to reliability metrics and their uses in example
2. For a complete mathematical introduction to reliability metrics please reference
appendix B.

The redundancy number depends on the residual covariance matrix (QRR) which is
the difference of the measurement covariance matrix (MCov) and the inverse of the
weight matrix as estimated by the solution covariance matrix (Cov)

W−1
estimated = P · (PT ·W ·P)−1 ·PT = P ·Cov ·PT . (4.28)

1Unfortunately, a nice analytical formula for the ppf does not exist. However, many languages
support computation of the ppf. For instance, in Python one may use the command “chi2.ppf(cf,ndof)”
after importing “from scipy.stats import chi2”.
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The residual covariance matrix is therefore explicitly given as (QRR = MCov−W−1
estimated)

QRR =


10−6 10−7 0 0

10−7 10−6 0 0

0 0 10−6 10−7

0 0 10−7 10−6

m2

︸ ︷︷ ︸
MCov

−


1 0

0 1

1 0

0 1


︸ ︷︷ ︸

P

· 5×

 10−7 10−8

10−8 10−7

m2

︸ ︷︷ ︸
Cov

·

 1 0 1 0

0 1 0 1


︸ ︷︷ ︸

PT

= 5×


10−7 10−8 −10−7 −10−8

10−8 10−7 −10−8 −10−7

−10−7 −10−8 10−7 10−8

−10−8 −10−7 10−8 10−7

m2.

(4.29)

The redundancy number for a particular observation is the residual covariance ele-
ment for that measurement weighted by the appropriate weighting factor

Rd =


QRR,11 · W11

QRR,22 · W22

QRR,33 · W33

QRR,44 · W44

 = 5×


10−7 · 106

10−7 · 106

10−7 · 106

10−7 · 106

 =


0.5

0.5

0.5

0.5

 . (4.30)

These values are reported under Red’cy in the Measurement Residuals table.

The next column and second reliability metric after redundancy is the internal relia-
bility. Internal reliability is essentially the minimum error that can be detected in a
measurement due to redundancy. It is calculated in such a way that the units are
the same as the measurement itself (generally meters or radians). For example, if
a DXYZ measurement has an internal reliability value of 0.10, that means that the
smallest error that can be detected in the DXYZ measurement is 0.10 meters. Any
error smaller than that for this particular measurement will pass into the solution
without being detectable!

The internal reliability is calculated using two test statistics, α and β which produce
a non-centrality parameter δ0 (normally α = 0.01 and β = 0.05 which produces δ0 =
4.22068). Internal reliability depends on the non-centrality parameter (δ0) multiplied
by the square root of diagonal terms of the measurement covariance matrix (MCov)
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and divided by the square root of the redundancy vector.

∇Ŷi = δ0

√
MCovii√

Rdi
= δ0



√
MCov11/

√
Rd1

√
MCov22/

√
Rd2

√
MCov33/

√
Rd3

√
MCov44/

√
Rd4

 = 4.22068×



√
10−6/

√
0.5

√
10−6/

√
0.5

√
10−6/

√
0.5

√
10−6/

√
0.5

 =


0.006

0.006

0.006

0.006


(4.31)

These values are reported under Int Rel in the Measurement Residuals table.

The last column in the measurement residuals table is the magnitude of the external
reliability. This is calculated by mapping the internal reliability through the state
update equations to give a vector for each measurement. The entire external reliability
vector array is N(states) x M(Measurements). External reliability is explicitly defined
in appendix B. However, the calculations are complex and involve complex matrix
math so are left out of this example.

The magnitude of the external reliability is calculated by taking the magnitude of each
external reliability vector separately. The specific component values of the external
reliability vector are given in the ENU frame and can be found in the solver *.out
file. For a more comprehensive explanation of the terms in this *.out file reference
the appendix section titled “Understanding Solver Output”. This example has been
reduced to two dimensions but obviously in three dimensions the Xi,3 term would
follow accordingly

|External Reliabilityi| =
√
X2

i,1 +X2
i,2 =



√
0.002982 + 0.000002

√
0.002982 + 0.000002

√
0.002982 + 0.000002

√
0.002982 + 0.000002

 =


0.003

0.003

0.003

0.003

 (4.32)

These values are reported under Ext Rel in the Measurement Residuals table.

The first three parameters in the Point Confidence Regions table refer to error ellip-
soids which surround each floating point in the adjustment. The latter three param-
eters refer to reliability rectangles which also surround each floating point and are
discussed in example 2. The only floating point in our example is site C, since sites
A and B are fixed control sites. Therefore the only row with non-zero entries for our
example is the row corresponding to site C.

To construct the parameters of the error ellipse we must first transform the solution
covariance matrix (Cov) from the ECEF frame to the ENU frame. The coordinate
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transformation from the ECEF frame to the ENU frame is given by

XENU = RECEF2ENU·XECEF, RECEF2ENU =


− sin(lon) cos(lon) 0

− cos(lon) sin(lat) − sin(lon) sin(lat) cos(lat)

cos(lon) cos(lat) sin(lon) cos(lat) sin(lat)

 .

(4.33)
The solution covariance matrix transforms as

CovENU = RECEF2ENU ·CovECEF ·RT
ECEF2ENU. (4.34)

To use the formulae for our example, we need to determine the latitude and longitude
of site C. The longitude and height are approximately those of control site B (−9×10−6

o and 0 m), while the latitude is given by 0.03o. The ECEF frame to ENU frame rotation
matrix in our example is explicitly given by

RECEF2ENU =


1.6× 10−7 1 0

−1.6× 10−7 2.5× 10−14 1

1 −1.6× 10−7 1.6× 10−7

 . (4.35)

The solution covariance matrix in the ENU frame is thus

CovENU = RECEF2ENU · 5×


10−12 10−12 10−12

10−12 10−7 10−8

10−12 10−8 10−7

m2 ·RT
ECEF2ENU

= 5×


10−7 10−8 10−12

10−8 10−7 10−12

10−12 10−12 10−12

m2.

(4.36)

There is both 2D and 3D error information in the Points Confidence Regions table. We
will start with the 2D error ellipse which is rendered on the map around each floating
point. The major and minor axes of the error ellipse form a rotated coordinate system
with respect to the ENU coordinate system. The azimuth angle is defined as positive
for clockwise rotations resulting in

X2Dellipse = REN2ellipse ·XEN

Cov2Dellipse = REN2ellipse ·CovEN ·RT
EN2ellipse

REN2ellipse =

 − sin (Az) − cos (Az)

cos (Az) − sin (Az)

 (4.37)
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The diagonal components of the 2D error ellipse covariance matrix are given explicitly
by

q11 = qEE sin2 (Az) + 2qEN sin (Az) cos (Az) + qNN cos2 (Az)

=
1

2
(qEE + qNN)−

1

2
(qEE − qNN) cos (2Az) + qEN sin (2Az)

q22 = qEE cos2 (Az)− 2qEN sin (Az) cos (Az) + qNN sin2 (Az)

=
1

2
(qEE + qNN) +

1

2
(qEE − qNN) cos (2Az)− qEN sin (2Az)

(4.38)

We have used the trigonometric identities 2 cos2(θ) = 1+cos(2θ), 2 sin2(θ) = 1−cos(2θ) and
sin(2θ) = 2 sin(θ) cos(θ). We have let elements of the covariance matricies be represented
by q in order to avoid confusion.

The azimuth angle which extremizes the axis is given by

dq11
dAz

= 0 → tan(2Az) =
2qEN

(qNN − qEE)
→ Az =

1

2
tan−1

(
2qEN

qNN − qEE

)
≈ 45o. (4.39)

The larger of the two values
{√

q11,
√
q22

}
corresponds to the 2D major axis and the

other corresponds to the 2D minor axis. There is a scaling factor of
√
APV and a

confidence level scaling factor of
√
2F(1−c),2,ndof 2D maj

2D min

 =

 max
{√

q11,
√
q22

}
min

{√
q11,

√
q22

}
 ·

√
APV ·

√
2F(1−c),2,ndof

=

 0.00074

0.00067

m · 0.77 ·
√
2 · 9.55 =

 0.0025

0.002

m

(4.40)

These values are reported under the 2D maj column in the Points Confidence
Regions table. The 2D minor value is not reported in the Point Confidence table
but used in calculations throughout SALSA as well as being displayed graphically
in the error ellipse itself.

For our example F0.05,2,3 = 9.55, though other values of may be found in tables of the
F-distribution.2 An analogous calculation may be done for the three dimensional ENU
covariance matrix, in which case the largest of {q11, q22, q33} would correspond to the
3D maj column in the Points Confidence Regions table. We can summarize this more
compactly in terms of eigenvalues

3D maj

2D maj

2D min

 =


sqrt of largest eigenvalue of CovENU

sqrt of larger eigenvalue of CovEN

sqrt of smaller eigenvalue of CovEN

 ·
√

APV ·


√
3 · F(1−c),3,ndof√
2 · F(1−c),2,ndof√
2 · F(1−c),2,ndof

 .

(4.41)
2To determine F(1−c),d,ndof

values in Python, use “1/f.ppf(1-c,ndof,d)” after importing “from scipy.stats
import f”.
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Furthermore, the vertical line height is given as

Vert =
√
qUU ·

√
APV ·

√
F(1−c),1,ndof

. (4.42)

This value is under the Vertical column in the Points Confidence Regions table.

Note that the formulae presented in this section assume the default setting of “Scale
by APV”. This can be disabled under Project → Configure. . . if desired, and then the
appropriate formulae are those presented here without the APV factor.

To the right of the three point confidence columns are three similiar columns devoted
to reliability rectangles. These are calculated by rotating the external reliability vec-
tors into the ENU frame and then making the largest vector the major axis of the
rectangle. The minor axis is then scaled such that all other external reliability vectors
fit within the rectangle. Appendix B has an in-depth derivation of reliability rectan-
gles.

The relationships we have discussed have been summarized in Table 4.3 for future
reference.

Table 4.3: Output Formulae

Quanitity Formula

State Vector X = Cov ·PT ·W · d

Raw Residuals (“Raw”) R = −P ·X+ d

Rel Residuals (“Rel”) RRel = L−1 ·R

A Posteriori Variance (“APV”) APV =
(
χ2/ndof

)
=

(
RRMS

Rel

)2 · neq
ndof

Standard Residuals (“Std”) Rstd,i/
√

APV · Rdi

Redundancy (“Red’cy”) Rdi = QDiag
RR,i · W

Diag
i

Internal Reliability (“Int Rel”) ∇Ŷi = δ0
√

MCovii√
Rdi

External Reliability Mag (“Ext Rel”) |External Reliabilityi| =
√
X2

i,1 +X2
i,2 +X2

i,3
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Chapter 5

Examples

Perhaps the best way to gain familiarity with the SALSA suite is to build and execute a
least squares adjustment for a real-world survey. Chapter 4 contained a preliminary
example whose purpose was to introduce the user to the formulae used to obtain the
output. This chapter walks the reader through an example problem that highlights
the key elements of the salsa interface and outlines the authors’ vision of the typical
work-flow for a geodetic survey LSA solution. After introducing salsa through this
first complete and detailed example (Example 1), we provide another example that
highlights specific features in salsa; these too are important because they show how
salsa can shed light on - and help the user address - common problems in geodetic
survey networks.

5.1 Example 1: Combined GPS and conventional adjust-
ment

The first example we’ll introduce is a combined GPS and conventional observations
survey that will illustrate most of the key aspects of the salsa interface and serves as
a model for building and executing a least squares adjustment in salsa. Credit Mr.
Bradley Beal of NGA for providing these example data [9]. We will also leverage vari-
ants of this example elsewhere in this user manual to illustrate other salsa features
and LSA principles.

Our example survey design is depicted in Figure 5.1. The objective of the survey is
to determine the position (including height) of an inaccessible target, designated as
POLE. The survey design involves establishing a small network of temporary points
(TPs) using GPS vectors (shown in blue) from several established control sites. Then,
conventional observations (orange) between the TPs and the target allow us to esti-
mate the target’s position.

We will build this example in several stages, and we will execute least squares adjust-

53



54 CHAPTER 5. EXAMPLES

Figure 5.1: Portion of Example 1 network.
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ments at each stage. This incremental approach is good practice, in that by solving
several small problems we are better positioned to isolate and resolve errors than
when we attempt one larger complex adjustment.

As we introduce each measurement type, we will show, via the Record Editor, how
a user would manually create the measurements using the salsa interface. However,
we have also provided the measurement files in .lsa format so that the reader need
not manually enter all these data. Typically, we expect that users will have access to
measurement files in .lsa format or in some other format that is easily converted to
.lsa, such as GeoLab .iob files.

5.1.1 Create New Project

As a general rule, the authors recommend organizing a project’s data within a com-
mon folder. Although SALSA can read data files located outside the project folder,
keeping all the project data together keeps the organization simple for the user and
simplifies subsequent transfer or archival of the project.

We’ll create a new project called example01 in a folder by the same name on our
Desktop. Launch salsa, then use the menu action Project → New... and browse to
the Desktop/example01 folder (creating it if necessary), and specify the project file
name example01.proj. (We could use any file extension we want, but .proj is a
convenient convention for salsa project files.)

Upon creating a new project in this fashion, salsa will generate the new file
example01.proj, a nearly empty file containing only a single comment record that
indicates the date and time of project creation. salsa will also copy the default config-
uration file from the salsa installation directory into the project directory, giving it the
name example01.cfg. The salsa interface will look like Figure 5.2 at this point.

5.1.2 Introduce Control Points

Our control network includes the sites listed in Table 5.1.

Table 5.1: Example 1 Control Network

Site X Coordinate Y Coordinate Z Coordinate

VNDP -2678090.4859 m -4525437.0277 m 3597431.9403 m

P513 -2669569.2656 m -4504986.4064 m 3629597.4450 m

We could at this point start keying in records representing our control sites, but in
the interest of developing good habits, we will instead organize these position records

Approved for public release, NGA-U-2025-01219



56 CHAPTER 5. EXAMPLES

Figure 5.2: The Salsa interface upon creating our new project.

in their own dedicated file which is to be included in our main project. To do so, we
need to insert an empty ‘include’ record referencing the new file we wish to create.

Note that in salsa, when we insert a record, the new record will be inserted after
the currently-selected record at the same hierarchy level (i.e., in the same file as the
selected record). In the case of inserting a new project-level include, either the Project
Include record or any record directly within the project level may be selected.

Therefore, select either the Project Include record or the comment record, then use the
menu action Record → Insert → New Include to include our new file. When prompted
by the file explorer, provide a name such as control.lsa. Now the salsa Project
Navigator shows control.lsa within our project, and if we click the little triangle
next to this Include record, we see that this new included file is empty except for a
single comment.

Now we’ll insert our position records. Since we want our new position records to be
inside the control.lsa file, we need to select a record within that file, i.e., the com-
ment record. Figure 5.3 shows the Project Navigator at this state, with the comment
record selected.

Therefore, select the comment within control.lsa and proceed with menu action
Record → Insert → POSC (Station Position Cartesian). This will result in a new,
selected, POSC record with its attributes available for editing in the Record Editor.
Now we can key in the first station name and coordinates as listed in Table 5.1. Since
these are control sites, set the position’s Type to Fixed.
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Figure 5.3: The Salsa Project Navigator after inserting a new Include record to contain
position records for a control network. Note the currently selected record (a comment
record) is inside control.lsa; therefore a subsequent Record → Insert operation will
yield a new record inside control.lsa as desired.

We could now proceed with menu action Record → Insert → POSC to create a record
for site P513 as well. However, entering all of the associated data (and all the mea-
surements we’ll get to momentarily) is very tedious, so the authors have provided
input files that can be imported into this project. Let’s take advantage of those!

Example data are included in the SALSA installation directory; on Windows systems
this will typically be C:\Program Files\SALSA\examples\. Copy the contents of
the example01 directory into the example01 folder you already created on your Desk-
top. (Note: Please utilize the examples directory only for copying data as some user
permissions may not allow writing to this directory.)

Now, in salsa, delete the control.lsa Include record by selecting the record and
pressing the delete key or by menu action Record → Delete. Replace the deleted
record by inserting ctrl_sites.lsa (which we just copied into our project folder) via
the menu option Import → Include from LSA. . . (or F6); when prompted, select the file
ctrl_sites.lsa.

Figure 5.4 shows the salsa interface after the two control sites have been introduced
to the project. (The Include record has been expanded and the first POSC record
selected.)

5.1.3 Execute GPS-only Adjustment

Next, we will introduce GPS vector estimates to the project; these will be used to
determine positions for the TPs. These GPS vectors will share an uncertainty model
(UNCR record). Thus, we could proceed manually by creating a UNCR record and then
keying in all the GPS vectors and covariance matrices, each time specifying that UNCR
record. Instead, we will take advantage of an lsa-formatted file already prepared in
this way.

Ensure that the existing Include record in the measurement tree is selected, so that
the next Include record we insert will be inserted at that same level of the hierarchy.
Then use the menu option Import → Include from LSA. . . and when prompted, select
the file gpsMeasurements.lsa.

Expand the gpsMeasurements.lsa Include record and take a moment to review the
contents. We see the UNCR record and six GPS vectors (DXYZ) relating the TPs to
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Figure 5.4: The Salsa interface after inserting an Include record containing a small
network of control sites.

control sites VNDP and P513. The Details column of the Project Navigator shows the
lengths of each vector. Select the UNCR record and look at the attributes shown in the
Record Editor. It’s been given a meaningful label ‘UNCR DXYZ STATIC’ and contains
two non-zero components, a to-station centering error and a from-station centering
error. Both errors have a value of 1.0 mm. These error terms will be combined
with the uncertainty (covariance matrix) specified with any measurements referencing
this UNCR record; each of the GPS vectors reference this UNCR so any uncertainties
specified by their individual measurements will consider the aforementioned error
terms.

Select one of the DXYZ records and review its attributes in the Record Editor. We see
the From and To sites specified, the X/Y/Z vector components, and the upper triangu-
lar covariance matrix components. We see that the ‘UNCR DXYZ STATIC‘ uncertainty
model has been specified.

Note that the Scaling for each measurement is set to None, for an effective value of
1.00. This is also a good time to point out the Scale column in the Project Navigator.
Each Include record includes a scale term. By default, this is set to None (1.000),
however the user may specify a VSCA label or numeric value and this value will be
propagated to each of the child records associated with the Include. Later in this
example we will use this field to manipulate the scaling of the uncertainty in our
observations to achieve a properly balanced observation set.

Also note that our map looks pretty plain; we don’t see the GPS vectors we just
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added, nor do we see the TPs. This is because salsa doesn’t yet know the location of
the TPs. . .

We can now proceed with a least squares adjustment of these GPS vectors. If we were
to select the menu action Project → Calculate Adjustment, initial coordinates for the
TPs would be determined, and the least squares solution would commence. But in-
stead of jumping right to the network adjustment, let’s take advantage of salsa’s menu
action Project → Generate Initial Positions (do save when prompted). This action ac-
tually initiates a solution (using lsasolver behind the scenes) but aborts immediately
after determining the initial coordinates of any unknown points, such as our TPs.
This action can be useful to users in that it facilitates rendering of the measurement
network in the map, and the user has an opportunity to ‘sanity check’ the problem
before commencing with a least squares solution.

After generating the initial positions, observe that they (the TPs) are now shown in the
Project Navigator, under a new Include record near the top labeled ‘Auto-generated
Initial Coordinates.’ Each of these ‘auto-generated’ POSG records is depicted with a
little gear image to remind the user they are automatically determined and were not
part of the user’s problem definition. These will be overwritten each time the user
calculates an adjustment. These records are not editable (except for their station
label), and they cannot be copy-pasted elsewhere into your project. You may delete
them, since they will just be auto-generated again the next time you calculate an
adjustment.

Though doing so now is not advised unless this example has been previously executed
successfully at least once, auto-generated POSG records may be permanently added
to a project; do so by running Project → Calculate Adjustment, opening the final
positions table via View → Final Positions, selecting an auto-generated point, then
right clicking to access and select the Add to project as Float option. Doing this
will make the gear icon disappear and the POSG record become persistent, moving
the POSG into a new Include record (and file on disk) initial_coordinates.lsa.
Thereafter, the file will be used as input to the solver and will not be overwritten when
calculating an adjustment.

Now that we have initial positions estimated for the TPs, the TPs show up in our map,
as do the GPS vectors to the control points. Note that auto-generated positions are
depicted with ‘?’ on their markers. (If the adjustment was already calculated in order
to permanently add the auto-generated POSG records to the project, the Initial radio
button below the map may need to be re-selected to display the initial auto-generated
positions with their ‘?’ symbols.)

Take a few moments to experiment with the map controls. Panning and zooming can
be done with mouse actions (click-and-drag, and scroll, respectively) or by using the
navigation controls overlaid on the map. (If you prefer, you can instead use the arrow
keys on your keyboard to pan, and +/- to zoom.) Note the little ‘home’ button in those
controls; it will redraw the map to include everything in our network.

Zoom into the cluster of TPs on the map. Note that when you select an item in the
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map (by clicking on it), it also becomes selected in the Project Navigator. Conversely,
when you select a record in the Project Navigator, it becomes selected (highlighted)
in the map. This coupling of the interfaces is intended to help users visualize their
measurement network and troubleshoot blunders or other errors.

Since our network appears to be sane, let’s proceed with an adjustment. First, we will
disable reliability metrics. Reliability metrics are turned on by default but are not the
focus of this example. They are the primary focus of example02. To disable reliability
metrics, first open the Configuration Menu by selecting the menu action Project →
Configure. . . and under the Solver Options box, select the no button next to Calculate
External Reliability. Press OK at the bottom of the Configuration Menu to accept the
changes and close the window. Use the menu action Project → Calculate Adjustment
(or F5). Save when prompted.

Wow! Lots of things just happened in the salsa interface! Reference Figure 5.5. Just
below the Project Navigator we see some summary information (processing time, de-
grees of freedom, etc.) and two important tests: the convergence test, and the Chi-
squared test. The convergence test shows that convergence was achieved, in 2 it-
erations, and the test indicates PASS. However, the Chi-squared test does not pass
with the default confidence level of 1-sigma. The significance of this result will be
discussed momentarily, for now let’s proceed to investigate other components of the
salsa interface.

Figure 5.5: The Salsa interface after running the GPS-only adjustment.

Below these convergence and Chi-squared test summaries we see a Measurement
Residuals table, which by default lists each measurement in descending order of
standard residual magnitude. Note that DXYZ vectors are listed in this table by
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individual components (X, Y, Z). If any measurement standard residual exceeds the
statistical test threshold as defined in appendix B, the standard residual value is
rendered in red text; no measurements in this example exceed the threshold.

Now is a good time to again mention that reliability metrics are not calculated in
this example. Because of this, a few of of the features in the salsa interface are
disabled. First, the “Max Ext Mag (m):” heading is disabled. Next, the two rightmost
columns of the Measurement Residuals table should be ignored. Lastly, the three
rightmost columns in the Point Confidence Regions table as well as the checkbox
labeled “Rectangles” in the mapping window should also be ignored. See example02
for in-depth coverage of reliability metrics and their uses.

To the right of the Measurement Residuals table we see the Point Confidence Regions
table. This table lists all points in the network in descending order of their 3-D
confidence region major axis length (the user can choose to sort by other columns).
Thus, points with the largest uncertainty are listed first.

In the status window at the bottom of the interface we see some output from the
CLI applications that prepared the data (lsapreprocessor), executed the adjustment
(lsasolver) and extracted results (lsapost). Since this adjustment executed appropri-
ately, there isn’t too much of interest in here, but know that this output exists and is
a good place to look for issues if the adjustment is not successful.

Finally, we note that the map has changed. The map now shows the least squares
problem output, not the input (observe the Initial and Adjusted radio buttons below
the map which allow the user to switch between the two states.) Our TPs are now
rendered with error ellipses depicting their 2-D confidence regions. The scale of the
ellipses is shown below the map and can be adjusted by manipulating the slider.

So how did the adjustment go? The solution converged, no measurements were
flagged as blunders and our point confidence regions are all sub-cm. However, given
the high APV value of 4.401 raised a failure alert for the Chi-squared test, this should
not be deemed a success. Generally, when the Chi-squared test fails this should be
taken to mean that the data are discrepant with the model parameters. This can be
attributed to blunders in the data or having overly optimistic sigmas that are small
in value. Given that no blunders were raised in the measurement residuals table, the
latter explanation seems a likely candidate.

Let’s account for this by utilizing a variance scaling (VSCA) modifier. In the project
navigator, select the UNCR record and proceed to click on Record → Insert → VSCA.
Edit the label and Scale Factor values of the new VSCA record to GPS and 2.000
respectively. Multi-select all of the DXYZ records by clicking on the first DXYZ record,
then press Shift + Left click on the last DXYZ record. Go to the Scaling dropdown
box in the Record Editor and select GPS from the dropdown menu. Take a moment
to observe that the Scale value for each of the DXYZ records is now 2.000.

Calculating a new adjustment will drop the APV to a more reasonable value of 2.200.
Unfortunately, this still does not pass the Chi-squared test. At this point, we could go
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back to our VSCA record and increase its value further; instead, let’s try an alternate
method of boosting the variance scaling of the DXYZ records. Find and click on the
gpsMeasurements.lsa Include record. In the Record Editor, click on the Scaling
dropdown box and select Value, then set the number next to the dropdown box to
be equal to 2.000. Upon hitting the Enter key, the user will observe that the scale
values of our DXYZ records are now equal to 4.000. Setting a scale value (either by
entering the value directly or through a VSCA record) on the parent Include record
will propagate to each of the child records. However, since each child DXYZ record
also utilizes the GPS VSCA modifier, the scale for those DXYZ records is the product
of their VSCA modifier and the scale of the parent Include record. Calculating a new
adjustment now yields a Chi-squared value of 1.100, which passes the test.

5.1.4 Add TP Conventional Network

We will now add the conventional observations between the TPs. These observations
include direction sets, zenith angles, and distances. Again, keying these data man-
ually would be very tedious, so please take advantage of the prepared files provided
with SALSA. In the Project Navigator, select our last Include record
gpsMeasurements.lsa (so that the next include will be inserted at this same level
in the hierarchy). Then use menu action Import → Include from LSA. . . and when
prompted, select the file conventional.lsa. Figure 5.6 shows the Project Navigator
once that file is included and expanded.

Take a few minutes to review the records we just inserted. Select the different
record types and review their attributes in the Record Editor. Observe the organi-
zation of these records; instrument heights and uncertainty models are specified near
the top, then the observations are specified by type within their own included file
conventional_TP.lsa: direction sets, zenith angles, and distances. This is just one
example of a project’s organization; some users may prefer to group observations by
setup instead. SALSA is not order-dependent, giving the user flexibility to organize
their project however they choose. For example, the instrument heights could be
specified after the observations, and the solution will not be impacted.

Let’s look specifically at instrument heights. Select the first HGHT record, with label
HGHT TP1. The Record Editor shows just five attributes: Enabled, Label, Height,
Sigma, and the General Notes field. This record is enabled, and we could disable
it by unchecking it in the Project Navigator or the Record Editor. It has the label
HGHT TP1 which is obviously a reference to the station name TP1. Note, however,
that this label can be any text that the user finds helpful that can uniquely identify
this height and sigma value. For example, if TP1 was set up and observed twice, once
by Jack, and once by Sue, we will have two different instrument heights and sigmas
for TP1, and we would create two HGHT records, perhaps one with label HGHT TP1-
Jack and one with HGHT TP1-Sue (or morning and afternoon - whatever works!).
Further description can be kept in the General Notes field for later reference.

Now that we see that a height record is just an arbitrary label and a value, skip down
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Figure 5.6: Portion of the Salsa Project Navigator after adding conventional observa-
tions to the temporary points.

to the first ZANG (zenith angle) observation, and let’s see how these height records are
referenced. Figure 5.7 shows the Record Editor with the first ZANG record selected.
Observe that this zenith angle is observed at station TP1 and is observing the zenith
angle to TP2. The Record Editor shows “Height From:” and there is a dropdown list of
choices. The currently-selected height record is the one we looked at moments ago,
with label HGHT TP1, and we see that the value is shown next to it, 1.6160 meters.
Look at the other options. We see the other height records available, and we see the
choice “Value.” If we choose Value, the 1.6160 entry becomes editable, and we can
type in a numeric value applicable to this individual ZANG observation.

The point we hope the reader takes from this close look at these height and ZANG
records is this: salsa provides the flexibility to key in these values directly, but a
smarter scheme is to define these attributes (height of instrument, uncertainty model)
with descriptive labels, and then specify those ‘modifiers’ by name in the individual
measurement records. This way, the user only needs to make an edit in one place
(the referenced HGHT or UNCR record) to update all the measurements referencing
that modifier. At this point, proceed to calculate an adjustment. The APV still passes
for our updated network with an APV value of 1.042.
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Figure 5.7: Record Editor showing the attributes of a ZANG (zenith angle) record.

5.1.5 Add Conventional Observations to Target

Finally, let’s add the conventional observations to the inaccessible target, which
is the subject of this survey after all. These observations are provided in the file
conventional_tgtPole.lsa, so select the Include record in our project tree
conventional_TP.lsa (located as a child record in the conventional.lsa Include
record), then use menu action Import → Include from LSA. . . and when prompted,
select the file conventional_tgtPole.lsa. Expand it in the Project Navigator and
observe that there are three groups of observations, this time organized by measure-
ment type. The observation sets include direction sets, zenith angles, and distances
to a new-to-this-project site named POLE. Note that these observations reference the
same height (HGHT) records and uncertainty models (UNCR) that we defined inside
the TP-only file.

Proceed with an adjustment (F5). Similar to the GPS only adjustment we can observe
that the convergence test passes with sub cm confidence intervals. However, the Chi-
squared test now fails with a value of 6.595 and there are now two ZANG records
highlighted red in the Measurement Residuals table. Our first diagnosing tool that
should be utilized for probing discrepant data is the measurement residuals table.
Sort the rows by the |Std| column. At the top two entries the outlying ZANG data
records can be observed. Upon closer inspection the user may notice that two of the
top three entries are ZANG measurements with POLE serving as the To point.

With the prevalence of ZANG records at the top of our Measurement Residuals table, it
seems prudent to investigate these measurement types further. From the menu select
Record → Find/Filter (or Ctrl+F). The Filter row will contain a dropdown box with a
default value of ’All Records’. Click on the box and scroll until you find an option
labeled ZANG. Once found, click on the option to leave only ZANG records and their
associated parent Include records. Scrolling through the individual sigmas, it can be
observed that many have reported sigmas as low as 1 arc second. Exit out of the
Filtered view by clicking the x in the upper right hand corner of the Find/Filter box.
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Find the UNCR records under the conventional.lsa Include record and select the
‘UNCR ZANG‘ uncertainty modifier. Navigate to the Sigma row in the Record Editor
and modify the sigma value to be 3.0 soa.

Calculating an adjustment will lower the APV to a more reasonable value of 3.030,
but the Chi-squared test still fails. At this point, we will introduce another useful
diagnostic tool, the Histogram Dialog box. Select View → Histogram to observe the
Histogram Dialog box present in Figure 5.8. The histogram utility displays all of
the measurement residuals in one plot while allowing the user to switch on or off
measurement types or files from the residuals view as well. On the tail ends of the
histogram, we can observe that two ZANG measurements still appear to be outliers.
Clicking on these two ZANG measurements on the two tail ends reveal that both of
the measurements have POLE serving as the To station...

Figure 5.8: Measurement histogram with APV value of 3.015

Go ahead and close out of the histogram. Navigate to the Zenith Angles section
of the conventional_tgtPole.lsa Include record and create a new UNCR record
by selecting the menu option Record → Insert → UNCR. Assign its label a value of
‘UNCR ZANG POLE‘; its From Centering Error a value of 1 mm; its To centering error
a value of 1 cm and its Sigma a value of 10.0 soa. Multi select all of the ZANG mea-
surements under conventional_tgtPole.lsa and select ‘UCNR ZANG POLE‘ from
the Uncertainty dropdown box. Calculate an adjustment to observe a new APV value
of 2.300. Though the Chi-squared test has not passed yet, the POLE ZANG measure-
ments are no longer at the top of our measurement residuals table. Opening up the
Histogram again, the user can also verify that the ZANG measurements are no longer
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present at the two end tails. The POLE DIST measurements now appear at the top of
the measurement residuals table.

Upon selecting either of the DIST measurements in the conventional_tgtPole.lsa
Include record, it can be seen that both measurements contain a reference to the
‘UNCR DIST RED‘ uncertainty modifier. Navigate to the Uncertainty Modifiers section
under the conventional.lsa Include record and select the ‘UNCR DIST RED‘ un-
certainty modifier. To verify that this modifier is only associated with the POLE DIST
measurements, right click ‘UNCR DIST RED‘ and select Select Referencing from the
menu. The desired measurements (and only the desired measurements) are high-
lighted appropriately. Select the ‘UNCR DIST RED‘ uncertainty modifier and modify
its sigma value to be 3 cm. Recalculating an adjustment yields a passing value of
1.082.

5.1.6 Review and Summary

Zoom in on the map to the small network of TPs and our target POLE. Note the relative
sizes of the error ellipses; it is reasonable that the uncertainty in POLE is larger than
for our TPs which benefited from GPS vectors. Our Point Confidence Regions table
shows that the uncertainty in POLE’s final position estimate is at the cm level, at 1-
sigma confidence level. The current choice of confidence level is displayed at the top
of the Point Confidence table and can be changed in the Configuration Menu. Figure
5.9 shows the map view at this stage.

Before leaving this example, let’s take note of three output files that have been gener-
ated each time we have run an adjustment. All should exist in the example01 folder
containing our project.

The first is the log file produced by lsasolver, named example01.out. Since this
example problem ran well for us, and we were able to troubleshoot a few discrepant
measurements using the salsa GUI, we really didn’t find ourselves needing to dig into
the log file for this example. However, the reader is encouraged to scan through this
log file, relying on the explanation in Section 4.4 as a guide.

The second is example01.pts which is a simple text file containing all the points
involved in this adjustment. This file can be opened via the menu action View → Final
Positions and is intended to give the user a quick look at the output in tabular format.

The third is a comma-separated values file named example01.csv. This file also
contains the adjusted coordinates but in a format easily opened using your favorite
spreadsheet program.
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Figure 5.9: Map showing TP and Target adjusted coordinates and confidence ellipses.
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5.2 Example 2: Redundancy and Reliability

Example 1 illustrates some of the indicators SALSA uses to help the user recognize
that a problem exists (e.g., the failing Chi-squared test and elevated APV), and how
these indicators can help the user isolate the problem (e.g., by flagging measurements
with high residuals). This example illustrates additional important indicators of the
solution quality: the redundancy and reliability metrics. Redundancy is critically
important in a geodetic least squares problem, and thus the user should ensure the
network contains sufficient redundancy in order to have confidence in the final result.
The confidence is mainly expressed through reliability metrics, which will be the focus
of this example.

In essence, reliability metrics inform the user of the network’s susceptibility to blun-
ders. This is done through three metrics: local reliability (also known as redundancy),
internal reliability, and external reliability. The first half of this example will inform
the user of the causes and indicators in SALSA of low redundancy. The second half
will focus on the external reliability metric to show the impact of low redundancy on
affected points in the network.

Please reference Appendix E titled “Understanding the Solver Output” for a brief ex-
planation of redundancy and reliability metrics and references therein for further
reading. Reference Appendix B, “Reliability and Standard Residuals,” for a compre-
hensive treatment of these Reliability metrics.

To execute this example, copy the example02 folder from the SALSA installation di-
rectory (i.e., C:\Program Files\SALSA\examples\example02) onto your desktop or
other convenient location. Start salsa and open the project file redundancy.proj
(Project → Open LSA. . . ). For the first part of this example, make sure salsa is not
configured to compute external reliability:

• Project → Configure. . .

– Calculate External Reliability = No

Then run the adjustment (F5). Figure 5.10 shows the salsa interface after the adjust-
ment, and Figure 5.11 provides a zoomed-in view of the network design within the
map view.

There are three fixed points to the east, and a single estimated target to the west. The
target is estimated using the classic “three-point intersection” methodology: azimuths
from each of the fixed points intersect at the target to determine horizontal position,
and zenith angles from the fixed points determine the height component. Direction
sets or horizontal angles could have used instead of azimuths, but azimuths are easier
to show in this example.

This solution looks fine: The adjustment converged, the Chi-squared test passed, and
no standard residuals are flagged as likely blunders.
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Figure 5.10: salsa interface for redundancy project, after adjustment.

What happens if the three-point intersection is reduced to a two-point intersection?
To find out, select and disable the AZIM measurement record from TP03 to TGT1
and re-run the adjustment (F5). Note the solver still achieves convergence, the Chi-
squared test passes with an APV near 1.0, and there are no high residuals. How-
ever, the two remaining azimuths to TGT1 show redundancy values very close to zero
(0.001). In addition, the Int Rel column for these two measurements show values of
approximately 1257 and 1413 SOA respectively. This means that any error in the
measurement smaller than 1257 or 1413 SOA will be undetectable. Why this is a
cause for concern will be shown later through external reliability. Save the output
files .out, .csv, or .pts for reference later in this example.

Even though the solver successfully converges on a solution and the Chi-squared
test passes, the redundancy metric indicates a major problem in the survey. Lacking
redundancy means that any error in the measurements goes directly into the solution
without any obvious indication to the user!.

To demonstrate this problem, select the AZIM record from TP02 to TGT1 and change
the minutes value of the angle from 10’ to 19’ (simulating a user blunder). Then run
the adjustment. Figure 5.12 shows the state of the salsa interface at this point.

If the low redundancy metric is ignored, the solution appears satisfactory: it converges
with no high residuals and a passing Chi-squared test. However, the final adjusted
position of TGT1 is now over three meters shifted to the west due to this blunder. The
shift in solution is observable by comparing the XYZ Final Adjusted Position for TGT1
in the .out output file from before and after the blunder error is introduced. Take
note: ignoring low redundancy in the network leaves you susceptible to measurement
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Figure 5.11: The redundancy project survey network.

Approved for public release, NGA-U-2025-01219



5.2. EXAMPLE 2: REDUNDANCY AND RELIABILITY 71

Figure 5.12: Introducing a 9’ blunder in the AZIM TP02 to TGT1 record (19’ vs 10’).

blunders with no obvious indication that an error has occurred.

Leaving the blunder error in place and re-activating the third azimuth record (from
TP03 to TGT1), re-run the adjustment. Now the Chi-squared test blows up with an
APV value of 718, a clear indication something is wrong. The Chi-squared test in-
dicates whether the post-fit residuals (i.e. the difference between the observed and
expected measurements) are aligned with the prescribed uncertainties of the mea-
surements, so having 9 arc-minutes of error in one of the post-fit residuals relative to
the expected 10 arc-seconds uncertainty produces a very high APV. However, as this
example illustrates, errors in measurements that lack adequate redundancy do not
yield high residuals and thus do not inflate the APV or cause the Chi-squared test
to indicate a problem. The user must understand that some redundancy is required
for every measurement in the network in order to have full confidence in the final
solution.

How much redundancy is required to achieve confidence in the solution? This can be
a difficult question to answer. First of all, there is no single ideal minimum thresh-
old that is appropriate for all geodetic survey problems. Second of all, how can the
surveyor know how poor redundancy in a given measurement actually affects their
confidence in the final adjusted coordinates? Fortunately, SALSA includes reliability
metrics which may help answer these questions by mapping and quantifying the im-
pact of low measurement redundancy into terms the user understands: final adjusted
coordinates. Reliability metrics provide an intuitive and visual descriptor, called a “re-
liability rectangle,” which shows a zone wherein the solution cannot be verified based
on elevated standard residuals alone. If the size of the rectangle exceeds the user’s
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tolerance for unchecked errors, then the user knows they must add additional mea-
surements to the network. A deep dive into the mathematical basis behind reliability
metrics can be found in appendix B, “Reliability and Standard Residuals.”

Reliability metrics are normally enabled by default. However, reliability calculations
were turned off by at the beginning of this example and will have to be manually
re-enabled. Go ahead and enable reliability calculations, and adjust the warning and
error thresholds as follows:

• Project → Configure. . .

– Calculate External Reliability = Yes

– External Reliability Warning (m) = 0.5

– External Reliability Error (m) = 1.0

In the Tree View, locate and disable the third azimuth record (TP03 to TGT1) again.
Recalculate the adjustment.

Figure 5.13: Output with reliability metrics included

Recall that earlier, even with the 9’ blunder, there was nothing obvious in the salsa
output to draw our attention to any problem. Now, looking at Figure 5.13, immediate
changes are noticeable. First, the Ext Rel (external reliability) column header in the
Measurement residuals table is highlighted red and the column has been filled with
meaningful values instead of dashes, unlike before. Within the table, the user can
see the two AZIM measurements are flagged with values that are 7.919 and 8.444
meters respectively. Above the Measurement Residuals table, the text “Max Ext Mag
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(m): 8.4440 > 1.0000” is also highlighted red. This value represents the maximum
external reliability value for all measurements and indicates whether that value con-
stitutes an error (red) or a warning (orange) based on the user-configurable thresholds
we edited moments ago. In addition, the Point Confidence table now displays three
additional numbers beyond the ellipse values: 3D maj RR, 2D maj RR, and Vertical
RR. These values represent the 3D and 2D major axes of the reliability rectangle as
well as the vertical component of the reliability rectangle.

What does all of this mean? Because the maximum external reliability magnitude
calculated is 8.444 meters, any error in a measurement (i.e., blunder) that affects the
estimated position by less than 8.444 meters is undetectable. In other words, the
solution exists in a zone (reliability rectangle) indicating how much the solution could
change due to a blunder without registering elevated measurement residuals.

To highlight the scale of the reliability rectangle for this example, Figure 5.14 shows
the reliability rectangle enabled in the mapping window. Note the reliability rectangle
is enabled by selecting the corresponding checkbox in the mapping window. The
rectangle is cyan by default; however, the user has the ability to change the color, line
style, and line width in the menu Preferences → Map Preferences...
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Figure 5.14: Reliability rectangle with one AZIM record disabled (2-point intersection).
Note the scale of the map shows the rectangle is several meters in size.
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At first inspection, it may appear that the point confidence regions (ellipses) were
disabled, but in fact, the TGT1 ellipse is so small in comparison to the reliability
rectangle that it is invisible. While the survey result exhibits adequate precision
(i.e., sub-meter error ellipse), the lack of redundancy yields a reliability rectangle that
highlights the susceptibility of the survey result to a single undetectable error.

Now, re-enable the third AZIM measurement and recalculate the adjustment. The
reliability results change drastically. The “Max Ext Mag(m):” value has dropped to
0.3227 meters; the survey design is now capable of detecting a multi-meter error as
has been introduced in our AZIM record from TP02 to TGT1. The residuals and Chi-
squared test are able to quickly show that a blunder has been committed. Diagnosing
the problem is now similar to what was done in example01.

Figure 5.15: Reliability rectangle with AZIM record re-enabled (3-point intersection).
Note the scale of the map shows the rectangle is sub-meter.

For completeness, and to satisfy our desire to resolve the blunder in this survey,
correct the blunder in the AZIM record (TP02 to TGT1), restoring the minutes field
from 19 back to 10. Re-run the adjustment. All tests should pass, and both the point
confidence region and reliability rectangle should be sub-meter, as shown in Figure
5.16.

In summary, just as the point confidence regions and ellipses help quantify and visu-
alize the precision achieved through the survey and adjustment, the reliability metrics
and rectangles help quantify and visualize the sensitivity of those results to a single
undetectable error. In order to assert confidence in a survey result, the surveyor
must ensure that the survey design includes sufficient redundancy to meet both the
precision and reliability goals as demanded by their application.

Approved for public release, NGA-U-2025-01219



76 CHAPTER 5. EXAMPLES

Figure 5.16: Adjustment result with blunder resolved. Note the ellipse and rectangle
show the precision and reliability, respectively, are sub-meter.

5.3 Example 3: 1D Adjustment (Leveling) Workflow

A commonly encountered problem in survey is the need to run an adjustment on a
leveling line. These adjustments are special since they typically are devoid of any
measurements which could be used to determine the horizontal position of a point.
(Note: Project data for this example were constructed from [10]). Consider the fol-
lowing project initially consisting of one fixed point and two points fixed in latitude
and longitude. Since we will only be incorporating leveling data, it is important that
our unknown points be fixed in latitude and longitude so that the problem is not
underdetermined. Create POSG records utilizing the information in Table 5.2 below.

Table 5.2: POSG Record Values

Point Status Lat (N) Lon (W) Orthometric Hgt(m)

AUSTIN CE Fixed 30 16 48.06083 97 44 16.33828 160.1613

N2277258 Lat/Lon Fixed 30 16 48.03800 97 43 48.14953 0.0000

A 1521 Lat/Lon Fixed 30 16 49.57966 97 43 0.43960 0.0000

We will now incorporate the set of HDIF measurements from our fixed station to the
stations whose heights we want to estimate. Locate the example\example03 subdi-
rectory and copy its contents into the current project folder. Utilizing the Import →
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Include from LSA... menu action, go ahead and select the file loop1.lsa. At this
point, go ahead and expand the records under the loop1.lsa Include record. The
hdiffsAB.lsa contains HDIF records starting at AUSTIN CE and going to N2277258,
while the hdiffsBA.lsa Include record contains HDIF records working in the oppo-
site direction.

At this point, the user may have noticed that in each .lsa record that only two points
have latitude and longitude information associated with them. The rest only have
HDIF records. Normally, this would cause the problem to be underdetermined. How-
ever, SALSA is fully capable of handling 1-D leveling lines. As a demonstration, go
ahead and disable the hdiffsBA.lsa Include and A 1521 POSG records. Hit the
Home key in the Map widget to refresh the view, then select the menu action Project
→ Generate Initial Positions and when prompted select Save.

The user can now observe the appearance of the temporary leveling points between
AUSTIN CE and N2277258 in Figure 5.17. Zooming in on the map it can be seen
that the temporary points are chained together based on the set of HDIF records they
are associated with. Further inspection in the Auto-Generated Initial Coordinates
shows that SALSA has made an initial estimate of the Latitude and Longitude for
these temporary points and fixed those two values as well. SALSA has a special
treatment for 1-D leveling lines. As the temporary points can not be estimated by
most of the a priori algorithms, if SALSA detects a collection of points joined together
by HDIF records, it will estimate their latitudes and longitudes by evenly spacing the
points between the estimated endpoints. Once those estimates are obtained, their
latitude and longitudes will be fixed so that the solver can compute unique solutions
for these points in 3D space. The estimation of these values serves mostly as a sanity
check so that the user can ensure the leveling line is appropriate. For more detailed
information on how leveling lines are drawn, refer to the Leveling Loop Formation and
Side Shot Handling discussions of section 4.3.
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Figure 5.17: Leveling line generated from HDIF record set.

Now let’s return to the crux of the exercise and solve for the unknown heights of
our sites. Re-enable the hdiffsBA.lsa and A 1521 records, then choose the menu
action Import → Include from LSA... and select loop2.lsa when prompted. The
reported sigmas on our HDIF records trend more optimistic than conservative. This
will be accounted for by creating a UNCR record with label hdifUNCR and sigma
value of 0.0001 m. Once the UNCR record is created, multi select all HDIF records
and choose hdifUNCR from the Uncertainty dropdown box. Select the menu action
Project → Calculate Adjustment and save when prompted. The reported orthometric
heights (recorded in Table 5.3 below) can be observed by choosing the action View
→ Final Positions. With no a priori knowledge of our heights, the solver was able to
provide an estimate utilizing a collection of HDIF records.
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Point Status Lat Lon (W) Hgt

A Fixed 0 0 0

B Height Constrained 0 -1 0

Meas From To Value Uncr

AZIM A B 89o 59’ 59” 10”

AZIM A B 90o 0’ 1” 10”

DIST A B 111.1783 km 1 km

Table 5.3: Final Height Values

Point Orthometric Hgt(m)

N2277258 178.3720

A 1521 177.5100

5.4 Example 4: 2D Adjustment (Horizontal) Workflow

Sometimes it is desirable to perform a 2D adjustment, in which the only measure-
ments present are those which constrain the horizontal positions. These adjustments
are special since they typically are devoid of any measurements which could be used
to determine the height of a point. In this section we briefly discuss how to perform
horizontal adjustments in salsa.

If there are already POSG or POSC records for all points in the horizontal only project,
the user may proceed to mark them all as constrained in height or fixed. Note that
these settings may be toggled with multiple POSG and POSC records selected.

5.4.1 Example

Consider the following project consisting of two locations, A and B, in which A is fixed
and B is constrained and the geoid is specified to be None. This network is depicted
in Figure 5.4.1.

The point B must be constrained in height for the problem not to be underdetermined.
In GeoLab, this constraining was automatically done for the user, converting points to
status 001 instead of 000. However, salsa does not automatically change the settings
so the user is responsible for this step.
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Figure 5.18: A simple horizontal example with two points and two AZIM records. Note
that point B must be constrained in the height since there are no measurements
which would allow salsa to determine the height.

Program B Final Latitude (N,dms) B Final Longitude (E,dms)

salsa 0o 0’ 0” 0o 59’ 55.4795”

GeoLab 0o 0’ 0” 0o 59’ 55.47950”

The adjustment depicted will execute in salsa, yielding the results displayed in Table
5.4.1. The results are consistent with the adjustment results one would obtain from
GeoLab.
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Chapter 6

Supported Measurement
Corrections

There are a number of corrections implemented in SALSA which may be used to
modify the measurement data of the user. For convenience, we have tabulated which
corrections apply to which record types in the Table 6.1.

Record Type Curv Hgt Reduced Refract OHC

AZIM X X

DIST X

DXYZ X

HANG X X

HDIF X X X X

VANG X X X

ZANG X X X

Table 6.1: Table indicating which types of corrections may be applied to which type
of record.
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6.1 Measurement Records

6.1.1 AZIM: Azimuthal Angles

The azimuth angle record between two points is nominally defined as

AZIM =
π

2
− tan−1

(
∆N

∆E

)
︸ ︷︷ ︸

Nominal

+CorrHgt + CorrDoV. (6.1)

We have denoted the northernly displacement by ∆N and the eastwardly displace-
ment by ∆E.

6.1.2 DIST: Distance Measurement

The distance measurement is nominally computed as the Pythagorean distance be-
tween the two points

DIST =

√
(XTo −XFrom)2 + (YTo − YFrom)2 + (ZTo − ZFrom)2︸ ︷︷ ︸

Nominal

×CorrHgt. (6.2)

6.1.3 DXYZ: 3-D XYZ Coordinate Difference

In ECEF XYZ coordinates, the difference in coordinates is nominally given as

DXYZ =


∆X

∆Y

∆Z

 =


(XTo −XFrom)

(YTo − YFrom)

(ZTo − ZFrom)


︸ ︷︷ ︸

Nominal

+


CorrHgt,X

CorrHgt,Y

CorrHgt,Z

 . (6.3)

6.1.4 HANG: Horizontal Angle

The horizontal angle between two points may be nominally rewritten (see Figure 6.1)
as the difference in azimuthal angles between those two points as follows,

HANG = (AZIMTo,At − AZIMFrom,At)︸ ︷︷ ︸
Nominal

+CorrHgt + CorrDoV. (6.4)
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At

From

To

Figure 6.1: Horizontal angle measurements may be thought of as the difference of two
azimuthal angle measurements.

6.1.5 HDIF: Height Difference

The difference in ellipsoidal heights is nominally given as

HDIF = (hTo − hFrom)︸ ︷︷ ︸
Nominal

= (HTo −HFrom) + [(Geoid Height)To − (Geoid Height)From]

+CorrCurv + CorrReduced + CorrRefrac + CorrOHC.

By default, it is assumed that the user has input an orthometric height difference.

6.1.6 VANG: Vertical Angle

The vertical angle is given trigonometrically (see Figure 6.2) by

VANG = sin−1

(
∆U

D

)
︸ ︷︷ ︸

Nominal

+CorrHgt + CorrDoV + CorrRefrac. (6.5)

Here ∆U denotes the up displacement between the “To” site and the “From” site. The
Pythagorean slant distance is denoted by D.

D

∆U

θ

Figure 6.2: The vertical angle is trigonometrically related to the upwardly displace-
ment ∆U and the Pythagorean slant distance D.
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6.1.7 ZANG: Zenith Angle

The zenith angle is the complement angle to the vertical elevation angle. Therefore we
obtain

sin (VANG) = sin
(π
2
− ZANG

)
= cos (ZANG) . (6.6)

This results in

ZANG = cos−1

(
∆U

D

)
︸ ︷︷ ︸

Nominal

+CorrHgt + CorrDoV + CorrRefrac. (6.7)

6.2 Curvature

In this section we will discuss the curvature correction. This correction is enabled
by default, but if your instrument is configured to perform the corrections itself this
option should be disabled.

6.2.1 HDIF: Height Difference

When this option is applied to HDIF records, the height difference arising from the
curvature of the Earth is approximated and removed. Begin by noting that the geom-
etry of the problem displayed in Figure 6.3 implies the following relationship (utilizing
the small angle approximation)

α ≈ ∆H

D
≈ (D/2)

REarth
. (6.8)

REarth REarth

∆H
D

α

Figure 6.3: The curvature correction to the height difference may be directly found
from geometric considerations.

We may solve this for the change in orthometric height to obtain

CorrCurv = (−∆H) = − D2

2REarth
. (6.9)
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We have introduced the slant distance, D, which is the Pythagorean distance between
the two points. Note, one recovers (5.4) of [11] if REarth is taken to be 6371 km.

6.3 Height Corrections

In this section we will discuss the corrections which arise due to the height of the
instrument and/or the target position.

6.3.1 AZIM Records

There is a correction arising from the geodetic height of the target position. The
correction is of the form1

CorrHgt ≈
(
0.108′′

1000

)
hTo,Geodetic cos

2 (ϕFrom) sin (2 · AZIMTo,From) . (6.10)

6.3.2 DIST Records

When this option is applied to DIST records, the contribution to the distance from
the instrument and target height is removed. The general strategy is to reduce the
measurement to the ellipsoid and then to recompute the slant distance. The resulting
form of the correction is [13].

CorrHgt =

√√√√[
1−

(
h2,tot − h1,tot

Nominal

)2
]

(REarth + h2) (REarth + h1)

(REarth + h2,tot) (REarth + h1,tot)
+

(
h2 − h1

Nominal

)2

.

(6.11)
We have let h1,tot and h2,tot denote the sum of the ellipsoidal height and the height
offset at that point.

To easily derive this result, consider the geometry presented in Figure 6.4.

Recall that the law of cosines may be written as

g2 = a2 + b2 − 2ab cos γ = (a− b)2 + 4ab sin
γ

2
. (6.12)

Applying the law of cosines to the geometry relevant for the correction yields

s2 = (hB,tot − hA,tot)
2 + 4(R+ hA,tot)(R+ hB,tot) sin

γ

2
, (6.13)

D2
m = (hB − hA)

2 + 4(R+ hA)(R+ hB) sin
γ

2
. (6.14)

1For further details, we refer the reader to [12] or (23.33) of [1].
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α β
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a b

γ

s

Dm

• •

R R

hA

hB

δhA

δhB

Figure 6.4: Geometry relevant for law of cosines discussion (left) and for height cor-
rection derivation (right). We have used s to denote the nominal slant distance and
Dm to denote the mark-to-mark distance.

Combining these results yields

D2
m =

(
s2 − (hB,tot − hA,tot)

2
) (R+ hA)(R+ hB)

(R+ hA,tot)(R+ hB,tot)
+ (hB − hA)

2. (6.15)

Factoring out the nominal slant distance, s, results in equation (6.11).

6.3.3 DXYZ Records

When this option is applied to DXYZ records, the XYZ coordinates at each point are
adjusted for the specified heights. The height offsets at each of the points is trans-
formed into a height offset in XYZ coordinates by

(∆X)From

(∆Y )From

(∆Z)From

 = RENU2XYZ,From·


0

0

hoffset,From

 ,


(∆X)To

(∆Y )To

(∆Z)To

 = RENU2XYZ,To·


0

0

hoffset,To

 .

(6.16)
The correction to the DXYZ measurement (which subtracts off the difference due to
the instrument and target height offset) may be written as

CorrHgt,XY Z = −


(∆X)To − (∆X)From

(∆Y )To − (∆Y )From

(∆Z)To − (∆Z)From

 . (6.17)

6.3.4 HANG Records

Since we have written the horizontal angle as the difference of two azimuthal angles
(see Figure 6.1), the target site height correction is likewise the difference of two
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azimuthal corrections

CorrHgt =

(
0.108′′

1000

)
cos2 (ϕAt) [hTo,Geodetic sin (2 · AZIMTo,At)− hFrom,Geodetic sin (2 · AZIMFrom,At)] .

(6.18)

6.3.5 VANG Records

The correction to the VANG measurement may be written as

(Nominal) + CorrHgt ≈ tan−1

[
tan (Nominal)−

(
∆hspecified

slant distance

)]
. (6.19)

6.3.6 ZANG Records

The corrected ZANG record is the complementary angle to the corrected VANG record,

(Nominal) + CorrHgt ≈
π

2
−
[
tan−1

[
tan

(π
2
− Nominal

)
−
(

∆hspecified

slant distance

)]]
. (6.20)

6.4 Reduced to Ellipsoid

In this section we will discuss the option of reducing your measurements to the el-
lipsoid. This removes all geoid-related corrections from your measurements. This
usually takes the form of preventing deflection of vertical corrections from being ap-
plied. The two deflection of vertical components are given by

ξ (North–South Direction) = Φ− ϕ,

η (East–West Direction) = (Λ− λ) cosϕ.
(6.21)

The symbols {ϕ, λ} denote the ellipsoidal latitude and longitude. The symbols {Φ,Λ}
denote the astronomical latitude and longitude.

In order to relate this to the language of North–South and East–West, consider the
following:
(ξ < 0): A negative meridian component (MC) of Deflection of the Vertical (DoV) in-
dicates that the astronomic latitude (Φ) will fall to the south of the corresponding
geodetic latitude (ϕ) of the point.
(η < 0): A negative prime vertical component (PVC) of the Deflection of the Vertical
(DoV) indicates that the astronomic longitude (Φ) will fall to the west of the corre-
sponding geodetic longitude (λ) of the point.
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In SALSA, these parameters are computed by noting that

tan ξ = −∂ (Geoid Height)
∂ (North)

= − 1

REarth

∂ (Geoid Height)
∂ϕ

,

tan η = −∂ (Geoid Height)
∂ (East)

= − 1

REarth cos (ϕ)

∂ (Geoid Height)
∂λ

.

(6.22)

Note that the final forms on the right hand side agree with equation (6.184) of [14]
after noting that tan θ ≈ θ for small θ.

6.4.1 AZIM Records

When this option is applied to AZIM records, the deflection of vertical corrections
are not included. There are two contributions from the deflection of vertical on the
azimuthal angle. The final expression for the change in azimuthal angle is given by2

CorrDoV = −ηFrom tanϕFrom−[ξFrom sin (AZIMTo,From)− ηFrom cos (AZIMTo,From)] cot (ZANGTo,From) .
(6.23)

6.4.2 HANG Records

This prevents the deflection of vertical correction from being applied. Since we have
written the horizontal angle as the difference of two azimuthal angles (see Figure
6.1), the deflection of vertical correction is likewise the difference of two azimuthal
deflection of vertical corrections. Those corrections takes the form

CorrDoV = {− [ξAt sin (AZIMTo,At)− ηAt cos (AZIMTo,At)] cot (ZANGTo,At)

+ [ξAt sin (AZIMFrom,At)− ηAt cos (AZIMFrom,At)] cot (ZANGFrom,At)} .
(6.24)

6.4.3 HDIF Records

When the this option is applied to HDIF records, the accounting for the geoid heights
is removed,

CorrReduced = − [(Geoid Height)To − (Geoid Height)From] . (6.25)

6.4.4 VANG Records

When this option is applied to VANG records, the deflection of vertical corrections are
not included. Those corrections take the form

CorrDoV = − [ξFrom cos (AZIMTo,From) + ηFrom sin (AZIMTo,From)] . (6.26)
2We refer the user to (5–98) of [15] for further details.
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6.4.5 ZANG Records

When this option is applied to ZANG records, the deflection of vertical corrections are
not included. Those corrections takes the form (see Figure 6.5)

CorrDoV = [ξFrom cos (AZIMTo,From) + ηFrom sin (AZIMTo,From)] . (6.27)

This correction agrees with (5–101) of [15].

α

∆
ZA

NG
=
ξ
co
sα

+
η
si
n
α

η

ξ

Figure 6.5: The deflection of vertical contribution to the zenith angle may be directly
found from geometric considerations. This is a top down view (looking down the “Up”
axis) of how a North–South deflection and a East–West deflection result in a zenith
angle contribution.

6.5 Refraction

In this section we will discuss the refraction correction. Physically, refraction impacts
survey measurements by causing light to propagate through a different path length
than is anticipated by the surveyor (light “bends” to a target as opposed to traveling
in a straight-line).

6.5.1 HDIF Records

When this option is applied to HDIF records, vertical refraction is accounted for. From
Figure 6.6, the geometrical relationship between the radius of curvature r and the
height difference is given by (utilizing the small angle approximation)

δ ≈ ∆H

D
≈ (D/2)

r
. (6.28)

We may introduce the refraction coefficient, k = REarth/r, and solve for the change in
height to obtain

CorrRefrac = (∆H) = k
D2

2REarth
. (6.29)

We have introduced the slant distance, D, which is the Pythagorean distance between
the two points.
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r r

∆H
D

δ

Figure 6.6: The refraction correction to the height difference may be directly found
from geometric considerations. We have used r to denote the radius of curvature
radius and δ to denote the refraction angle.

It is common for sources to give the equation for the combined effect of curvature and
refraction.

CorrCurv + CorrRefrac = (−1 + k)
D2

2REarth

≈ (−1 + 0.14) (0.0785) (D/km)2

≈ −0.0675(D/km)2.

(6.30)

The numerical values were chosen to demonstrate consistency with (5.7) of [11]. We
emphasize that SALSA allows the user to specify the refraction coefficient k.

6.5.2 VANG Records

When this option is applied to VANG records, the refraction angle is subtracted from
the measured angle. As shown in Figure 6.6, the added refraction angle may be
written as

δ ≈ (D/2)

r
. (6.31)

Rewriting this in terms of the refraction coefficient k = REarth/r immediately allows us
to obtain the contribution which must be removed from the angular measurement

CorrRefrac = −k
D

2REarth
. (6.32)

This contribution agrees with (5.12b) of [14].

6.5.3 ZANG Records

When this option is applied to ZANG records, it adds the refraction angle to the mea-
surement. Similarly to the VANG record, we choose to write the refraction angle in

Approved for public release, NGA-U-2025-01219



6.6. ORTHOMETRIC HEIGHT CORRECTION 91

terms of the refraction coefficient to obtain

CorrRefrac = k
D

2REarth
. (6.33)

6.6 Orthometric Height Correction

In this section we will discuss the orthometric height correction.

6.6.1 HDIF Records

When this option is applied to HDIF records, the difference in gravitational accelera-
tion between the two points is accounted for. For brevity, we will use the subscript “1”
in place of “From” and the subscript “2” in place of “To” in this section. The definition
of the orthometric height is the integral along the plumb line from the geoid to the
surface of the gravitational acceleration divided by the mean gravitational acceleration
along the plumb line,3

H =
1

ḡ

∫ surface

geoid
g dn. (6.34)

A useful difference to consider is the difference in integrals between the two points

(ḡ2H2 − ḡ1H1) =

∫ surface2

surface1
g dn. (6.35)

By adding and subtracting by the appropriate factors, we may obtain the expression

(H2 −H1) = ∆n︸︷︷︸
Leveling

+

∫ surface2

surface1

(
g − γ450
γ450

)
dn−

(
ḡ2 − γ450

γ450

)
H2 +

(
ḡ1 − γ450

γ450

)
H1︸ ︷︷ ︸

CorrOHC

. (6.36)

We have denoted the level measurement value as ∆n. The introduced constant, γ450 ,
is the normal gravitational acceleration evaluated on the surface of the ellipsoid and
at 45 degrees latitude. Numerically, this has a value of γ450 = 9.806199 m/s2.

In practice, the terms which comprise the orthometric height correction are not
known. Therefore Poincare-Prey Reduction4 is often utilized to eliminate the mean
gravitational acceleration from the expression

ḡ = g +
(
4.24× 10−7

)
H/s2. (6.37)

3See (3.106) of [14].
4See section 3.5 of [15].
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Performing elementary algebra we find the orthometric height correction to be ap-
proximately given by5

CorrOHC ≈ 1

2

∑
i

(
gi − γ450

γ450

)
(H2 −H1)+

(
g1 − γ450

γ450

)
H1−

(
g2 − γ450

γ450

)
H2−

(
4.317× 10−8

)
(H2−H1).

(6.38)

The gravitational accelerational acceleration usually is not known and therefore the
normal gravitational acceleration is used in place of the physical gravitational accel-
eration,

CorrOHC ≈ 1

2

∑
i

(
γi − γ450

γ450

)
(H2 −H1)+

(
γ1 − γ450

γ450

)
H1−

(
γ2 − γ450

γ450

)
H2−

(
4.317× 10−8

)
(H2−H1).

(6.39)
The normal gravitational acceleration only depends on the latitude (ϕ) and the ellip-
soidal height (h) at the point. Explicitly, the normal gravitational acceleration is given
by

γ = γ0 +
[
−
(
3.0877× 10−3 − 4.3× 10−6 sin2 ϕ

)
(h/km) +

(
7.2× 10−7

)
(h/km)2

]
m/s,

γ0 = 9.780327
(
1 + 5.3024× 10−3 sin2 ϕ− 5.8× 10−6 sin2(2ϕ)

)
m/s2.

(6.40)

Our final expressions agree with (4–46) of [15].

A common approximation scheme which is found in the literature is to assume:

• The orthometric heights are much larger than their difference: H2 ∼ H1.

• The height dependent terms in the normal gravity are negligible: γ ∼ γ0.

• γ0 ∼ 9.780327
(
1 + 5.3024× 10−3 sin2 ϕ

)
m/s2.

This leads to
CorrOHC ≈ −H1

(
5.288× 10−3

)
(ϕ2 − ϕ1) sin (2ϕ1) . (6.41)

This agrees with equation (23.39) of [1] and equation (5.27) of [11].6 We would like
to emphasis that SALSA uses the more accurate expression which was previously
introduced.

5We have used the Midpoint Rule approximation,
∫ surface2

surface1

(
g−γ45

0

γ45
0

)
dn ≈ 1

2

∑
i

(
gi−γ45

0

γ45
0

)
(H2 −H1).

6The adjustment resulting from the use of the approximate form is in agreement with the results of
GeoLab [16].
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Chapter 7

UNCR Record Corrections

There are a number of UNCR record corrections implemented in SALSA which may
be used to modify the measurement uncertainty data of the user. For convenience,
we have tabulated which corrections apply to which record types in the Table 7.1.
In general, the instrument will be placed at the “From” station and the target will be
placed at the “To” station. The one exception is HANG, where the instrument is at the
“At” station and targets are at the “From” and “To” stations.

Record Type At Cent Err From Cent Err To Cent Err PPM Sigma

AZIM X X X

DGRP X X X

DIST X X X X

DXYZ X X X X

HANG X X X X

HDIF X X

VANG X X X

ZANG X X X

Table 7.1: Table indicating which types of UNCR record corrections may be applied to
which type of record. Note that HDIR Records, while unable to have an UNCR record
specified directly, may inherit one from their parent DGRP.

7.1 Centering Errors and PPM

Note that centering errors in SALSA are treated as horizontal errors.
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7.1.1 AZIM: Azimuthal Angles

The error applied to AZIM measurement records due to Centering Errors takes the
following form

σ2
AZIM,Centering =

(
σFrom Centering Error

DTo, From

)2

+

(
σTo Centering Error

DTo, From

)2

. (7.1)

Where D is the horizontal distance, not the slant distance, between the “From” and
“To” points and can be calculated easily in the ENU reference frame

DTo, From =

√
(∆ETo, From)2 + (∆NTo, From)2 (7.2)

To see Equation 7.1, note that we can consider the two errors independently as is
depicted in Figure 7.1.

To

δα
δα

FromExpect FromσFrom From

δα

ToExpect ToσTo

Figure 7.1: The “From” centering error is depicted on the left (tan δα ≈ δα =
σFrom/DTo,From) and the “To” centering error is depicted on the right (tan δα ≈ δα =
σTo/DTo,From). The expected azimuth is zero.

7.1.2 DGRP/HDIR: Horizontal Direction

The error is the same as for AZIM records, where the “From” position is taken from
the DGRP record and the “To” position is taken from the HDIR record.

7.1.3 DIST: Distance Measurement

The error applied to DIST measurement records due to Centering Errors and PPM
takes the following form1

σ2
DIST,Centering&PPM = (σFrom Centering Error∗cos(α))2+(σTo Centering Error∗cos(α))2+σ2

PPM

(
DIST
106 m

)2

.

(7.3)
Where α is calculated as:

1We refer the reader to equation (7.38) of [1] for further details.
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α = arctan(
∆U√

∆E2 +∆N2
) (7.4)

Where ∆E, ∆N , and ∆U are the component differences between the “From” and “To”
points in the ENU reference frame.

7.1.4 DXYZ: 3-D XYZ Coordinate Difference

The error applied to DXYZ measurement records due to Centering Errors and PPM
takes the following form

CovDXYZ,Centering&PPM = (7.5)

CovDXYZ,Centering + CovPPM

Where CovPPM is defined as:

CovDXYZ,PPM = (7.6)

σ2
PPM

( DIST
106 m

)2


1 0 0

0 1 0

0 0 1

 .

The error applied to DXYZ measurement records due to centering errors is more com-
plicated than for DIST records. First, define the error vector in the ENU frame:

Fc/TcENU =
[
σFc/Tc σFc/Tc 0

]
(7.7)

Then, take the outer product of this vector with itself to get the measurement covari-
ance in the ENU frame:

CovDXYZ,Fc/Tc,ENU =


σFc/Tc

σFc/Tc

0

[
σFc/Tc σFc/Tc 0

]
=


σ2

Fc/Tc 0 0

0 σ2
Fc/Tc 0

0 0 0

 (7.8)

Then, rotate the result into the XYZ reference frame to get the final measurement
covariance:

CovDXYZ,Fc/Tc,XYZ = σ2
Fc/TcRENU2XY Z


1 0 0

0 1 0

0 0 0

RT
ENU2XY Z (7.9)
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7.1.5 HANG: Horizontal Angle

The error applied to HANG measurement records due to Centering Errors takes the
following form2

σ2
HANG,Centering&PPM =

(
σFrom Centering Error

DISTFrom,At

)2

+

(
σTo Centering Error

DISTTo,At

)2

(7.10)

+

(
DISTTo,From σAt Centering Error√

2 DISTFrom,At DISTTo,At

)2

.

7.1.6 HDIF: Height Difference

The error applied to HDIF measurement records due to PPM takes the following form

σ2
HDIF,PPM = σ2

PPM

(
DIST
106 m

)2

. (7.11)

7.1.7 VANG: Vertical Angle

The error applied to VANG measurement records due to Centering Errors takes the
following form

σ2
VANG,Centering =

(
sin(VANGTo,From)σFrom Centering Error

DISTTo,From − cos(VANGTo,From)σFrom Centering Error

)2

(7.12)

+

(
sin(VANGTo,From)σTo Centering Error

DISTTo,From − cos(VANGTo,From)σTo Centering Error

)2

.

This result may be found geometrically via Figure 7.2.

δν

σ

σ cos νσ sin ν ν
ν

Figure 7.2: The geometry depicting the correction (tan δν ≈ δν = σ sin ν/(DIST−σ cos ν)).
The vertical angle is denoted by ν and the centering error by σ in this diagram for
brevity. A similar argument holds for the “From” station.

2We refer the reader to equations (7.9) and (7.21) of [1] for further details.
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7.1.8 ZANG: Zenith Angle

The error applied to ZANG measurement records due to Centering Errors takes the
same form as for the VANG measurement records.

7.2 Sigma

The UNCR record provides the capability to add additional uncertainty to whichever
measurement record type is of interest. In particular, the Sigma field will always add
to the variance such that

σ2
Measurement Record,with additional = σ2

Measurement Record + σ2
additional. (7.13)

For the case of DXYZ records, the correction is of the form

CovDXYZ,with additional = Cov2
Measurement Record + σ2

additional


1 0 0

0 1 0

0 0 1

 . (7.14)

Note that this uncertainty contribution is accounted for prior to writing the *.dat file.
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Chapter 8

Instrument Height Uncertainty
Corrections

Generally, in geodetic survey measurements, the instrument employed in a measure-
ment isn’t placed directly on the point being surveyed but is placed on a tripod which
positions the instrument over the point at some convenient working height. The sur-
veyor takes care to plumb the instrument over the point to minimize any lateral offsets
and to measure the height offset that is introduced by the tripod. These actions (cen-
tering the instrument and measuring the height offset) typically cannot be achieved
without some error. Centering errors, affecting the horizontal plane of the instrument,
are handled by salsa through the UNCR (uncertainty) record as described in Chapter
7. The uncertainty in the measurement of an instrument height is the subject of this
chapter.

For convenience, table 8.1 shows which measurments have “To” and “From” instru-
ment heights as well as which measurements are affected by the uncertainty of the
instrument height. Since instrument height uncertainties are a vertical correction,
not every measurement type is affected even if it has a “To” or “From” height spec-
ified. In general, an instrument is placed at the “From” station and the target is at
the “To” station. The one exception to this generality is the HANG measurement type,
where the instrument is at the “At” station and the targets are at the “To” and “From”
stations.

8.1 Instrument Height Uncertainties

Note that instrument height uncertainties in salsa are treated as vertical errors. In
summary, only these four measurment types are affected: DIST, DXYZ, VANG and
ZANG.
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Record Type Height From Height To Height Uncertainty

AZIM X X

DGRP

DIST X X X

DXYZ X X X

HANG X X

HDIF

VANG X X X

ZANG X X X

Table 8.1: Table indicating which instrument height uncertainties are applicable to
each record type.

8.1.1 DIST: Distance Measurement

The error applied to DIST measurement records due to instrument height uncertainty
takes the following form:

σ2
DIST,Instr HGHT = (σHeight From sin(α))2 + (σHeight To sin(α))

2. (8.1)

Where α is calculated the same as in chapter 7. The expression for α is repeated here
for convenience:

α = arctan(
|∆U |√

∆E2 +∆N2
) (8.2)

Where ∆E, ∆N , and ∆U are the component differences between the “From” and “To”
points in the ENU reference frame.

8.1.2 DXYZ: 3-D XYZ Coordinate Difference

The error applied to DXYZ measurement records due to instrument height uncertainty
is more complicated than for DIST records. First, define the error vector in the ENU
frame:

HeightFrom/ToENU =
[
0 0 σHeight From/To

]
(8.3)

Then, take the outer product of this vector with itself to get the measurement covari-
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ance in the ENU frame:

CovDXYZ,Instr HGHT,ENU =


0

0

σH

[
0 0 σH

]
=


0 0 0

0 0 0

0 0 σ2
H

 (8.4)

The, rotate the result into the XYZ reference frame:

CovDXYZ,Instr HGHT, XYZ = σ2
HRENU2XY Z


0 0 0

0 0 0

0 0 1

RT
ENU2XY Z (8.5)

The total measurement covariance for both the “From” and “To” stations is:

CovDXYZ,Instr HGHT Total,XY Z = CovDXYZ,Instr HGHT From,XY Z + CovDXYZ,Instr HGHT To,XY Z

(8.6)

Where the measurement covariances for each station are defined by 8.5.

8.1.3 VANG: Vertical Angle

The error applied to VANG measurement records due to instrument height uncertainty
takes the following form where S is the slant distance, d is the horizontal distance
between the two points, and H is the vertical distance between the two points:

σ2
VANG,Instr HGHT =

 H
S − H−σHFrom√

d2+(H−σHFrom
)2

cos(VANGTo,From)


2

(8.7)

+

 H
S − H−σHTo√

d2+(H−σHTo
)2

cos(VANGTo,From)


2

This result may be found geometrically via figure 8.1.

From this diagram one can derive the previously given equation for the measurement
variance. First, establish some basic identities:

sin θ =
H

S
; sin (θ − σθFrom

) =
H − σHFrom

S∗
(8.8)
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d

S

θ

θ − σθ

σθ

σH

H − σH

σH

H

Figure 8.1: The geometry depicting the effect of instrument height uncertainty at the
“From” station, σHfrom

, on the measured Vangle, θ. A similar argument holds for the
“To” station.

Where:
S =

√
d2 +H2;S∗ =

√
d2 + (H − σHFrom

)2 (8.9)

Next using basic trigonometric identities:

sin (θ − σθFrom
) =

H − σHFrom

S∗
(8.10)

sin θ cosσθFrom
− cos θ sinσθFrom

=
H − σHFrom

S∗
(8.11)

And following the small angle assumption:

sin θ − cos θσθFrom
=

H − σHFrom

S∗
(8.12)

H

S
− cos θσθFrom

=
H − σHFrom

S∗
(8.13)

cos θσθFrom
=

H

S
− H − σHFrom

S∗
(8.14)

σθFrom
=

H
S − H−σHFrom

S∗
cos θ

(8.15)

The derivation for σθTo
is analagous. Therefore, to achieve the variance equation 8.7,

square both the “From” and “To” results and add them together.

8.1.4 ZANG: Zenith Angle

The error applied to ZANG measurement records due to instrument height uncer-
tainty takes the same form as for the VANG measurement records. The only difference
is cos becomes sin.
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Chapter 9

Station Inverse Data

The Station Inverse dialog box is primarily intended to provide the user with various
metrics that relate the states of two user-selected stations. Many of these relative
quantities have been defined previously: the azimuth angle in section 6.1.1, the slant
distance in section 6.1.2, the 3-D XYZ vector in section 6.1.3, the height difference
in section 6.1.5, and the vertical angle in section 6.1.6. Note that the Station Inverse
dialog box only functions after an adjustment has been run (including the calculation
of any derived points), as the values within the Station Inverse dialog box require the
h5 file generated by the adjustment process.

9.1 Station Inverse Dialog Data Generation

The Station Data Dialog box shown in Figure 9.1 provides a user interface through
which the user can add and remove station inverse pairs. Individual information for
each station is provided in the left half of the dialog box. Relative information between
stations is provided in the right half of the dialog box. The center table serves as a
graphical display of the station inverse pairs that will have their metrics generated in
<Project Name>.inv and <Project Name>Inv.csv files. The following subsections
detail the various actions the user can perform in the Station Data Dialog box and
the steps that are executed to generate the output inverse pair data.

9.1.1 Interacting with the Station Data Dialog Interface

Upon selecting View → Station Inverse from the main window, the Station Data Dialog
box table will be loaded with all prior existing pairs. For more information regarding
the parsing of the <Project Name>Inverses.cfg file refer to the appendix ”Inverse
Configuration Parsing”. This interface allows the user to perform the following ac-
tions.
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Figure 9.1: Station Inverse Dialog

• Add Pair to Project - Comboboxes allow the user to user to select stations that
were enabled for the last adjustment. Once a station has been selected in the
To and From comboboxes they may be added to the list by clicking the Add to
Project button. Note that if a station pair already exists in the list or if the To
and From comboboxes have the same value, then the pair will not be added to
the list.

• Remove Pair(s) from Project - Left clicking a row will highlight an individual pair.
Additional pairs can be highlighted individually by pressing Shift and Click on
the other desired row. Additionally, once a row is selected the user can hit Ctrl
+ Shift + Click to highlight everything between the original row and the newly
selected row. Once the desired row(s) are highlighted they may be removed by
pressing Right Click and selecting Delete or by pressing the Delete key.

• Export Results - Upon clicking the Export Results button all of the valid pairs
in the center table will have their data generated to an output file. For more
information please refer to section 9.1.2

• Export Results As - Behaves in a similar manner to Export Results but with
extended functionality. This button will bring up a file dialog box where the
user can select the output directory to save their inv and csv files and in-
put a new base name for the output files as well. This button should be uti-
lized if it is not desired that the output be placed in the project directory or
an output file convention differing from the default <Project Name>.inv and
<Project Name>Inv.csv is desired. This allows the user to backup the cur-
rent results of the inverse calculations such that they will not be overwritten
(as <Project Name>.inv and <Project Name>Inv.csv will be) by subsequent
modifications and adjustments to the project.

• Pair Selection - Highlighting an individual pair by clicking its row, or selecting
an up or down arrow will update the text boxes to display the metrics for that
station inverse pair. If the pair is invalid, the boxes will be cleared.
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9.1.2 Inverse Pair Data Generation

Upon clicking one of the Export buttons from the Station Data Dialog box or selecting
Project → Calculate Adjustment from the main Salsa interface the following sequence
will be executed.

1. Project will search for <Project Name>Inverses.cfg file. If not found an early
exit will occur.

2. The file will be parsed for all unique, valid pairs. A pair is considered valid if

• The From and To stations have labels that correspond to an existing POSG,
POSC or derived point record.

• Both stations were enabled at the time Calculate Adjustment was last per-
formed.

• The pair is non-trivial, i.e. the From and To stations do not have the same
label.

3. Output <Project Name>.inv and <Project Name>Inv.csv files will be gener-
ated containing the metrics for valid inverse pairs.

The inv output file is a plain text file which writes each quantity from the Station Data
Dialog GUI on its own line. It is meant to serve as a human readable format for all
of the station inverse pairs. Conversely, the csv file delimits quantities using commas
and has only one line per station pair.

9.2 Station Inverse Dialog Relative Geodetic (WGS84) Data
Definitions

As described above, all relative quantities between the two provided stations are de-
fined in sections 6.1.1 through 6.1.6, with the exception of the ellipsoidal distance
and the horizontal distance. For these quantities previously defined, the correspond-
ing uncertainties are also computed via the equivalent measurement first order par-
tial derivative matrices that are employed in an adjustment. These uncertainties are
displayed within the Station Inverse dialog box next to the nominal values. All quan-
tities are specified in meters, except for the azimuth and vertical angles between the
stations which are provided in degrees, minutes, and seconds of arc, along with the
associated uncertainties in seconds of arc. Also note that the DXYZ vector covariance
is provided, which includes both the diagonal and off-diagonal covariance values.

The ellipsoidal distance is the shortest distance along the surface of the WGS 84
ellipsoid from the “From” station latitude and longitude to the “To” station latitude
and longitude. The horizontal distance is the magnitude of the relative station vector
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projected into the horizontal plane, which is defined using the East-North-Up frame
computed at the “From” station. The ellipsoidal distance and the horizontal distance
between a “From” and “To” station are shown in Figure 9.2, along with the previously
defined slant distance (section 6.1.2).

h1 

From Station 

To Station 

h2 

Ellipsoidal Distance 

Horizontal  
Distance 

Slant Distance 

WGS-84 

Figure 9.2: Relative Station Distances

9.2.1 Ellipsoidal Distance

The Ellipsoidal distance is in general defined as the shortest distance along the sur-
face of a three dimensional ellipsoid between two points on the ellipsoid. The ellipsoid
used in SALSA is WGS 84, which is an ellipsoid of revolution with a flattening param-
eter f = 1/298.257223563 and semi-major axis (SMA) aWGS84 = 6378137.0 meters. The
two points on the surface are often defined using their geodetic latitude and longitude
values.

Vincenty’s Method for Ellipsoidal Distance Computation

To compute the ellipsoidal distance between the “From” and “To” station locations, the
commonly used Vincenty’s Method is employed [17]. Vincenty’s Method is an iterative
numerical approach that provides consistent geodesic distance values between all
points on an ellipsoid, except those points antipodal (i.e. on exactly opposite sides of
the Earth) to each other (or nearly antipodal).
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The semi-minor axis is needed for Vincentys method, and is computed as

b = (1− f)a (9.1)

The geodesic latitude ϕ and longitude λ for the two stations are assumed to be known,
and the longitude difference is computed as

∆λ = λ2 − λ1 (9.2)

where λ2 represents the longitude of the “To” station, and λ1 represents the longitude
of the “From” station. These subscripts will be used for these stations for the remain-
der of this derivation. The “reduced latitude” of each station (i.e. the latitude on the
auxiliary sphere) is computed as

U1 = tan−1 [(1− f) tan(ϕ1)]

U2 = tan−1 [(1− f) tan(ϕ2)]
(9.3)

The quantity λ̄ is initialized as the longitude difference:

λ̄ = ∆λ (9.4)

The following equations are then iterated upon until λ̄ converges (as dictated by a
change in magnitude ||∆λ̄|| of less than 1× 10−12):

sinσ =
√
(cosU2 sin λ̄)2 + (cosU1 sinU2 − sinU1 cosU2 cos λ̄)2 (9.5)

cosσ = sinU1 sinU2 + cosU1 cosU2 cos λ̄ (9.6)

σ = tan−1 sinσ

cosσ
(9.7)

sinα =
cosU1 cosU2 sin λ̄

sinσ
(9.8)

cos2 α = 1− sin2 α (9.9)

cos(2σm) = cosσ − 2 sinU1 sinU2

cos2 α
(9.10)

C =
f

16
cos2 α

[
4 + f

(
4− 3 cos2 α

)]
(9.11)

λ̄new =∆λ+ (1− C)f sinα

∗
{
σ + C sinσ

[
cos(2σm) + C cosσ

(
−1 + 2 cos2(2σm)

)]} (9.12)

∆λ̄ = λ̄new − λ̄prev (9.13)

After λ̄ has converged, the ellipsoidal distance s is computed using equations:

u2 = cos2 α
a2 − b2

b2
(9.14)
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k1 =

√
1 + u2 − 1√
1 + u2 + 1

(9.15)

A =
1 + 1

4k
2
1

1− k1
(9.16)

B = k1
(
1− 3

8k
2
1

)
(9.17)

∆σ =B sinσ
{
cos(2σm) + 1

4B
[
cosσ

(
−1 + 2 cos2(2σm)

)
−1

6B cos(2σm)(−3 + 4 sin2 σ)(−3 + 4 ∗ cos2(2σm))
]} (9.18)

s = bA(σ −∆σ) (9.19)

For two points that are exactly on the equator (i.e. the geodetic latitude is zero), the
value for the cos(2σm) term is set to zero to avoid a singularity in the computation of
that parameter (the term is not not used anyways when both points are exactly on
the equator).

Sigma Point Transform for Uncertainty Mapping

The unscaled sigma point transform [18] is employed to map the uncertainty in both
station positions into a single uncertainty value for the ellipsoidal distance. Com-
pared to the standard linearized approach of pre- and post-multiplying the solution
covariance by first order partial derivative matrices, the sigma point transform bet-
ter captures the performance of nonlinear functions, while eliminating the need to
compute the partial derivative matrices.

The two station positions in ECEF XYZ coordinates are stacked into a single vector as

x =

 rFrom

rTo

 (9.20)

The ECEF XYZ covariance of both stations is Covx, which includes cross covariance
terms between the stations. To obtain Covx, the covariance values associated with
these two stations are extracted from the total covariance matrix:

Covx =

 CovFrom CovFromCrossTo

CovTFromCrossTo CovTo

 (9.21)

The Cholesky decomposition [19] of Covx is computed:

c
√

Covx = chol (Covx) (9.22)

where
Covx = c

√
Covx

c
√

Covx
T

(9.23)
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The Cholesky decomposition matrix is notionally considered the “square root” of the
covariance matrix. However, the covariance when working with derived points can
often be positive semi-definite instead of positive definite: some of the eigenvalues of
the matrix are zero as a result of having one or more position components fixed. The
Cholesky decomposition process requires a positive definite matrix input in order to
provide a unique solution. Fortunately, the Cholesky decomposition process is stable
as the eigenvalues of a matrix approach zero (i.e. changing the eigenvalue from one
very small value to another very small value does significantly not change the decom-
position), and thus small values can be substituted for any zero-value eigenvalues to
obtain a Cholesky decomposition that is correct to any desired precision [20, 21].

To determine if there are any zero-value eigenvalues before performing the Cholesky
decomposition, the eigenvalues and associated eigenvectors for the Covx matrix are
computed via the EigenSolver tool within the Eigen library [22]:

Covx = UΛUT (9.24)

where Λ is a diagonal matrix with eigenvalues on the diagonal, and U is an orthogo-
nal matrix consisting of the eigenvectors associated with the eigenvalues in Λ. If any
eigenvalues are zero or slightly negative (likely resulting from numerical precision lim-
itations), these values are changed to a very small positive value ϵ. After this change,
the covariance matrix can be reassembled via equation 9.24. Then the Cholesky de-
composition can be executed to obtain the “square root” covariance matrix described
in equation 9.23.

The covariance square root matrix is then employed to deterministically generate a
set of vectors called “sigma point vectors”:

X = [x+
√
n c
√

Covx(:, 1), x+
√
n c
√

Covx(:, 2), ...,

x−
√
n c
√

Covx(:, 1), x−
√
n c
√

Covx(:, 2), ...
] (9.25)

where n is the number of dimensions of the initial vector (six in this two-station
example), and the notation (:, i) indicates the ith column of the c

√
Covx matrix. Each

column of X represents a sigma point vector, also described as Xi for column i.

These sigma point vectors can be used to map the formal covariance of the station
positions to the uncertainty in the ellipsoidal distance. Each sigma point vector Xi is
mapped through the nonlinear function g(x, a, f) which includes the conversion from
Cartesian ECEF XYZ positions of both stations to geodetic coordinates and applying
Vincenty’s Method (section 9.2.1) to compute the ellipsoidal distance:

Yi = g(Xi, a, f) (9.26)

The mean of the mapped sigma points, which does not necessarily equal the computed
ellipsoidal distance using the nominal station positions, is

ŷ =
1

2n

2n∑
i=1

Yi (9.27)
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The mean and mapped sigma point vectors are used to compute the mapped covari-
ance matrix:

Covy =
1

2n

2n∑
i=1

(Yi − ŷ) (Yi − ŷ)T (9.28)

Note that the dimension of ŷ and Covy will be 1 and 1 × 1 for the single geodesic
distance output, and thus

σellipsoidal =
√

Covy (9.29)

9.2.2 Horizontal Distance

The horizontal distance between two stations is defined as the magnitude of the 2D
vector between the stations that results from projecting the relative 3D vector into
the horizontal plane. Given the two station positions in ECEF cartesian frame coordi-
nates, the relative station vector is

rXYZ
rel = rTo − rFrom (9.30)

This rXYZ
rel vector is projected into the horizontal plane, defined as perpendicular to the

WGS 84 ellipsoid at the “from” station coordinates:

rENU
rel = RENU

XYZ rXYZ
rel (9.31)

where RENU
XYZ is the rotation matrix from the ECEF frame to the ENU frame (which is

also fixed to the surface of the Earth). The RENU
XYZ rotation matrix is defined as:

RENU
XYZ =

[
Ê N̂ Û

]T
(9.32)

where the unit vectors Ê, N̂ , and Û are the unit vectors of the east, north, and up
directions in the ECEF frame at the “From” station. The terms of RENU

XYZ are defined in
equation 4.33.

To obtain the horizontal distance, the RSS magnitude of the east and north compo-
nents is computed:

Dhorizontal =
√
rENU

rel (1)2 + rENU
rel (2)2 (9.33)

To determine the uncertainty in the horizontal distance, the same unscaled sigma
point transform is employed as described above for the ellipsoidal distance. The
mapping function is the horizontal distance calculation provided in equations 9.30
through 9.33 instead of the ellipsoidal distance, but otherwise the approach is iden-
tical.
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Custom Import and Export Scripts

SALSA supports the importing of instrument files into a project through Import menu
actions. Furthermore, various output formats are available through Export menu
actions. Selecting these menu actions causes SALSA to initiate a python script which
has been bundled with SALSA. This section will explain how the user may write their
own custom import and export scripts which populate these menus.

10.1 Discoverable Scripts

SALSA will auto-populate the Import and Export menus with scripts which are located
in special folders within the project directory. The scripts which the user would like
to populate the Import menu should be placed within a customImport folder within
the project directory. The scripts which the user would like to populate the Export
menu should be placed within a customExport folder within the project directory. In
Figure 10.1 we demonstrate a typical file structure.

The custom scripts populate SALSA in the manner depicted in Figure 10.2.

10.2 Writing Custom Import Scripts

To assist you in writing your own importing scripts, we have provided an example
import script, called SampleCustomImport.py. This file demonstrates how to accept
the arguments passed to import scripts from SALSA, manipulate data in an instru-
ment file (such as systematically altering a naming convention) and finally convert it
to lsa format. The arguments passed to these scripts include the path of the general
converting tool used by SALSA which currently support Leica GSI, WIPPS PPP, Leica
sets of angles (.log), and Trimble Data Exchange Format for GPS, level, total station
measurements (.asc). Users do not need to use these arguments if they prefer to write
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Figure 10.1: To be discoverable by SALSA, custom import scripts must be placed in
the customImport folder and custom export scripts must be placed in the customEx-
port folder.
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Figure 10.2: Scripts placed in discoverable directories will auto-populate as menu
actions.
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their own script from scratch. In the custom import script, the “Parse” section shows
how to accept the arguments passed by SALSA to the script and should not be heav-
ily modified. The section “converterlauncher.py” shows how to call the usual SALSA
import tool with your modified instrument files. Note that one of the arguments is
”type” of the instrument files which may be needed to be modified by the user.

10.3 Writing Custom Export Scripts

To assist you in writing your own reporting scripts, we have provided an example
reporting script called SampleCustomExport.py. This file demonstrates how to use
the hdf file which SALSA passes to all reporting scripts to perform manipulations to
your output and write out a new file. The different sections of the scripts are clearly
labelled allowing you to only re-use the parts which are relevant for your application.
In particular, the “Parse” section, which shows how to accept the hdf file from SALSA,
should not be greatly modified. Furthermore, the “ReadHDF” section provides a quick
reference for how to extract information from the hdf file and store it into memory.

10.4 Obtaining Custom Scripts

The user is most likely to obtain a custom script either from colleagues or from mak-
ing it on their own for their special application. However, there will be a small number
of custom scripts which are included in the SALSA release and have been subject to
our testing. The custom export scripts may typically be found in

C:\Program Files\SALSA\reporting\extras

and the custom import scripts may typically be found in

C:\Program Files\SALSA\converters\extras.

To utilize these scripts, they must be copy and pasted in the relevant folders described
in 10.1.

10.5 Facilitating Custom Import and Export File Copies

If a custom import or export script becomes a common part of the user’s workflow,
it may become tedious to create subdirectories and copy over the necessary files for
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each new project. SALSA provides users with a straightforward mechanism to specify
files that are automatically added to any newly created project’s customImport or
customExport folder. Users can accomplish this by completing the following steps.

1. Navigate to the data folder in SALSA’s installation directory. See Figure 2.2

2. Open default.cfg in a text editor. This may require elevated permissions.

3. Add a new line with the tag --customExportCopy followed by a space and the
file name you wish to add to your project’s customExport folder. Create a new
line for each file you wish to copy into customExport. Note if a file name has a
space in it, please enclose in quotes.

4. Add a new line with the tag --customImportCopy followed by a space and the
file name you wish to add to your project’s customImport folder. Create a new
line for each file you wish to copy into customImport. Note if a file name has a
space in it, please enclose in quotes.

5. Save the modified default.cfg file when finished.

If one or more files are tagged with customExportCopy, a customExport folder is
generated when creating a new SALSA project, and the relevant files are copied into
that folder. The same paradigm holds for customImport. Note that only new projects
will employ these tags in the default.cfg file to automatically copy the files. Users with
prior existing projects who wish to employ custom export or custom import scripts
must add them manually as described in 10.1.
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Chapter 11

LSA Record Reference

It should be clear to the reader at this point in this text that salsa organizes the
least squares problem as a collection of what we’ve been calling “records,” that these
records may be organized hierarchically, that they may be edited via the Record Edi-
tor, and that they are saved with the salsa project in a special .lsa format (which is
detailed in Chapter 12). However, we have not yet introduced all of the record types
which may be used in salsa, nor have we fully explained all the fields presented by the
Record Editor for each record type. The goal of this chapter is to provide a complete
reference that explains each salsa record type in detail.

Each of the following sections adheres to a consistent pattern: we introduce each
record type by its few-letter abbreviation and its one-line description, we explain the
fields that are presented in the Record Editor for the record type, and then we close
with additional explanation as warranted. The order of the following sections mirrors
the order that record types are shown in salsa’s Record → Insert menu.
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11.1 INCLUDE - Additional .lsa file

A special record used to include additional .lsa files in the project.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

File: Relative path to the file to include1,2

Scaling: Variance scaling to apply to all measurements in the included file3

Notes

1. “Including” an .lsa file in a salsa project does not affect the file’s location. salsa
will read from and write to the file wherever it may be located. Thus, to eliminate
the possibility of making unintended changes to files outside of the current salsa
project folder, we recommend copying these input files into the salsa project
folder and them including them from there.

2. Included files located in the project directory or a child of the project directory
are stored with a relative path from the parent file to the included file. Files
located outside of the project directory are stored with an absolute path.

3. Keep in mind the fact that variance scaling in salsa is cumulative, so the effective
variance scaling for any record is the product of that individual record’s scaling
factor times its parent’s scaling factor times that parent’s scaling factor, etc.

11.2 COMMENT - a comment

A comment.

Record Editor Fields

Comment: Text of the comment
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Notes

1. Comments have no impact on the adjustment; they are supported to help users
build a well-organized and well-documented LSA project.

2. A separator bar (also available in the Record → Insert menu) is just a comment
containing a bunch of ‘–’ characters.
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11.3 POSG - Station Position (Geodetic)

An initial position estimate for a point, using Geodetic coordinates1.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

Label: Unique string used to describe this point.

Latitude, Longitude: Geodetic latitude and longitude of the point. These angles may
be expressed in either degrees, minutes, and seconds of arc (DMS) or
as decimal degrees by selecting the corresponding radio button. Lati-
tudes may be expressed as positive-North or positive South using the
N/S selector, and likewise longitudes may be expressed as positive
East or West using the E/W selector.

Height: Height of the point, recorded as either ‘Ellipsoidal’ or ‘Orthometric’.
If the right-most dropdown box is set to ‘Ellipsoidal’, then height is
relative to the WGS 84 ellipsoid. If set to ‘Orthometric’, then the height
is relative to the geoid defined by the geoid file used in the project.

Type2: Type(s) of constraints applied to this point
Floating: free to adjust
Constrained: constrained by a covariance matrix
Fixed: Lat, Lon and ElHt are all fixed, point will not be adjusted

Covariance3: Upper triangular covariance matrix elements

Lat Fixed: Latitude of the point is fixed and will not be adjusted

Lon Fixed: Longitude of the point is fixed and will not be adjusted

ElHt Fixed: Ellipsoid height of the point is fixed and will not be adjusted

Scaling: Apply a scale factor to multiply the covariance

Notes

1. Note that all internal computations in salsa are executed in an ECEF Cartesian
(XYZ) frame; salsa uses the WGS 84 ellipsoid parameters to compute the Carte-
sian coordinates for POSG records.

2. The ‘Type’ options for POSG (and POSC) records warrant some elaboration.
‘Floating’ means that the point is entirely free to move in the adjustment, barring
any ‘fixed’ components discussed momentarily; any covariance matrix content is
ignored. Most points in a typical survey will be Floating. ‘Constrained’ means
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that the point is an absolute ECEF coordinate estimate, complete with a covari-
ance matrix characterizing the uncertainty in that estimate. Constrained points
will move as part of the least squares adjustment just like any other measure-
ment. ‘Fixed’ means the point’s coordinates are taken as known, and they are
not allowed to move in the adjustment. In terms of least squares theory, a fixed
point’s coordinates are not even included in the state vector which is the sub-
ject of the estimation. ‘Lat/Lon/ElHt Fixed’ technically does not ‘fix’ the point’s
coordinates but imposes a constraint equation that prohibits movement in the
specified direction(s). The word ‘fixed’ is used in the GUI with some reservation
by the authors, but it is concise.

3. Units of the covariance matrix elements are assumed to match the linear units
specifying the ellipsoid height. For example, if the ellipsoid height is expressed
in meters, the covariance elements will be interpreted as m2. Note that the
covariance elements for a POSG record are expressed in a local north/east/up
frame as indicated by the matrix element labels.
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11.4 POSC - Station Position (Cartesian)

An initial position estimate for a point, using ECEF XYZ coordinates.

Record Editor Fields

Enabled: When checked, the record will be used to calculate the network adjust-
ment

Label: Unique string used to describe this point

X,Y,Z: ECEF X, Y, and Z coordinate estimates for this point

Type1: Type(s) of constraints applied to this point
Floating: free to adjust
Constrained: constrained by a covariance matrix
Fixed: Lat, Lon and ElHt are all fixed, point will not be adjusted

Covariance2: Upper triangular covariance matrix elements

Lat Fixed: Latitude of the point is fixed and will not be adjusted

Lon Fixed: Longitude of the point is fixed and will not be adjusted

ElHt Fixed: Ellipsoid height of the point is fixed and will not be adjusted

Scaling: Apply a scale factor to multiply the covariance

Notes

1. The ‘Type’ options for POSC (and POSG) records warrant some elaboration.
‘Floating’ means that the point is entirely free to move in the adjustment, barring
any ‘fixed’ components discussed momentarily; any covariance matrix content is
ignored. Most points in a typical survey will be Floating. ‘Constrained’ means
that the point is an absolute ECEF coordinate estimate, complete with a covari-
ance matrix characterizing the uncertainty in that estimate. Constrained points
will move as part of the least squares adjustment just like any other measure-
ment. ‘Fixed’ means the point’s coordinates are taken as known, and they are
not allowed to move in the adjustment. In terms of least squares theory, a fixed
point’s coordinates are not even included in the state vector which is the sub-
ject of the estimation. ‘Lat/Lon/ElHt Fixed’ technically does not ‘fix’ the point’s
coordinates but imposes a constraint equation that prohibits movement in the
specified direction(s). The word ‘fixed’ is used in the GUI with some reservation
by the authors, but it is concise.

2. Units of the covariance matrix elements are assumed to match those linear units
specifying the ECEF XYZ coordinates. For example, if the ECEF XYZ position is
expressed in meters, the covariance elements will be interpreted as m2.
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11.5 DIST - Distance measurement

A slant distance measurement between two points.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

From: Label for the point where the measurement vector originates

To: Label for the point where the measurement vector terminates

Distance: Distance measured between the From and To points

Sigma: Measurement uncertainty

Height From1: Height of the instrument at the From point

Height To: Height of the target at the To point

Uncertainty: Uncertainty model to apply to this measurement

Scaling: Scaling to apply to this measurement’s covariance

Notes

1. If a distance measurement has already been corrected to account for heights
of instrument and target (i.e., “reduced mark-to-mark”), the Height From/To
should be set to zero in salsa.
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11.6 DXYZ - Delta XYZ measurement

An ECEF XYZ vector measurement between two points.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

From: Label for the point where the measurement vector originates

To: Label for the point where the measurement vector terminates

Delta X,Y,Z: X,Y,Z components of the vector measurement

Covariance1: Covariance matrix for the measurement

Height From2: Height of the instrument at the From point

Height To: Height of the instrument at the To point

Uncertainty: Uncertainty model to apply to this measurement

Scaling: Scaling to apply to this measurement’s covariance

Notes

1. Units of the covariance matrix elements are assumed to match those linear units
specifying the XYZ vector components. For example, if the vector measurement
is expressed in meters, the covariance elements will be interpreted as m2.

2. If a vector measurement has already been corrected to account for instrument
heights (i.e., “reduced mark-to-mark”), the Height From/To should be set to
zero in salsa. Typically, GNSS processing software does account for instrument
heights (as well as antenna effects) when computing the vector estimate.
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11.7 HANG - Horizontal Angle Measurement

A horizontal angle measured between two points.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

From: Label for the point where the angle originates

At: Label for the point where the instrument is located

To: Label for the point where the angle terminates

Angle1: Angle measured between the From and To points

Sigma: Measurement uncertainty

Height From: Height of the instrument at the From point

Height To: Height of the instrument at the To point

Uncertainty: Uncertainty model to apply to this measurement

Scaling: Scaling to apply to this measurement’s covariance

Reduced: When checked, indicates measurement has been reduced to the Ellip-
soid

Notes

1. The sign convention for horizontal angles is positive-clockwise.

Approved for public release, NGA-U-2025-01219



126 CHAPTER 11. LSA RECORD REFERENCE

11.8 AZIM - Azimuth Measurement

A horizontal angle measured1 from the North2 vector.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

From: Label for the point at which the azimuth was observed

To: Label for the point that was the target of the azimuth observation

Angle: Angle from true North to the To point2

Sigma: Measurement uncertainty

Height From: Height of the instrument at the From point

Height To: Height of the target at the To point

Uncertainty: Uncertainty model to apply to this measurement

Scaling: Scaling to apply to this measurement’s covariance

Reduced: When checked, indicates measurement has been reduced to the El-
lipsoid

Notes

1. Azimuth ‘measurements’ are not, in practice, observed directly. Rather, they
are the product of other measurements and reductions typically including astro-
nomic observations. These estimates may be introduced into salsa as an AZIM
record. The sign convention for azimuths is positive-clockwise.

2. The default convention for Azimuth records is that they are expressed as angles
clockwise from North; this record provides an option to instead specify the angle
clockwise from South.
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11.9 VANG - Vertical Angle Measurement

An angle measurement of a point relative to the horizontal plane1.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

From: Label for the point at which the measurement is taken

To: Label for the point where the angle terminates

Angle: Angle measured from the horizontal plane to the To point

Sigma: Measurement uncertainty

Height From: Height of the instrument at the From point

Height To: Height of the target at the To point

Uncertainty: Uncertainty model to apply to this measurement

Refract Coeff: Coefficient used for refraction correction2

Scaling: Scaling to apply to this measurement’s covariance

Reduced: When checked, indicates measurement has been reduced to the
Ellipsoid3

Notes

1. Vertical and Zenith angles are complementary; a VANG record with observed
angle α is exactly equivalent to a ZANG record with observed angle 90− α.

2. Empirical studies of terrestrial refraction, k, show that the frequently-used Gaus-
sian refraction coefficient of k = 0.13 is not suitable for describing refraction ef-
fects in the lower atmosphere (where surveying observations are taken) and that
k can vary from -4 to +16 over the course of a day [23]. salsa users are advised
to leave the refraction correction disabled (equivalent to k = 0) in the absence of
comprehensive atmospheric data concurrent with their observations.

3. Typically, VANG/ZANG observations are not reduced to the Ellipsoid; they are
made relative to the local gravity field and are influenced by any deflection of
the vertical (DOV) at the instrument location. Unless the user specifies that the
measurement has already been reduced to the Ellipsoid, salsa will apply DOV
corrections to the observation.
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11.10 ZANG - Zenith Angle Measurement

An angle measurement of a point relative to vertical1.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

From: Label for the point at which the measurement is taken

To: Label for the point where the angle terminates

Angle: Angle measured from the vertical axis to the To point

Sigma: Measurement uncertainty

Height From: Height of the instrument at the From point

Height To: Height of the target at the To point

Uncertainty: Uncertainty model to apply to this measurement

Refract Coeff: Coefficient used for refraction correction2

Scaling: Scaling to apply to this measurement’s covariance

Reduced: When checked, indicates measurement has been reduced to the
Ellipsoid3

Notes

1. Vertical and Zenith angles are complementary; a VANG record with observed
angle α is exactly equivalent to a ZANG record with observed angle 90− α.

2. Empirical studies of terrestrial refraction, k, show that the frequently-used Gaus-
sian refraction coefficient of k = 0.13 is not suitable for describing refraction ef-
fects in the lower atmosphere (where surveying observations are taken) and that
k can vary from -4 to +16 over the course of a day [23]. salsa users are advised
to leave the refraction correction disabled (equivalent to k = 0) in the absence of
comprehensive atmospheric data concurrent with their observations.

3. Typically, VANG/ZANG observations are not reduced to the Ellipsoid; they are
made relative to the local gravity field and are influenced by any deflection of
the vertical (DOV) at the instrument location. Unless the user specifies that the
measurement has already been reduced to the Ellipsoid, salsa will apply DOV
corrections to the observation.
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11.11 HDIF - Height Difference Measurement

A measure of the difference between two heights.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

From: Label for the point from which the height difference is referenced

To: Label for the point referenced by the height difference

Height Diff: Measured height difference between the From and To points

Sigma: Measurement uncertainty

Uncertainty: Uncertainty model to apply to this measurement

Refract Coeff: Coefficient used for refraction correction1

Scaling: Scaling to apply to this measurement’s covariance

Reduced: When checked, indicates measurement has been reduced to the
Ellipsoid2

Curvature: When checked, indicates that the curvature correction will be applied

OHC: When checked, indicates that the orthometric height correction will
be applied

Notes

1. Empirical studies of terrestrial refraction, k, show that the frequently-used Gaus-
sian refraction coefficient of k = 0.13 is not suitable for describing refraction ef-
fects in the lower atmosphere (where surveying observations are taken) and that
k can vary from -4 to +16 over the course of a day [23]. salsa users are advised
to leave the refraction correction disabled (equivalent to k = 0) in the absence of
comprehensive atmospheric data concurrent with their observations.

2. Typically, leveling measurements have not been reduced to the Ellipsoid prior
to importing them in salsa; they are therefore orthometric height differences,
and salsa will apply gravity corrections to these observations. If the observation
has already been reduced outside of salsa (thus it represents an ellipsoid height
difference), this box should be checked so that salsa does not apply gravity cor-
rections.
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11.12 HDIR - Horizontal Direction Measurement

A measurement that defines a direction to a point1.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

To Point: Label for the point to which this direction is measured

Dir Group: Label for the Direction Group this direction belongs to

Angle: The measured direction angle

Sigma: Measurement uncertainty

Height To: Height of the target at the To point

Notes

1. Unlike azimuth observations (AZIM) which are relative to true North, horizontal
direction records (HDIR) in salsa are relative to an arbitrary azimuth defined
by the instrument (typically a total station). As such, HDIR records are only
meaningful when expressed as a group; see the Direction Group (DGRP) record
introduced next.
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11.13 DGRP - Direction Group

A group that comprises a set of horizontal direction measurements.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

Label: Unique string used to describe this direction group

At Point: Label for the point at which directions in this group were measured

Uncertainty: Uncertainty model to apply to these measurements

Scaling: Scaling to apply to these measurements’ covariance

Reduced: When checked, indicates measurement has been reduced to the Ellip-
soid

Notes

1. Reference the HDIR record discussed on the previous page.
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11.14 HGHT - Height of Instrument/Target

A record used to capture instrument and target heights.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

Label: Unique label used to identify this height record

Height: The height of the instrument or target for this correction

Notes

1. Like other ‘modifier’ records in salsa, the HGHT record exists so that other salsa
records can reference it. The purpose of the HGHT record is to capture the nu-
meric height of instrument or target for a particular setup; then all observations
taken with that setup – assuming they have not already been reduced mark-to-
mark – should reference a common HGHT record. This ‘best practice’ keeps salsa
projects clear and maintainable.
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11.15 VSCA - Variance Scaling

A record used to provide additional scaling to the variance (sigma2 or covariance) of a
measurement.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjustment

Label: Unique label used to identify this record

Scaling: Variance scaling to apply to the measurement

Notes

1. Note that individual measurement records, as well as INCLUDE records, can be
scaled directly by entering a numeric value. The purpose of the VSCA record, like
other ‘modifiers’ in salsa, is to allow a user to create a descriptively-named record
that can be referenced by other records. For example, in a large project contain-
ing many files a user might create a VSCA record named “GPS” and another
named “Conventional” and then reference the appropriate VSCA record in each
INCLUDE record in the project. This ‘best practice’ simplifies any subsequent
tuning of the relative variances among GPS and conventional observations.

2. A VSCA record is also the only way to scale the entire project; the top-level
project record (which in all other ways is identical to an INCLUDE record) does
not support numeric variance scaling but can reference a VSCA record.
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11.16 UNCR - Uncertainty Model

An uncertainty model describing sigma, ppm, and centering errors1.

Record Editor Fields

Enabled: When checked, the record will be included in the network adjust-
ment

Label: Unique label used to identify this record

At Cent Err: Centering error to apply at the At point

From Cent Err: Centering error to apply at the From point

To Cent Err: Centering error to apply at the To point

PPM: Parts per million error to apply to the measurement

Sigma: Additional measurement uncertainty to apply

Notes

1. Not all components of an uncertainty model (UNCR record) are applicable to
all measurement types. For example, a DXYZ record is impacted by From and
To centering errors, but there is no ‘At’ station. salsa will apply the applicable
components of an UNCR model to records that reference it.

Approved for public release, NGA-U-2025-01219



11.17. MEAN - POSITION DERIVED FROM MEAN OF POSITIONS 135

11.17 MEAN - Position Derived from Mean of Positions

A MEAN record specifies a derived position that is calculated as the mean of a group of
points after the adjustment is completed. A MEAN record can be edited in the Project
Navigator and Record Editor. The derived position that the MEAN record specifies will
appear in the Point Confidence Regions table in the Salsa gui. It will also appear in
the .csv, .pts, and .h5 output files.

Record Editor Fields

Enabled: When checked, the derived point will be calculated

Label: Label assigned to the derived point specified by the MEAN record

Positions: List(a) of POSG and POSC record used in the mean calculation

Derived Position Calculation Details

The mean derived point is computed as an unweighted mean position of two or more
adjusted, fixed, or previously computed derived points. The mean derived point is
calculated after the adjustment is completed. For example, consider a structure that
is surveyed at four corners, as depicted in Figure 11.1. For the mean derived point to
correspond to the center of the building, the four corner points must be employed in
the unweighted mean computation. The computed formal uncertainty on the mean
point does not account for the possible error introduced by a failure to symmetrically
survey the structure. However, it is possible to add uncertainty σextra to all compo-
nents of the mean point (i.e. σ2

extra is added to all three diagonal components of the
mean derived point covariance) if the user feels there is unmodeled error in the points
used to compute to mean derived point. The mapping of the formal covariance from
the included points to the mean derived point is discussed in Appendix “Derived Point
Uncertainty Computation”.

Notes

(a) In the .lsa file, the list is a space separated list of position labels. Any position
labels containing a space are enclosed in double quotes.
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The simple mean of the input positions

Four-Sided Structure

•
Position1

•Position2 •Position3

•
Position4

•
Unweighted mean of the positions

Failure to survey symmetrically introduces errors

Four-Sided Structure

•
Position1

•Position2 •Position3

•
Unweighted mean of the positions

The mean is unweighted

Four-Sided Structure

•
Position1

•
Position2

•
Unweighted mean of the positions

Figure 11.1: The unweighted mean will acquire errors if the object of interest is not
surveyed symmetrically. In the left diagram, the four corners of a structure are sur-
veyed and the mean corresponds to the center of the structure. In the middle diagram,
one of the corners of the structure cannot be accessed for survey, and therefore the
mean does not correspond to the center of the structure. In the right diagram, the
unweighted mean is not impacted by the blue uncertainty ellipses.

11.18 ENUO - Position Derived from ENU Offset from Posi-
tion

A ENUO record specifies a derived position that is calculated as an East-North-Up
offset from an adjusted, fixed, or previously computed derived point. The ENUO
derived point is calculated after the adjustment is completed. A ENUO record can be
edited in the Project Navigator and Record Editor. The derived position that the ENUO
record specifies will appear in the Point Confidence Regions table in the Salsa gui. It
will also appear in the .csv, .pts, and .h5 output files.

Record Editor Fields

Enabled: When checked, the derived point will be calculated

From: Label for the adjusted position that defines the origin of the ENU offset

To: Label assigned to the derived point specified by the ENUO record

Delta E,N,U: East, North, Up offsets

Sigma E,N,U: East, North, Up offset uncertainties

Derived Position Calculation Details

To apply the provided ENU offset vector to the “from” point specified and thus obtain
the derived point, the ENU offset vector is rotated from the ENU frame to the ECEF
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XYZ frame and then added to the ECEF XYZ “from” point position:
Xf

Yf

Zf

 =


X0

Y0

Z0

+


− sinλ0 − cosλ0 sinϕ0 cosλ0 cosϕ0

cosλ0 − sinλ0 sinϕ0 sinλ0 cosϕ0

0 cosϕ0 sinϕ0




∆E

∆N

∆U

 (11.1)

where {X0, Y0, Z0} are the ECEF XYZ coordinates of the “from” position and {ϕ0, λ0} are
the corresponding latitude and longitude values. The mapping of the formal covari-
ance for the ENUO derived point is discussed in Appendix “Derived Point Uncertainty
Computation”.
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Chapter 12

The LSA File Format Specification

Note: Legal limits for the strings and numeric values composing LSA records are listed in lsaValidationSpec.xlsx,
which is installed along-side this User Manual, in the SALSA documentation folder. The output decimal precision for
these values are defined there as well. LSA records that contain values not conforming to these limits or are otherwise
malformed will yield parse warnings in SALSA.

### Whitespace Delimited ###
- In general, this syntax is space-delimited.
- Any number of adjacent white space characters (spaces and tabs) will be treated as a single delimiter.
- Any labels or filenames containing spaces must be enclosed in double quotes.
- Blank lines are preserved by the .lsa file parser but not displayed in the salsa gui.
- An exception to this is the text notes field, delimited by its <TXNS> </TXNS> tags.

### Comments and Disabled Records ###
- Any line starting with a # is either a comment or a disabled record.
- The parser will attempt to parse any line that begins with a # as a record.

- If the line parses successfully, the line is stored as a disabled record.
- If the parse fails, the line is stored as a comment.

### LSA Record Specifications ###
- In general, one line of the file corresponds to one record.
- If the parser encounters a record ending with "...", it will continue parsing the record on the next line.
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- Each record begins with a unique 4 letter designation for the record type.
- Fields enclosed in <angled braces> are required.
- Fields enclosed in [brackets] are optional.
- The OR symbol (|) indicates a number valid values for a location.
- All records (except comments) having associated General Notes gain the notes field [<TXNS></TXNS>] on save.

### Positions ###
POSG <sta_name> [Flt|Con|Fix][N|E|U] <degrees | D M S> <N|S> <degrees | D M S> <E|W> <Height> <cm|m|ft> [ortho]
[CovNN CovNE CovNU CovEE CovEU CovUU][VSCA<VALUE val>|<label>][AUTOGEN] [<TXNS></TXNS>]

POSC <sta_name> [Flt|Con|Fix][N|E|U] <X Y Z m|km|ft>
[CovXX CovXY CovXZ CovYY CovYZ CovZZ][VSCA<VALUE val>|<label>][AUTOGEN] [<TXNS></TXNS>]

NOTE: the Flt|Con|Fix and N|E|U options for POSG and POSC store the values displayed in the gui. Logically
incompatible parameter combinations such as ’NE + Fix’ are valid and should be fully supported as part
of the LSA file spec. These inconsistencies are resolved when flattening the LSA tree to the .dat file.

### Measurements ###
DXYZ <FROM> <TO> <dX dY dZ m|km|ft> <cxx cxy cxz cyy cyz czz>
[HFROM<label>|<ht cm|m|ft hts cm|m|ft>][HTO<label>|<ht cm|m|ft hts cm|m|ft>][UNCR label]
[VSCA<VALUE val>|<label>] [<TXNS></TXNS>]

DIST <FROM> <TO> <distance> <sigma cm|km|m|ft>
[HFROM<label>|<ht cm|m|ft hts cm|m|ft>][HTO<label>|<ht cm|m|ft hts cm|m|ft>][UNCR label]
[VSCA<VALUE val>|<label>] [<TXNS></TXNS>]

HANG <FROM> <AT> <TO> <degrees> [min sec DMS] <sigma rad|deg|soa>
[HFROM<label>|<ht cm|m|ft hts cm|m|ft>][HTO<label>|<ht cm|m|ft hts cm|m|ft>][UNCR label][REDUCED]
[VSCA<VALUE val>|<label>] [<TXNS></TXNS>]

ZANG <FROM> <TO> <degrees> [min sec DMS] <sigma rad|deg|soa>
[HFROM<label>|<ht cm|m|ft hts cm|m|ft>][HTO<label>|<ht cm|m|ft hts cm|m|ft>][UNCR label][REFRACT coeff][REDUCED]
[VSCA<VALUE val>|<label>]
[<TXNS></TXNS>]

VANG <FROM> <TO> <degrees> [min sec DMS] <sigma rad|deg|soa>
[HFROM<label>|<ht cm|m|ft hts cm|m|ft>][HTO<label>|<ht cm|m|ft hts cm|m|ft>][UNCR label][REFRACT coeff][REDUCED]
[VSCA<VALUE val>|<label>]
[<TXNS></TXNS>]

AZIM <FROM> <TO> <N|S> <degrees> [min sec DMS] <sigma rad|deg|soa>
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[HFROM<label>|<ht cm|m|ft hts cm|m|ft>][HTO<label>|<ht cm|m|ft hts cm|m|ft>][UNCR label][REDUCED]
[VSCA<VALUE val>|<label>] [<TXNS></TXNS>]

HDIF <FROM> <TO> <ht diff> <sigma cm|m|ft>
[UNCR label][REFRACT coeff][REDUCED][VSCA VALUE value | label][CURV] [OHC] [<TXNS></TXNS>]

### Directions and Direction Groups ###
DGRP <dir_group> <AT> [UNCR label][REDUCED][VSCA VALUE value | label] [<TXNS></TXNS>]
HDIR <dir_group> <TO> [*+*|-]<degrees> [min sec DMS] <sigma rad|deg|soa> [HTO <label>|<ht cm|m|ft hts cm|m|ft>]
[<TXNS></TXNS>]

## Modifiers
UNCR <tag> <sigma> <cm|m|ft|rad|deg|soa> <PPM> <AT cent error> <FROM cent error> <TO cent error> <cm|m|ft>
[<TXNS></TXNS>]
VSCA <tag> <scale factor> [TOPARENT] [<TXNS></TXNS>]
HGHT <tag> <height> <cm|m|ft> <heightSigma> <cm|m|ft> [<TXNS></TXNS>]

## Derived Measurements
MEAN <NEW_POINT> <sigma cm|km|m|ft> [POINT] [POINT] [POINT] ... [<TXNS></TXNS>]
ENUO <FROM> <NEW_POINT> <dE dN dU m|km|ft> <se sn su> [<TXNS></TXNS>]

A
p
p
roved

for
p
u

b
lic

release,
N

G
A

-U
-2

0
2
5
-0

1
2
1
9



142 CHAPTER 12. THE LSA FILE FORMAT SPECIFICATION

Approved for public release, NGA-U-2025-01219



Chapter 13

The DAT File Format Specification

The solver input data is contained in a flat text file (the “DAT file,” usually with exten-
sion .dat) with its own format as documented here.

Notes on the format:

# DAT files are ASCII and whitespace-delimited with one record per line
# Labels (From, At, To) denote positions (Points or POS records)
# Each POS record (Point) must have a unique label;
# but not all labels need have a POS record.
# keywords are in ALL CAPS
# POS ... CONS c[c’] constrain the position solution to a plane[line]
# using c,c’ = one of{XYZ} OR {NEU} and c != c’
# Note that covariance is required for POS with ADJ
# FIX : Point is constant (not adjusted);
# ADJ : use position as a priori information and adjust control point;
# EST or blank: use position only as a priori.
# LUNIT means linear unit MM|M|CM|KM|FT
# AUNIT means angular unit RAD|DEG|SOA but not DMS
# DMS denotes ’deg/min/sec’ (int/int/float) and follows angle given by deg min sec
# NB in the angle records "angle sig AUNIT" means angle and sigma
# both have unit AUNIT; consider "angle AUNIT sig AUNIT"
# fcsig acsig and tcsig are centering errors on From, At and To stations in LUNITs
# CORR is optional but must be followed by corrections in the order shown;
# use zero placeholders.
# ht[f|t] is height at From|To; target height diff. is implemented using From+To
# refract is a float refraction, and CURV, OHC and GEOID are keywords meaning
# apply curvature, orthometric height and (DOV, undulation) corrections,
# respectively.
# Title is for output only
# comment lines begin with ’#’ and are ignored; also #-to-EOL is ignored
#
# Tags: each measurement record (all measurements+DirSet+Dir+POS ADJ)
# can be given an optional tag with the field tag=TAG
# where TAG is the user’s tag. This field MUST BE THE LAST FIELD on the line.
# This tag will be used in generating
# "data names" in the solver, rather than simply numbering them;
# the number will be used when a tag is not found.
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# The user MUST use unique tags; failure to do so will cause the solver
# to throw an exception.

The records are defined as follows, each a single line (even though some lines here
are wrapped), beginning with a keyword.

Configuration records.

# Configuration: output precision; problem dimension (2D is XY);
# convergence criteria
TITLE title # quotes optional
PREC eps UNIT [eps UNIT] # output precision; linear and/or angular units
DIM 2|3 # dimension of the problem; 2D is XY only, i.e. Z’s ignored
CONV [n ITER] [d CONV] # convergence criteria; either or both
CONFIDENCE alpha # confidence for Chi squ test (0 < alpha < 1)
OUT [NOAPV] [APQUIT] # output NOAPV = do not scale covariance with APV
OUT [NOAPV] [APQUIT] # output APQUIT = quit after ComputeAPriori()
GEOIDFILE filename # Filename for the gridded EGM08 geoid file
INTERPOLATION method # Geoid Interpolation method (bicubic, bilinear)
HASH string # GUI may want to pass hash through solver to binary file
COMMENT ... # comment that is echoed in output file
GEOID <file> # geoid file

Position (site or Point) record.

# no corrections; constraints c one[two] of XYZ|NEU
POS label X Y Z [covxx xy xz yy yz zz] LUNIT [FIX|ADJ|EST] [CONS c[c]]
# undocumented
POS label D M S N|S D M S E|W Ht LUNIT [covxx xy xz yy yz zz [NEU] LUNIT]

[FIX|ADJ|EST] [CONS c[c]]

POS label X Y Z covxx xy xz yy yz zz LUNIT FIX|ADJ|EST CONS c[c]
POS label X Y Z covxx xy xz yy yz zz LUNIT FIX|ADJ|EST
POS label X Y Z covxx xy xz yy yz zz LUNIT CONS c[c]
POS label X Y Z LUNIT FIX|EST CONS c[c]
POS label X Y Z LUNIT FIX|EST
POS label X Y Z LUNIT CONS c[c]
POS label D M S N|S D M S E|W Ht LUNIT covxx xy xz yy yz zz NEU LUNIT FIX|ADJ|EST

CONS c[c]
POS label D M S N|S D M S E|W Ht LUNIT covxx xy xz yy yz zz NEU LUNIT FIX|ADJ|EST
POS label D M S N|S D M S E|W Ht LUNIT covxx xy xz yy yz zz NEU LUNIT

CONS c[c]
POS label D M S N|S D M S E|W Ht LUNIT covxx xy xz yy yz zz LUNIT FIX|ADJ|EST

CONS c[c]
POS label D M S N|S D M S E|W Ht LUNIT covxx xy xz yy yz zz LUNIT FIX|ADJ|EST
POS label D M S N|S D M S E|W Ht LUNIT covxx xy xz yy yz zz LUNIT

CONS c[c]
POS label D M S N|S D M S E|W Ht LUNIT FIX|EST

CONS c[c]
POS label D M S N|S D M S E|W Ht LUNIT FIX|EST
POS label D M S N|S D M S E|W Ht LUNIT

CONS c[c]
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Measurement records (again, one per line even though some are wrapped here).

# 3-D delta XYZ (Delta)
DEL labFr labTo dX dY dZ covxx xy xz yy yz zz [asig [PPM]] [fcsig tcsig] LUNIT

[CORR htf htt [LUNIT]]

# Distance (Dist)
DIS labFr labTo distance sig [asig [PPM]] [fcsig tcsig] LUNIT

[CORR htf htt [LUNIT] [refract]]

# height (Height) GEOID if orthometric and undulation correction must be applied
HGT labFr labTo height sig [asig [PPM]] LUNIT [CORR [refract]

[CURV] [GEOID]]

# Azimuth (Azimuth)
AZM labFr labTo angle [min sec DMS|AUNIT] sig [asig] AUNIT [fcsig tcsig LUNIT]

[CORR htf htt [LUNIT] [GEOID]]

# Horizonal angle (HAngle)
HAN labFr labAt labTo angle [min sec DMS|AUNIT] sig [asig] AUNIT [fc ac tc LUNIT]

[CORR htf htt [LUNIT] [GEOID]]

# Direction set and Direction (each complete set used to create set of HANs)
# Set = { One DIRSET + >1 DIR with one "group" string};
# group for each set must be unique and identical throughout set
# Zero or one DIR in a set -> set is ignored - no HANs can be constructed
# DIRs where group does not appear in a DIRSET are ignored
DIRSET group labAt [ac LUNIT] [CORR GEOID]
DIR group labTo angle [min sec DMS|AUNIT] sig [asig] AUNIT [tc LUNIT]

[CORR htt [LUNIT]]

# Vertical angle (VAngle)
VAN labFr labTo angle [min sec DMS|AUNIT] sig [asig] AUNIT [fc tc LUNIT]

[CORR htf htt [LUNIT] [refract] [GEOID]]

# Zenith angle (ZAngle)
ZAN labFr labTo angle [min sec DMS|AUNIT] sig [asig] AUNIT [ac tc LUNIT]

[CORR htf htt [LUNIT] [refract] [GEOID]]

A table showing which records have centering, sigma, PPM and various corrections.

centering --sigs-- -------corrections--------- notes
FC AC TC sig PPM HI/HT DOV Undul Refrac Curv

POS - - - y - - - - - - also constraints

DEL y - y y y y - - - - GNSS relative position

DIS y - y y y y - - y -

HGT - - - y y - y y y y Orthometric/ellipsoid
as [GEOID]
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AZM y - y y - y y - - -

HAN y y y y - y y - - -

VAN y - y y - y y y y - keyword GEOID:
geodetic or not

ZAN y - y y - y y y y - keyword GEOID:
geodetic or not

Examples.

# example
DIRSET A00 TOWER1 0.001 M
DIR A00 TOWER2 0 0 0.0 DMS 15 SOA 0.001 M # no heights
DIR A00 TOWER3 62 41 38.2 DMS 15 SOA 0.001 M # no ht
DIR A00 TOWER 95 57 16.0 DMS 15 SOA 0.001 M # no ht

DIRSET A01 TOWER2 0.001 M
DIR A01 TOWER1 0 0 0.0 DMS 15 SOA 0.001 M CORR 1.508 M
DIR A01 TOWER3 311 46 17.9 DMS 15 SOA 0.001 M CORR 1.407 M
DIR A01 TOWER 314 29 32.2 DMS 15 SOA 0.001 M CORR 0.000 M

DIRSET A02 TOWER3 0.001 M
DIR A02 TOWER1 0 0 0.0 DMS 15 SOA 0.001 M CORR 1.508 M
DIR A02 TOWER2 69 4 34.5 DMS 15 SOA 0.001 M CORR 1.449 M
DIR A02 TOWER 255 47 15.4 DMS 15 SOA 0.001 M CORR 0.000 M
DIR A02 TOWERB 255 59 27.0 DMS 60 SOA 0.001 M CORR 0.000 M

# Extraction. block string creates groups, groups are extracted with
# final nominal value and full covariance.
# Option to store solution in binary file, reload just for extraction.
# Does not apply to data, as such, b/c measurements of same thing can be repeated.
EXTR blk POS label (3)
EXTR blk DEL labFr labTo (3)
EXTR blk DIS labFr labTo
EXTR blk HGT labFr labTo
EXTR blk AZM labFr labTo
EXTR blk HAN labFr labAt labTo
EXTR blk VAN labFr labTo
EXTR blk ZAN labFr labTo
EXTR blk DIRSET group
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Preprocessor command-line
reference

lsapreprocessor, Ver. 1.0.0, Run 2016/01/29 at 09:40:47
Usage: lsapreprocessor [option] ...
Program lsapreprocessor will read an input file and ...
Input is on the command line, or of the same format in a file (see --file below);
lines in that file which begin with ’#’ are ignored. Accepted options are
shown below, followed by a description, with default value, if any, in ().

# File I/O:
--file <name> Name of file containing more options [#-EOL=comment] [repeat] ()
--out <name> Name of output file ()
--outpath <path> Path for output file ()
--input <name> Name of input file(s) ()
--inpath <path> Path for input file ()

# Help:
--validate Read input and test its validity, then quit (don’t)
--verbose Print extended output information (don’t)
--debug Print debug output at level 0 [debug<n> for level n=1-7] (-1)
--help Print this and quit (don’t)
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Solver command-line reference

lsasolver, Ver. 0.5.0 9/22/15, Run 2015/10/08 at 11:32:53
Usage: lsasolver [option] ...
Program lsasolver will read an input file and ...
Input is on the command line, or of the same format in a file (see --file below);
lines in that file which begin with ’#’ are ignored. Accepted options are
shown below, followed by a description, with default value, if any, in ().

# File I/O:
--file <name> Name of file containing more options [#-EOL = comment]
--out <name> Name of output file ()
--outpath <path> Path for output file ()
--input <name> Name of input file(s) ()
--inpath <path> Path for input file ()

# Program control:
--apquit Quit after computing a priori positions (don’t)

# Algorithm [*overwrite DAT file input; default if no DAT input]:
--niter <n> Limit on the number of iterations (default 15) [*] (-1)
--conv <frac> Convergence criterion (default 1.0e-08) [*] (0.00)
--2D Solve a true 2D problem (ignore Z) (don’t)
--noAPV Leave covariance in relative units (default F) [*] (don’t)
--APV Scale covariance to physical units (default T) [*] (don’t)
--alpha <prob> Significance level of Chi-squared test [0<prob<1] (0.050)
--SOA Express angle equations in seconds-of-arc (don’t)
--allowCOM Allow a priori computation to return center-of-mass solution
--statsAll Output chi squared and data snooping at every iteration
--calcExtRelVect Calculate external reliability values

# Geoid:
--geoidfile <name> Name of geoid file ()
--geoidpath <path> Path for geoid file ()
--interpolation <method> Geoid interpolation method [bicubic,bilinear] (bicubic)

# Output:
--eqnout <file> Output observation equations to this file ()
--bin <file> Output results for GUI to file in CSV format ()
--csv <file> Output final positions and errors to CSV format file ()
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--extr <"str"> Extraction string (EXTR tag TYP label[s]) [repeat] ()
--westLon Output west longitude (don’t)
--datout <file> Output a complete DAT file after adjustment ()
--progress Output to stdout summary information, incl. at each iteration

# Help:
--validate Read input and test its validity, then quit (don’t)
--verbose Print extended output information (don’t)
--debug Print debug output at level 0 [debug<n> for level n=1-7] (-1)
--timing Print timing information (don’t)
--help Print this and quit (don’t)
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IOB-to-LSA command-line
reference

iobconverter, Ver. 1.0.0, Run 2016/01/29 at 09:42:38
Usage: iob2lsa [option] ...
Program iobconverter will read an .iob file and convert it

and included files (if any) to .lsa files. Input is on the command line.
Accepted options are shown below, followed by a description,
with default value, if any, in ().

# File I/O:
--lsa <name> Name of output .lsa file ()
--iob <name> Name of input .iob file(s) ()
--lsapath <path> Path for output .lsa file ()
--iobpath <path> Path for input .iob file ()

# File I/O:
--warn <name> Name of output .wrn file ()
--warnpath <path> Path for output .wrn file ()
--project Add include record for lsa option file (don’t)
--projdir <path> .lsa files created within this directory ()

# Help:
--validate Read input and test its validity, then quit (don’t)
--verbose Print extended output information (don’t)
--debug Print debug output at level 0 [debug<n> for level n=1-7] (-1)
--help Print this and quit (don’t)
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Postprocessor command-line
reference

lsapost, Ver. 2.1 1/21/16 rev, SALSA Ver. 1.0.0 Jan 29 2016 09:27:15,
Run 2016/01/29 at 09:44:28

Usage: lsapost [option] ...
Program lsapost will read an input file and ...
Input is on the command line, or of the same format in a file (see --file below);
lines in that file which begin with ’#’ are ignored. Accepted options are
shown below, followed by a description, with default value, if any, in ().

# File I/O:
--file <name> Name of file containing more options [#-EOL=comment][repeat]()
--log <name> Name of output log file ()
--logpath <path> Path for output log file ()
--bin <name> Name of input file - required ()
--binpath <path> Path for input file ()
--dat <name> Name of input DAT file (ignore all but EXTR) ()
--datpath <path> Path for input DAT file ()

# Data input:
--extr <"str"> Extraction string (EXTR tag TYP label[s]) [repeat] ()
--comment <"str"> Comments added to the output, including pts file [repeat] ()

# Geoid input:
--geoidfile <name> Name of geoid file ()
--geoidfile2 <name> Name of second geoid file ()
--geoidpath <path> Path for geoid file(s) ()
--interp <method> Geoid interpolation method [bicubic or bilinear] (bicubic)
--interp2 <method> Geoid interpolation method for second geoid (bicubic)

# Data Output:
--ptsfile <name> Write ’Points file’ to this filename ()
--csvfile <name> Write CSV file to this filename ()
--noAPV Leave covariance in relative units (default F) (don’t)

# Output:
--dump Dump the binary data to the log file (don’t)
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--westLon Output west longitude (don’t)
--linprec Output linear precision (M) (3)
--angprecM Output angular precision (SOA) for measurements (3)
--angprecP Output angular precision (SOA) for positions (LLH) (9)
--warningExtRelVect Output warning threshold (M) for external reliability
--errorExtRelVect Output error threshold (M) for external reliability
--confid Confidence factor (for ptsfile), one of 1sig,90,95 (1sig)

# Help:
--validate Read input and test its validity, then quit (don’t)
--verbose Print extended output information (don’t)
--debug Print debug output at level 0 [debug<n> for level n=1-7] (-1)
--help Print this and quit (don’t)
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Appendix A

Derived Point Uncertainty
Computation

Derived points in a SALSA project are computed after the adjustment process via two
possible methods:

1. Computing the mean of two or more adjusted, fixed, or previously computed
derived points - see section 11.17

2. Applying an East-North-Up offset vector from an adjusted, fixed, or previously
computed derived point - see section 11.18

These derived points can be employed in the Station Inverse dialog box, which is
intended to provide the user with various metrics that relate the states of two user-
selected stations. However, in order to have appropriate uncertainty values for these
metrics when one or both stations are derived points, the derived point covariance
values and associated cross covariance values relative to all other points (including
other derived points) must be computed.

Computing Full Formal Covariance For Mean Derived Points

To compute the covariance and cross covariance values associated with a mean de-
rived point, first the partial derivative matrix is computed, which contains the partial
derivatives of the augmented covariance containing the mean derived point with re-
spect to the original full state covariance. The partial derivative matrix contains the
identity matrix for the original states with respect to the original states (all 1’s along
the diagonal). All partial derivative values of the derived point with respect to the
points employed in the mean calculation are 1/nmean for each position component,
where nmean is the total number points employed in the mean calculation. All other
partials derivative values are zero.

161



162 APPENDIX A. DERIVED POINT UNCERTAINTY COMPUTATION

The original full state covariance is then mapped to the new augmented covariance
containing the mean derived point by pre- and post-multiplying by the partial deriva-
tive matrix:

CovNew = P CovOriginal P
T (A.1)

where P is the partial derivative matrix. If multiple derived points are specified, the
mapped covariance for each individual derived point serves as the original covariance
for the next calculated derived point (and thus the derived points are always processed
in the appropriate order based on how they are defined).

If any fixed points (which are not contained in the original full covariance) are used to
compute a mean derived point, the covariance is expanded by 3 columns and 3 rows,
all containing zeros. This new augmented “input” covariance is then used in equation
A.1 above, with the final covariance containing only the original full covariance (no
fixed points) and the new mean derived point covariance values. Because all covari-
ance values associated with these fixed points are zero, this step is only employed to
simplify the required bookkeeping of the states.

After mapping the covariance, it is possible to inflate the uncertainty of the new mean
point by adding σ2

extra to all three diagonal components of the mean derived point
covariance. This uncertainty inflation may be desired if the user feels there is un-
modeled error in the points used to compute the mean derived point.

Computing Full Formal Covariance For ENU Offset Derived
Points

To compute the covariance and cross covariance values associated with a ENU offset
derived point, the same analytical partials approach is employed as for the mean
derived point covariance calculation. However, there are a few extra steps involved.

First the user-provided 1-σ values are used to form the offset vector covariance:

CovENU
off =


σ2

E 0 0

0 σ2
N 0

0 0 σ2
U

 (A.2)

The CovENU
off matrix is then rotated into the ECEF XYZ frame:

CovXYZ
off = RENU2ECEF CovENU

off RT
ENU2ECEF,

RENU2ECEF =


− sinλ0 − cosλ0 sinϕ0 cosλ0 cosϕ0

cosλ0 − sinλ0 sinϕ0 sinλ0 cosϕ0

0 cosϕ0 sinϕ0

 .
(A.3)
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where ϕ0 and λ0 are the geodetic latitude and longitude values of the “from” position.

For ENU offset derived points that originate at fixed points, CovXYZ
off is the final derived

point covariance and all cross covariance terms are zero. Thus the final modified
covariance including the ENU derived point is

CovNew =

 CovOriginal 0

0 CovXYZ
off

 (A.4)

For ENU offset derived points that originate at adjusted or other derived points, the
bottom right 3x3 sub-matrix of an augmented “input” matrix is set equal to CovXYZ

off :

CovAugIn =

 CovOriginal 0

0 CovXYZ
off

 (A.5)

The matrix CovAugIn is then mapped using a partial derivative matrix P . Within that
partials matrix, all diagonal entries for the original state with respect to the original
state are 1’s (identity); all partials of derived point components with respect to the
“from” point associated components are 1; and all partials of the derived point with
respect to the offset vector are 1 (a 3x3 identity matrix in the bottom right 3x3 sub-
matrix of the partials matrix). Finally, the partial derivative matrix is applied to the
input augmented covariance CovAugIn:

CovNew = P CovAugIn P T (A.6)
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Appendix B

Reliability and Standard Residuals

The geometry and number of observations obtained for a particular survey can heavily
impact the final solution, the associated formal uncertainty of that solution, and the
“reliability” of that solution. The term “reliability” refers to the robustness of the
survey to significant biases and blunders in the observations.

There are three primary reliability metrics than can be computed for each observa-
tion employed in a survey: local reliability, otherwise known as redundancy, derived
in section B.1; internal reliability, otherwise known as the minimum detectable bias,
derived in section B.2; and external reliability vectors, which are the minimum de-
tectable bias values mapped through the state update equation, derived in section
B.3. The magnitude of the external reliability vectors can provide a sense of the rel-
ative impact a minimum detectable bias has on the state (e.g. each position that is
estimated), and thus the RSS (root-sum-square) magnitude is computed and provided
for each observation. The external reliability vectors can be bounded by a “reliability
rectangle” which provides a visual indication of the impact any lack of reliability in
the observations has on the final estimated positions.

Overall these reliability metrics provide the surveyor a sense of susceptibility in the
estimated positions to blunders and outliers in the observations, and thus where
they may want/need to strengthen their network of observations by adding more ob-
servations and/or improving the geometry of those observations (e.g. adding range
measurements in the direction of the rectangle major axis) in order to obtain a suffi-
ciently reliable solution and formal covariance. The reliability metrics can also be part
of the final deliverable product to customers, informing the reliability of the solutions
and covariance provided.

In addition to reliability metrics, standard residuals are computed for each observa-
tion of a survey adjustment, and are provided in the “Measurement Residuals” table
within the SALSA UI. This appendix details the derivation and utility of these values
when employing SALSA in a survey adjustment.
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B.1 Redundancy

The redundancy metric, also known as the “partial redundancy” and “local reliability”
value, indicates how susceptible the solution is to errors in that observation, and thus
larger redundancy values are better than small values. If there are observations with
very small redundancy values, more observations may be needed (thus increasing the
redundancy) to safeguard against blunders or outliers in those observations.

First the relationship between the observations vector Y and the post-fit raw residuals
vector Rraw is derived:

Rraw = Y −Hx̂

= Y −H Cov HT MCov−1 Y

= QRR MCov−1 Y
= R Y

(B.1)

where H is the measurements partials derivatives matrix with respect to the estimated
state, x̂ is the estimated state, Cov is the post-fit formal estimated state covariance,
MCov is the prescribed measurement noise covariance matrix, R is the redundancy
matrix (the diagonals of which are the redundancy values ri for each observation),
and QRR is the “residuals cofactor matrix”:

QRR = MCov −H Cov HT (B.2)

R = QRR MCov−1 represents the linear transformation between the observations and
the residuals, or the “proportionality factor” between gross errors and the residuals.

Thus the effect on an individual residual Rraw,i from an individual blunder ∆Yi on
observation i is

∆Rraw,i =
QRRii

MCovii
∆Yi

= ri ∆Yi

(B.3)

Thus the vector of individual redundancy values for each observation can be assem-
bled from the diagonal elements of R:

Rd = [r1 r2 · · · ]
=

[
QRR,11MCov−1

11 QRR,22MCov−1
22 · · ·

] (B.4)

where QRR,ii is the ith diagonal element of QRR, and MCov−1
ii is the ith diagonal element

of inverted measurement noise covariance MCov−1.

The redundancy value ri varies from 0 to 1:

• A redundancy of 0 indicates no redundancy at all in the observation, and thus
there is no impact on the residual (which remains zero). Any error in the ob-
servation goes straight into the state, and thus it is impossible to identify any
blunders.
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• A redundancy of 1 indicates perfect redundancy that is achievable only with
infinite observations, thus a value of 1 is never actually achieved, but rather
approached as the number of redundant measurements increases. Any error in
the observation is almost perfectly reflected in the residual, almost none of the
error will go into the solution, and thus it is trivial to identify the blunder.

Note how in equation B.2 the post-fit formal state covariance Cov is mapped into the
measurement space via H. If any of the states map 1-to-1 into the measurement
space (i.e. there is only measurement for a particular state), mapping the state co-
variance value into measurement space via H produces a covariance value for that
observation that is equal to the measurement noise covariance value for that observa-
tion, and thus the difference value when computing QRR is zero (i.e. the redundancy
is zero). As the number of observations associated with a particular state increases,
the magnitude of the associated post-fit formal state uncertainty drops, the result-
ing mapped covariance for those observations drops, the associated values in QRR

approach the associated measurement noise covariance matrix MCov, and thus the
associated redundancy values in R = QRR MCov−1 approach 1.

Also note how the redundancy values are not at all dependent on the actual observa-
tion values: only the structure of the survey adjustment (i.e. the geometry, types, and
number of observations obtained) affects the redundancy values. Thus surveyors can
employ SALSA to ensure all observations have reasonable redundancy when design-
ing the structure of the survey. Ghilani [1] states “The redundancy numbers provide
insight into the geometric strength of the adjustment.” He also states “Redundancy
numbers above 0.5 are generally sufficient to provide well-checked observations.”

The sum of the redundancy values for all observations, i.e. the trace of R or the sum
of Rd, is equal to the degrees of freedom NDOF of the estimation problem:∑

i

ri = NDOF = Nobs −Nunknowns (B.5)

where Nobs is the total number of observations and Nunknowns is the number of esti-
mated states. Thus NDOF can be thought of as the overall redundancy of the survey
adjustment, and an individual redundancy value is the share of that overall redun-
dancy attributed to the corresponding individual observation.

B.2 Standard Residuals

The standard residual is a metric often used to identify and correct potentially erro-
neous, unreasonable, or problematic measurements (e.g. from user blunders during
the survey, or outliers resulting from unmodeled forces with large tails). Also known
as “standardized” residuals, or “studentized” residuals, standard residual values are
computed for every observation in SALSA adjustments. The process of reviewing the
standard residuals and removing or correcting any problematic observations is often
called “data snooping” in the literature.
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B.2.1 Supporting quantities

To compute the standard residual value for an observation, several other quantities
are first needed. First the relative residual vector is computed:

Rrel =
c
√

MCov
−1

Rraw

(
c
√

MCov c
√

MCov
T
= MCov

)
(B.6)

where c
√

MCov is the Cholesky decomposition [19] of the measurement noise covari-
ance matrix MCov.

Next the Chi-Squared metric [1] is computed for the entire adjustment:

χ2 = (RMS (Rrel))
2Nobs (B.7)

where RMS (Rrel) is the root-mean-square of the relative residual vector Rrel.

The a posteriori variance of unit weight (APV) is easily computed from the Chi-Squared
metric:

APV = χ2/NDOF (B.8)

B.2.2 Standard residual derivation

A standard residual value is actually a test metric computed for a hypothesis test:

H0 : E[∆Yi] = 0

HA : E[∆Yi] ̸= 0
(B.9)

where ∆Yi is a potential blunder on observation i, H0 is the hypothesis that observa-
tion i is not an outlier, and HA is the hypothesis that observation i is an outlier.

The test metric is a standard z-test metric, dividing the potential blunder ∆Yi by the
uncertainty of that potential blunder:

TX =
∆Yi
σ∆Yi

(B.10)

The uncertainty value σ∆Yi is computed as

σ2
∆Yi

=

(
∂Yi

∂Rraw,i

)2

σ2
Rraw

=

(
MCovii
QRR,ii

)2

(APV QRR,ii)

= APV
MCov2ii
QRR,ii

σ∆Yi =
√

APV
MCovii√
QRR,ii

(B.11)
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where the raw residual variance σ2
Rraw

= APV QRR,ii, and the partial derivative ∂Yi
∂Rraw,i

is obtained from equation B.3.

The test metric TX (i.e. standard residual) is then computed:

TX =
∆Yi
σ∆Yi

=
MCovii
QRR,ii

Rraw,i

√
QRR,ii√

APV MCovii

=
Rraw,i√

APV QRR,ii

=
Rraw,i/

√
MCovii√

APV QRR,ii/MCovii
=

Rrel,i√
APV ri

(B.12)

The standard residuals for all observations, collected into a vector, is

Rstd =
[
Rrel,1/

√
APV · r1 Rrel,2/

√
APV · r2 · · ·

]
(B.13)

Thus the standard residual is a further “normalization” of the relative residual in-
volving the APV and the redundancy of the measurement. Note that having the re-
dundancy value in the denominator of each standard residual value means that if
the redundancy is very small, the standard residual may be especially high and thus
less reliable as a blunder test (described in more detail below). If a measurement’s
redundancy is zero (undesirable for any measurement in any survey), the associated
standard residual is infinite (and thus not computable).

B.2.3 Standard residual test threshold

After computing the standard residual value, the value is compared to a threshold
based on a user-provided confidence value and assumed probability density function
(PDF) in order to ascertain whether the hypothesis test passes or fails. A visualization
of this threshold is provided via the “accepted” and “rejected” regions in figure B.1,
along with the PDF fX , standard residual test metric TX , and significance level α that
defines the threshold.

The significance level α = 1 − Confidence, where Confidence is the confidence value
provided by the user, is typically equal to 0.95 or 0.99 (95% or 99%). For example, if
the user specifies a 99% confidence level, α = 0.01.

The most common PDF employed in a standard hypothesis test is the classic Gaussian
(i.e. normal) distribution, for which regions of acceptance (i.e. H0 is declared true)
are:

• ≈ ±1.96 for α = 0.05 (95% confidence)

• ≈ ±2.58 for α = 0.01 (99% confidence)

• ≈ ±3.29 for α = 0.001 (99.9% confidence)
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Figure B.1: Hypothesis test

Ghilani [1] states “In practice, authors have reported that a value of 3.29 also works
as a criterion for rejection of blunders.”

However, the use of the Gaussian distribution is applicable only when the possible
values for the standard residuals can extend infinitely in the positive or negative
direction. When the a priori variance of unit weight, which describes how the least
squares weighting matrix and the inverse of the measurement noise covariance are
related (and thus is typically equal to identity), is used in lieu of the APV in equations
B.12 and B.13, as described in Ghilani [1] and Leick [3], the assumption of infinite
tails for the standard residual is reasonable. But when the APV is used as described
in equations B.12 and B.13, a different distribution is needed: the tau distribution,
as described in section B.2.4.

B.2.4 Tau distribution

Unlike the standard residual formulations provided in Ghilani [1] and Leick [3], a
different convention is employed in Vanicek & Krakiwsky (Chapter 13) [24] and Deakin
[25]: the APV is employed in the standard residual, as described in equations B.12
and B.13. As a result of employing the APV, the standard residuals have finite limits.
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To derive these limits, first the standard residual is reformatted:

Rstd,i =
Rrel,i√
APV · ri

=
Rrel,i√

(RMS(Rrel))2Nobs
NDOF

ri

=
Rrel,i√

(
∑m

j=1 R
2
rel,j/Nobs)Nobs

NDOF
ri

=
Rrel,i√∑m
j=1R

2
rel,j

√
NDOF√
ri

(B.14)

As a particular relative residual Rrel,i approaches infinity, the finite limit of the stan-
dard residual is revealed:

Rstd,i → ±
√
NDOF√
ri

as Rrel,i → ±∞ (B.15)

Note that the standard residual formulation in equations B.12 and B.13 is also re-
ferred to as an “internally studentized residual”. In this formulation, the APV value
is computed using all post-fit observation residuals, including any potential outliers.
Because any anomalous residuals are included in the computation of the APV, which
is in turn used to “studentize” or “standardize” the residuals, as a particular obser-
vation residual approaches infinity, the corresponding standard residual approaches
the finite limit shown in equation B.15. An alternative formulation is the “externally
studentized residual”, in which the APV does not include potential outliers. This
formulation can have infinite limits as a result, but is not widely used.

When a scenario has non-infinite DOF, which is true for any adjustment performed
in SALSA, alternatives to the Gaussian distribution are more representative of the
relevant PDFs. One commonly used alternative is Student’s t-distribution. However,
the t-distribution has infinite tails, unlike the standard residual formulation in equa-
tions B.12 and B.13. Thus a different alternative is employed: the tau distribution,
as described in Pope [26], and Thompson [27], and as illustrated in figure B.2.

Note how in figure B.2 the tau distribution with DOF ν = 4 has finite limits of ±2,
and as the number of DOF increases, the tau distribution approaches the normal
distribution (like the t-distribution).

The tau distribution is closely tied to the t-distribution:

τν =
tν−1

√
ν√

ν − 1 + t2ν−1

(B.16)

where tν−1 is the t-distribution with ν − 1 DOF.
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Figure B.2: Tau distribution for different DOF (ν)

If the value of t within equation B.16 approaches infinity, the finite limit of the tau
distribution is revealed (suppressing subscripts):

lim
t→±∞

τ = lim
t→±∞

t
√
ν√

ν − 1 + t2
=

√
ν lim
t→±∞

t√
ν − 1 + t2

= ±
√
ν (B.17)

To summarize, because the standard residual formulation provided in equations B.12
and B.13 has non-infinite limits, the tau distribution is the most appropriate distri-
bution to use when computing thresholds for hypothesis testing: if the probability of
standard residual values beyond those finite limits is zero, the PDF employed should
reflect that reality. This reality also implies that if the a priori variance of unit weight
(typically identity) is employed rather than the APV when computing standard resid-
uals, a distribution with infinite tails such as the normal or t-distribution is more
appropriate.

Readers may note that the finite limits in equations B.15 and B.17 are not identical:
the standard residuals are bounded by ±

√
ν√
ri

, while the tau distribution is bounded by

±
√
ν. Section B.2.5 details how the tau distribution is scaled by 1√

ri
to appropriately

account for the finite limits of the standard residuals.

B.2.5 Computing Threshold Values For Tau Distribution

To compute the hypothesis test threshold value using the tau distribution, first a
confidence interval value must be specified. The value employed within SALSA is 95%,
or 0.95, which corresponds to a significance level α = 0.05. If a larger confidence value
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is employed, the threshold values become larger, and thus fewer standard residuals
will fail the statistical test.

SALSA employs a “two-sided” hypothesis test: the 5% rejection region includes the
area under the PDF curve for both sides of the distribution, as depicted in figure
B.1. Because the tau distribution is symmetric, the area under the PDF curve for the
right-side tail is α/2 = 0.025. And because the shape of the PDF depends on the DOF
ν, as depicted in figure B.2, the x-axis boundaries of the rejection regions depend on
the DOF ν.

The x-axis boundary value for the right-side tail, which is the hypothesis test thresh-
old magnitude value of interest and is also referred to as the “critical value”, has
a CDF of 1 − 0.025 = 0.975. (The cumulative distribution function, CDF, is the area
under the PDF from negative infinity to a specified critical value.) Thus an “inverse
CDF” function is needed: given the particular CDF of 0.975, the inverse CDF function
obtains the x-axis value corresponding to that CDF.

The relationship between the tau distribution and the t-distribution (equation B.16)
allows the use of the GPSTk t-distribution inverse CDF function invStudentsCDF to
compute the tau distribution threshold:

tν−1 = invStudentsCDF (1− α/2, ν − 1)

τν = tν−1 ·
√
ν/

√
ν − 1 + t2ν−1

Test Threshold = τν/
√
ri

(B.18)

The method provided in equation B.18 works for all scenarios with DOF equal to 2 or
greater. When the DOF equals 0 (exactly determined system with no redundancy) or 1
(only a single degree of freedom for the entire survey), the standard residual threshold
is not computed. However, scenarios with DOF equal to 0 or 1 are unlikely to occur
for real-world surveys (though they might occur for simple toy problems set up for
analysis and troubleshooting).

B.3 Internal Reliability

Internal reliability, also known as the minimum detectable bias for a particular ob-
servation, is based on two confidence (probability) threshold values, the measurement
uncertainty, and the redundancy (local reliability) metric. The two threshold values
are:

• α = Probability the observation is considered a blunder, when it is actually not

• β = Probability the observation is not considered a blunder, when it actually is

Common values are α = 0.01 and β = 0.05. Figure B.3 provides a visual representa-
tion of the “no blunder” (i.e. null) and “blunder” hypotheses. Both hypotheses are
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Figure B.3: Relationship between α, β, and δ

assumed to have Gaussian (i.e. standard, or normal) distribution, and the blunder
hypothesis has a non-zero mean value. That non-zero mean value, also equal to the
distance between the center of each distribution, is referred to as the “non-centrality
parameter” δ0. For α = 0.01 and β = 0.05, the non-centrality parameter is δ0 = 4.22068.

To compute the minimum detectable bias, the minimum gross error ∇Yi is set equal
to the gross error ∆Ŷi which produces a test statistic TN equal to δ0:

TN = ∆Ŷi/σ∆Ŷi
= δ0 (B.19)

However, instead of setting σ∆Ŷi
equal to the expression for σ∆Yi provided by equation

B.11 to derive the final expression for TN , a slightly different expression is used:

σ∆Ŷi
=

MCovii√
QRR,ii

(B.20)

where the
√

APV term has been removed. Why is
√

APV not employed? Leick [3]
provides an explanation: “Baarda’s (1967) development of the concept of reliability of
networks is based on un-Studentized hypothesis tests, which means that the a priori
variance of unit weight is assumed to be known. Consequently, the a priori variance of
unit weight (not the a posteriori variance of unit weight) is used in this section.” The a
priori variance of unit weight is assumed equal to identity, and thus the expression is
simplified to the form in equation B.20. A significant benefit of this revision is that the
internal reliability metric (and thus the external reliability metric as defined in section
B.4) for each observation is not dependent on any actual observations collected in the
field, and thus can serve as a powerful planning tool prior to the survey.
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The minimum detectable bias is then computed as:

∇Ŷi = δ0 σ∆Ŷi

= δ0
MCovii√
QRRii

= δ0
MCovii√
QRRii

QRRii

MCovii

1

ri

= δ0

√
QRRii

ri

= δ0

√
ri MCovii

ri

= δ0

√
MCovii√

ri

(B.21)

For a given δ0 and MCovii, a larger redundancy number means a smaller minimum
detectable bias. In other words, the minimum detectable bias is inversely propor-
tional to the square root of the individual redundancy value. An observation with low
redundancy and thus a large minimum detectable bias can potentially significantly
derail the estimated state (i.e. adjusted position), as illustrated in section B.5.

B.4 External Reliability

External reliability is calculated by mapping the minimum detectable blunders for
each observation through the state update operation, which provides the impact on
the estimated state from that blunder:

∇x̂i =
(
HT MCov−1 H

)−1
HT MCov−1 ∇Ŷi (B.22)

where ∇Ŷi is a vector of m elements which are all equal to zero except the ith element,
which has value ∇Ŷi:

∇Ŷi =
[
0 . . . 0 ∇Ŷi 0 . . . 0

]T
(B.23)

The result is an array of “state impact” vectors, one for each observation. Lower
redundancy leads to a larger minimum detectable bias, which in turn leads to larger
state impact vectors.

To visualize these state impact vectors, a ”Reliability Rectangle” is constructed, as
illustrated in figure B.4. This rectangle allows the user to quickly grasp the effect that
strong or weak redundancy in the observations has on the final state. The result is
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intuitive and actionable information for the surveyor regarding the susceptibility of
any planned or collected observations to blunders or significant outliers.

A reliability rectangle is defined by the following properties:

• The rectangle is centered at the estimated state position (or the a priori position
if the survey has not yet been conducted)

• All external reliability vectors are rotated into the ENU frame, using the above
center position as the reference position for that rotation

• The rectangle is oriented such that the major axis direction matches the direction
of the largest magnitude state vector, and the scaling of the rectangle in that
direction matches the magnitude of the largest magnitude state vector

• The smaller dimension of the rectangle is scaled to fit all the other external
reliability vectors

Figure B.4: Example reliability rectangle
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B.5 Examples

Below are two “toy problems” that illustrate the utility of the above metrics for survey-
ors. While a typical survey has many more observations than these simple examples,
employing relatively few observations in these examples hopefully allows the reader
to more easily grasp the nature of the reliability metrics and how they are computed
for each observation.

B.5.1 Range Example

The first simple example employs range observations from several stations to estimate
a desired position, as illustrated by figure B.5. Note that the example contains no
specific distance units. The position of interest is located at [0,10], with the true
position matching the a priori nominal position to simplify the example. The ranging
station positions are fixed at [0,0], [1,0], and [10,10]. Measurement noise of 0.01 1-σ
is added to the observations, and a measurement uncertainty of 0.01 1-σ is employed
in the estimation process (and thus all measurements have equal weight).
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Figure B.5: Ranging example - map
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Figure B.6 provides a zoomed-in view of the region around the point of interest. The
formal uncertainty is visible via the 3-σ formal covariance ellipse, which appears rea-
sonably sized in both directions. In contract, the magnitude of the reliability rectangle
is large in the East-West direction - far larger than the formal covariance scaling in
the East-West direction. The lack of redundancy in the East-West direction from hav-
ing only one ranging station to the East of the estimated position results in a large
reliability rectangle magnitude.

Figure B.6: Ranging example - zoomed map
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To demonstrate what a reliability rectangle illustrates, the minimum detectable bias
computed for the East station range observation is added to that observation, as
shown in figure B.7. The result: the estimated position now lies approximately on the
western edge of the reliability rectangle. (The estimated position lands exactly on the
edge if no measurement noise is added.)

Figure B.7: Ranging example - east station blunder
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To illustrate how the estimated position is so heavily affected by a blunder in a low
redundancy observation, each of the ranging observations can be viewed as a circle
with radius equal to the range value, as shown in figure B.8:

Figure B.8: Ranging example - observations as circles
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Zooming in on the point of interest, figure B.9 shows the estimated position is now
0.6 units to the west, just as in figure B.7. The least squares estimation process
identifies the position that minimizes the sum of the squared pre-fit residuals, which
means the estimated position lies on the “Obs 3” line between the “Obs 1” and “Obs
2” lines - the best place to minimize those residuals. The low redundancy of the east
station observation allows this large blunder to significantly affect the state.

Figure B.9: Ranging example - observations as circles
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The pre-fit and post-fit observation residuals for the blunder scenario are provided
in figures B.10 and B.11. Note that while the third pre-fit residual (corresponding to
the East station range observation) is clearly the largest residual, the third post-fit
residual is reasonably close to zero and smaller than the other two residuals. Thus
an analysis of the post-fit residuals can easily miss any blunders or outliers in ob-
servations that have poor redundancy, and these blunders or outliers can also lead
to the rejection of good observations if the surveyor does not address this lack of re-
dundancy (e.g. throwing out observation two in this scenario, as it has the largest
magnitude post-fit residual).

Figure B.10: Ranging example - east station blunder pre-fit residuals
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Figure B.11: Ranging example - east station blunder post-fit residuals
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The redundancy values (local reliability) for the three observations highlight how the
third observation has almost no redundancy, as shown in figure B.12.

Figure B.12: Ranging example - redundancy values
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The minimum detectable bias values (internal reliability) for the three observations,
as shown in figure B.13, reveals how the third observation has a significantly larger
magnitude due to the poor redundancy of that observation:

Figure B.13: Ranging example - minimum detectable bias values
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The external reliability vector magnitudes for the three observations, as shown in
figure B.14, similarly shows the third observation has a much larger magnitude than
the other two observations:

Figure B.14: Ranging example - external reliability vector magnitudes
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The post-fit residuals plotted in figure B.11 can be transformed into standard resid-
uals, as described in section B.2. The results are provided in figure B.15. Note that
even though the observation 3 has the blunder, the largest standard residual magni-
tude occurs for observation 2. Thus if the surveyor only checks the standard residual
magnitudes and ignores the redundancy, internal reliability, and external reliability
metrics, a good observation can be excluded and a blunder can remain. In other
words, standard residuals can prove unreliable in identifying blunders if sufficient
redundancy is not established for all observations.

Figure B.15: Ranging example - standard residuals with east station blunder
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Given the wide reliability rectangle presented in figure B.6, a good course of action
is to add observations that provide redundancy in the east-west direction. Figure
B.16 illustrates the result of adding two ranging stations to the east (neither of which
contain blunders, but the blunder for observation 3 remains):

Figure B.16: Ranging example - adding additional observations
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Zooming in on the point of interest, figure B.17 shows the estimated position is ap-
proximately 0.2 units to the west, rather than 0.6 as seen in figure B.9. The positive
influence of the additional measurements results in a smaller impact on the estimated
state from the observation 3 blunder.

Figure B.17: Ranging example - adding additional observations - zoomed
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Now that all observations have reasonable redundancy, the standard residuals now
correctly identify the blunderous observation, as shown in figure B.18.

Figure B.18: Ranging example - adding additional observations - standard residuals

B.5.2 Angles Example

An analogous example to the ranges-only example involves only azimuth angle obser-
vations, as shown in figure B.19. As in the previous example, the position of interest
is located at [0,10], measurement noise of 0.1◦ 1-σ is employed, and the measurement
uncertainty is also set as 0.1◦ 1-σ.
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Figure B.19: Angles example - map
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Figure B.20 provides a zoomed-in view of the region around the point of interest, with
the formal uncertainty and reliability rectangle more visible. Unlike in Example 1,
the reliability rectangle has large magnitude in the North-South axis due to lack of
redundancy in that direction from having only one station to the East providing a
direction observation.

Figure B.20: Angles example - zoomed map
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The redundancy values (local reliability) for the three observations highlight how the
third observation has almost no redundancy, as shown in figure B.21.

Figure B.21: Angles example - redundancy values
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The minimum detectable bias values (internal reliability) for the three observations,
as shown in figure B.22, reveals how the third observation has a significantly larger
magnitude due to the poor redundancy of that observation:

Figure B.22: Angles example - minimum detectable bias values
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The external reliability vector magnitudes for the three observations, as shown in
figure B.23, similarly shows the third observation has a much larger magnitude than
the other two observations:

Figure B.23: Angles example - external reliability vector magnitudes
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Just as in the ranges example above, the minimum detectable bias computed for
the East station range observation is added to that observation, as shown in figure
B.24. The result: the estimated position now lies approximately on the northern edge
of the reliability rectangle. (The estimated position lands exactly on the edge if no
measurement noise is added.)

Figure B.24: Angles example - east station blunder
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Again just as in the ranges example above, the standard residuals do not reveal that
the east station observation has a blunder, due to the lack of redundancy for that
observation, as shown in figure B.25.

Figure B.25: Angles example - standard residuals with east station blunder
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To address the lack of redundancy, another station can be added to the east, as
shown in figure B.26.

Figure B.26: Angles example - adding additional observations
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Zooming in on the estimated position reveals the impact of this additional observation
on the reliability rectangle, as shown in figure B.27:

Figure B.27: Angles example - adding additional observations
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B.6 User Actions

After an adjustment is processed, the surveyor should first verify that all observations
have sufficient redundancy and no estimated points have unacceptably large reliabil-
ity rectangles. Without good redundancy and reliability for each observation, metrics
like standard residuals are not reliable indicators of potential blunders in the system.

Once good redundancy and reliability of all observations has been established, the
standard residuals can be evaluated. If the standard residual test metric magnitude
computed in equation B.12 for a particular observation exceeds the threshold com-
puted in equation B.18, the standard residual value is displayed as red text in the
Measurement Residuals table.

The user may wish to check each of these marked observations for blunders, with a
focus on the data and/or sites involved in that measurement. Note that one blunder
can affect many other quantities in the adjustment (estimated states and post-fit
residuals). Thus the user is strongly encouraged to look for and correct only one
blunder at a time, starting with the observation that has the largest standard residual
test metric. After fixing that largest blunder, the user should re-run the adjustment
and determine via the standard residuals (and other metrics such as the Chi-Squared
Test) if more investigation is needed. Note that if the method of “fixing” the largest
blunder results in poor redundancy/reliability, see above - the standard residuals
may not be reliable anymore.

An important note: due to how the standard residual threshold is computed in equa-
tion B.18, if the redundancy value for an observation is low, the threshold value can
become quite large. As a result, an observation with a large standard residual and low
redundancy can still pass the hypothesis test and not be marked as red. Yet another
reason it is vital to ensure all observations have reasonable redundancy. If the user
encounters such an observation, we recommend the user collect more observations
as needed to address the lack of redundancy in the survey itself if at all possible. If
it is not possible, we recommend still investigating the largest residuals, even if they
are not marked as failed the hypothesis test.

The user may also encounter smaller standard residuals that fail the hypothesis test
and thus are marked as red. These observations likely have strong redundancy and
small prescribed measurement uncertainty, and thus the relatively small raw residual
is still large enough to fail the standard residuals hypothesis test. GPS vector obser-
vations often fall into this category, because GPS vector uncertainties are notoriously
optimistic. Thus the user can likely ignore these relatively small standard residu-
als without significant impact on the final adjustment solution. If the user is feeling
ambitious though, he or she can increase the prescribed uncertainty for that obser-
vation type, likely making that uncertainty more realistic and changing the standard
residuals hypothesis test to passing.

One final note: the user should also keep an eye on the Chi-Squared global fit test to
determine if there are any blunders remaining in the observations. If in the unlikely
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event there are large standard residuals but due to low redundancy values none of
those residual fail the hypothesis test, it is like the Chi-Squared test will still fail.
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Appendix C

Definitions and Acronyms

CG Conjugate Gradient (least squares solution method)

CLI Command-Line Interface

DMS Degrees, Minutes, Seconds

ECEF Earth-centered Earth-fixed (Cartesian reference frame)

GNSS Global Navigation Satellite Systems

GPS Global Positioning System

GUI Graphical User Interface

HDF Hierarchical Data Format

SALSA Surveyor’s Applications for Least Squares Adjustment

SOA Seconds of Arc

SRIF Square Root Information Filter (least squares solution method)

WGS 84 World Geodetic System 1984
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Appendix D

Conversion of Instrumentation
Output

Instrument and File Types Supported

At time of writing, salsa can import from the following instrument or file types; each
of these converters is available under the Import menu:

• GeoLab format, typically .iob

• Leica Sets of Angles format, typically .log or .txt

• Trimble Data Exchange Format, typically .asc

• grape/merge Precise Point Positioning format, typically .log

• OPUS Precise Point Positioning format, typically .opus

• Leica Levels data, typically .gsi. Both GSI-8 and GSI-16 data formats are sup-
ported. Only BF and BFFB line leveling methods are currently supported.

• Leica Geo Office ASCII exports, typically .asc

Metadata

When converting third-party instrument output files into salsa’s .lsa format, a com-
ment will be placed at the top of the resulting .lsa file that indicates what converter
was used to convert the file, what the source file was, and when the conversion took
place.

Any information contained in the third-party output files that provides additional
background on how that file was generated, such as the instrument type used, the
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instrument serial number, what version of software generated the output, when the
file was generated, etc., will also pass through to the resulting .lsa file as a comment.

Order Preservation

To the extent possible, records in the .lsa file will appear in the order that the in-
formation appears in the third-party instrument output file. The order may not be
exactly the same because some .lsa records require information that may be scat-
tered throughout the instrument output file. For instance, a ZANG record contains, in
addition to the zenith angle measurement, the name of the From site, the instrument
height offset at that site, the name of the To site, and the target height offset at that
site. This information may be scattered throughout the instrument output file, and it
isn’t until it has all been collected that the ZANG record can be written to the .lsa
file.

Auto-generated Labels

Some .lsa records are referred to by measurement records by their labels. Examples
of these records are instrument/target height offset records (HGHT), records describ-
ing the error model, including the centering errors, for a type of measurement (UNCR),
and records that indicate of which set a particular set of directions are part (DGRP).
When created within salsa, using the Record Editor, the user may chose whatever
descriptive label they wish for their referent records. However, when converting from
third-party instrument output files, these labels are auto-generated. The scheme for
generating these labels is as follows:

1. DGRP labels will appear in the .lsa as DGRP#1, DGRP#2, etc., in the order that
sets of directions appear in the instrument output file.

2. HGHT labels will appear in the .lsa as HGHT#1 StationName,
HGHT#1 DifferentStationName, HGHT#2 StationName, etc. The label will contain
the station name, and the number will be incremented in the .lsa file depending
upon how many times the instrument/target height offset at that station has
been redefined.

3. UNCR labels will appear in the .lsa as UNCR#1 MeasurementType, including
the type of measurement in the label. These labels are primiarily placeholders
for the user to add additional information based upon their understanding of the
instrument/target setup or measurement conditions. As this information is not
available during conversion, only one uncertainty record for a given measure-
ment type will appear in each resulting .lsa file. The default centering error for
the At/From/To stations is set at 1 mm.
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Importing Into SALSA

When inserting instrumentation output files into a salsa project via the Record →
Insert → Include from... feature, salsa will automatically attempt to make the auto-
generated labels unique to avoid duplication of labels throughout the project. There-
fore, if two instrument output files containing a single set of horizontal directions are
inserted into a project, the first Include record in the project would contain an uncer-
tainty record with a label of UNCR#1 HDIR, and a direction group label of DGRP#1,
while the second Include record in the project would contain an uncertainty record
with a label of UNCR#2 HDIR, and a direction group label of DGRP#2.

Leica Sets of Angles Measurement Uncertainties

The user can configure the conversion process to assign default measurement un-
certainties to the measurements in a .log or .txt file, or to accept the instrument-
assigned uncertainties on the measurements (see Section 3.8.1). If the user opts
to accept the instrument-assigned uncertainties, the following procedure is followed
to derive the standard deviations of each measurement. For a given Set Results
section of the file (e.g. Horizontal Set Results, Vertical Set Results, and
Distance Results), containing some number of sets, N, and some number of points:

1. The mean value of each measurement, M , to a point is taken as the Mean of all Sets
value for Vertical and Horizontal Sets, and the Mean Distance Of All Sets for
Distances.

2. The individual measurements to each point, Mi, are taken as the Reduced Mean
values for Hz Results Of Single Sets, the Mean Of Face I/II values for
V Results Of Single Sets, and the Mean Of Face I and II values for Distance
Results Of Single Sets.

3. The standard deviation over N sets for measurement M to a point is then σ =√∑N
i=1(M−Mi)

2

N .

4. If the calculated standard deviation for a direction happens to be less than
1 second of arc, then the standard deviation for that direction is set to the
Standard Deviation Of Single Measurement. This covers the case when
there is only one set, or when the reduced mean of a single set is 0 for all sets
(which seems to be the case for the starting direction).

5. If the Mean Of Face I and II value for a distance measurement is zero, it is
treated as the mean value when computing the standard deviation.
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Appendix E

Understanding the Solver output

This Appendix describes, in more detail than the text in Chapter 4 “Understanding
the Solver,” how to interpret parts of the output file of the solver. An example from a
real, non-trivial run of the solver is presented and examined.

Consider the section of the solver output called “Final Solution” near the bottom of
the file. This begins with a table of all the measurement data including measurements
and residuals. The table is followed by a list of the three entries in the table with the
largest standard residuals. Then comes the summary of statistics that is described in
Chapter 4.

[Note that the printed precision of numbers in this table is controlled by the solver
options --linprec --angprecM and --angprecP. In addition, the solver will also
print this table at each iteration if the --verbose option is found (also with standard
residuals if --statsAll). See the solver command line reference Chapter 13.]
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Data and residuals (Final)
Label Meas(m|DMS) Nomin(m|DMS) Pre-R(m|soa) Post-R(m|soa) Rel-Res Std-Res Redund Int-Rel(m|SOA) Ext-Rel-E(m) Ext-Rel-N(m) Ext-Rel-U(m) Ext-Rel-Mag
Del.T8(VNDP-OSS_TP1)X -682.22620 -682.22080 -0.00181 -0.00540 -1.47760 -1.60865 0.5659 0.02058 0.01111 0.00349 -0.00251 0.01191
Del.T8(VNDP-OSS_TP1)Y 1183.31220 1183.31748 -0.00145 -0.00528 -0.45181 -0.53724 0.4760 0.02615 -0.00888 0.00505 -0.00608 0.01189
Del.T8(VNDP-OSS_TP1)Z 1215.35160 1215.35195 -0.00275 -0.00035 -0.73950 -0.90598 0.4427 0.01981 0.00122 0.00952 0.00449 0.01060
Del.T9(5N-OSS_TP1)X -3333.41390 -3333.42650 0.01619 0.01260 1.90033 1.66670 0.8686 0.03005 0.00313 0.00138 -0.00216 0.00404
Del.T9(5N-OSS_TP1)Y -3034.89880 -3034.91172 0.01675 0.01292 1.11493 0.95988 0.8963 0.03529 -0.00167 0.00195 -0.00258 0.00364
Del.T9(5N-OSS_TP1)Z -6138.44080 -6138.43635 -0.00685 -0.00445 -0.11113 -0.09554 0.9017 0.03134 0.00006 0.00269 0.00135 0.00301
Del.T10(VNDP-OSS_TP2)X -639.20240 -639.19906 0.17191 -0.00334 -0.83647 -0.88349 0.5973 0.02182 -0.00004 0.00472 -0.00173 0.01336
Del.T10(VNDP-OSS_TP2)Y 1143.13750 1143.14303 -2.17457 -0.00553 -0.89714 -1.18186 0.3823 0.03075 -0.00190 -0.00173 -0.00529 0.01603
Del.T10(VNDP-OSS_TP2)Z 1195.07860 1195.07789 -1.72257 0.00071 -0.22129 -0.29052 0.3888 0.02230 -0.00403 0.00244 0.00299 0.01318
Del.T11(5N-OSS_TP2)X -3290.38760 -3290.40476 0.19241 0.01716 2.39202 2.08804 0.8709 0.03236 0.00005 0.00148 -0.00159 0.00419
Del.T11(5N-OSS_TP2)Y -3075.06890 -3075.08617 -2.15177 0.01727 1.22928 1.05730 0.9039 0.03847 -0.00034 -0.00002 -0.00195 0.00375
Del.T11(5N-OSS_TP2)Z -6158.71370 -6158.71041 -1.72657 -0.00329 0.15504 0.13371 0.8955 0.03227 -0.00103 0.00047 0.00111 0.00329
Del.T12(VNDP-OSS_TP3)X -691.84980 -691.84291 -0.37619 -0.00689 -1.57596 -1.56023 0.6833 0.02238 0.00409 -0.00380 -0.00143 0.01174
Del.T12(VNDP-OSS_TP3)Y 1158.97540 1158.98088 -2.77565 -0.00548 0.01523 0.01859 0.4480 0.03091 -0.00149 0.00792 -0.00441 0.01408
Del.T12(VNDP-OSS_TP3)Z 1173.01550 1173.01021 0.04978 0.00529 0.88973 1.07754 0.4563 0.02135 0.00279 0.00257 0.00206 0.01116
Del.T13(5N-OSS_TP3)X -3343.03330 -3343.04861 -0.35399 0.01531 1.88901 1.61984 0.9083 0.03591 0.00121 -0.00072 -0.00123 0.00354
Del.T13(5N-OSS_TP3)Y -3059.23540 -3059.24832 -2.75725 0.01292 0.53935 0.45882 0.9245 0.04236 -0.00015 0.00161 -0.00165 0.00317
Del.T13(5N-OSS_TP3)Z -6180.78090 -6180.77809 0.04168 -0.00281 0.15331 0.13104 0.9171 0.03315 0.00061 0.00048 0.00100 0.00286
Dis.T7(newPOSG-OSS_TP2) 26.00000 26.00413 -1.72816 -0.00413 -0.01376 -0.01124 0.9993 1.26625 -0.00002 0.00002 -0.00001 0.00007
Han.T14(OSS_TP2-OSS_TP1) 62 41 38.0 62 41 39.5 -9866.8 -1.5 -0.2 -0.3 0.3036 55.19650 0.00262 -0.00296 0.00008 0.00395
Han.T15(OSS_TP1-OSS_TP2) 311 46 17.9 311 46 20.7 -2440.1 -2.8 -0.4 -0.6 0.3112 51.56637 -0.00120 -0.00346 0.00002 0.00466
Han.T16(OSS_TP1-OSS_TP3) 69 4 34.7 69 4 41.2 7421.3 -6.5 -0.5 -0.5 0.6983 66.00486 -0.00138 -0.00014 -0.00002 0.00195
Zan.T17(OSS_TP1-OSS_TP2) 91 0 8.3 90 59 59.7 -1739.2 8.7 0.9 0.9 0.6543 51.56637 -0.00034 -0.00010 0.00243 0.00309
Zan.T18(OSS_TP1-OSS_TP3) 93 9 35.9 93 9 35.6 -9234.2 0.4 0.0 0.1 0.3217 70.13019 0.00005 -0.00065 0.00403 0.00648
Zan.T19(OSS_TP2-OSS_TP1) 89 0 8.7 89 0 2.4 1754.2 6.3 0.6 0.6 0.6543 51.56637 0.00034 0.00010 -0.00243 0.00309
Zan.T20(OSS_TP2-OSS_TP3) 91 36 16.5 91 36 12.9 -5737.0 3.6 0.4 0.4 0.4995 59.81692 0.00047 -0.00024 0.00001 0.00490

Largest 3 external reliability vector magnitudes:
Del.T10(VNDP-OSS_TP2)Y 1143.13750 1143.14303 -2.17457 -0.00553 -0.89714 -1.18186 0.3823 0.03075 -0.00190 -0.00173 -0.00529 0.01603
Del.T12(VNDP-OSS_TP3)Y 1158.97540 1158.98088 -2.77565 -0.00548 0.01523 0.01859 0.4480 0.03091 -0.00149 0.00792 -0.00441 0.01408
Del.T10(VNDP-OSS_TP2)X -639.20240 -639.19906 0.17191 -0.00334 -0.83647 -0.88349 0.5973 0.02182 -0.00004 0.00472 -0.00173 0.01336

Largest 3 standard residuals (** denotes possible blunder: threshold based on Tau distribution and redundancy for each obs)
Del.T11(5N-OSS_TP2)X -3290.38760 -3290.40476 0.19241 0.01716 2.39202 2.08804 0.8709 0.03236 0.00005 0.00148 -0.00159 0.00419
Del.T9(5N-OSS_TP1)X -3333.41390 -3333.42650 0.01619 0.01260 1.90033 1.66670 0.8686 0.03005 0.00313 0.00138 -0.00216 0.00404
Del.T13(5N-OSS_TP3)X -3343.03330 -3343.04861 -0.35399 0.01531 1.88901 1.61984 0.9083 0.03591 0.00121 -0.00072 -0.00123 0.00354

RMS post-fit relative residual (Final) = 9.37613e-01
Degrees of freedom = 17; Std dev of unit weight = 1.22461; APV = 1.49967 (Final)
RMS post-fit raw residual (angles) (Final) = 2.5e-05 rad = 5.1e+00 soa.
RMS post-fit raw residual (length) (Final) = 9.11888e-03 m.
Chi-squared test lower bound (0.050): 0.510 < 1.500 pass
Chi-squared test upper bound (0.950): 1.500 < 1.623 pass
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Consider each of the columns of this table in turn (some of the column labels have
been shortened in the table above to save space).

Column 1 Label. This is the label that the solver uses to identify the measurements.
It is of the form type.label(From-To)[XYZ], which consists of (a) the 3-letter measure-
ment type from the input file (Dis = distance, Zan = zenith angle, etc.), (b) a unique
label, which will be a number unless “tag=label” appears with the measurement in
the input file, and (c) the labels for the Points involved in the measurement separated
by dashes, usually just From-To, although horizontal angles will have From-At-To.
Delta measurements (always in groups of 3) will also have a coordinate (X,Y,Z) at the
end, since the measurement is a 3-vector.

For example, Del.T6(VNDP-TP1)Y is the Y-component of the delta measurement from
Point VNDP to Point TP1; Zan.T16(TP1-TP3) is the zenith angle from Point TP1 to
Point TP3.

Column 2 Meas(m|DMS). This is the measurement as read from the input file. Angles
are expressed in DMS and linear measurements in meters.

Column 3 Nomin(m|DMS). This is the nominal or “predicted” value of the measure-
ment, meaning the value computed using the current positions of all the Points.

Column 4 Pre-R(m|soa). The pre-residual is simply the difference “Measured minus
Nominal,” using the current value for the Nominal (which is shown in column 3). In
the final solution (after the last iteration) this means the Nominal as computed from
the final adjusted Points. It is called “pre” because it is the data computed before (and
passed into) the linear least squares algorithm.

Column 5 Post-R(m|soa). The post-residual is simply the difference “Measured mi-
nus Nominal,” using the a priori value for the Nominal (not shown in the table); it is
the total net residual after (hence “post”) the adjustment. Thus if the a priori position
of a Point is not very good (e.g. it had to be computed by the solver), this post-residual
may very well be large.

Column 6 Rel-Resid. The relative residual is the output of the least squares solu-
tion algorithm at the latest iteration. Thus it indicates how much the measurement
is “in error” according to the algorithm. This quantity is dimensionless, because the
data given to the algorithm (and thus also its output) has been weighted (multiplied)
by the inverse measurement covariance matrix. One can think of it roughly as the
measurement residual in physical units divided by the given uncertainty in that mea-
surement. (Of course this is a rough characterization because the division is actually
a full matrix operation.)

Column 7 Std-Resid. The standard residual, actually a statistical test metric, is
defined in appendix B. This test metric is compared to a threshold computed using a
95% confidence level. Standard residual values exceeding their respective thresholds
are marked with “**” for the user, indicating a possible blunder within the survey
adjustment network (so not necessarily within that measurement). The above table
does not have any standard residuals exceeding their respective thresholds.
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The three largest magnitude standard residual measurements are repeated in a sub-
sequent table, prior to the statistical summary. Note that the standard residual is
undefined for measurements with zero redundancy (which is very undesirable for any
measurement in any survey), resulting in two dashes for the standard residual col-
umn value.

Column 8 Redund. Redundancy is a number between 0 and 1 that is a measure of
the immunity of the estimation to errors in the subject measurement. This column
is the portion of the redundancy of the problem that belongs to this measurement;
the sum of all the redundancies is equal to the degrees of freedom of the problem.
Thus a large degree of freedom implies geometric strength in the estimation, and the
geometry of the network and placement of the measurements are combined to “divide
up” the total redundancy among the measurements.

It helps to think of redundancy in the two extreme cases. First, consider the case
of zero redundancy. Suppose a DXYZ (GNSS vector) involves one fixed Point A and
another unknown Point B; then if no other measurements involve B, then the adjust-
ment determines B simply by adding the DXYZ to A, and there is no more information
pertaining to, and so no freedom to adjust, the measurement to Point B. The redun-
dancy of the DXYZ will be zero (so will the pre-residual and relative residual, the
standard residual is undefined).

Second, consider the case of high redundancy. Suppose one measurement involves
two Points that also are involved in many other measurements. If you imagine per-
turbing that measurement, then the algorithm would respond by adjusting many
other Points and measurements. The measurement is “tied” to many others through
a strong network design. Conversely, all the other measurements to which it is tied
will serve to improve the determination of the measurement’s residual; redundancy
in the network is necessary to identify the measurement as discrepant. Ghilani [1]
has more discussion, including the derivation of redundancy.

Column 9 Int-Rel. Internal reliability, also known as the minimum detectable bias, is
a quantity derived from redundancy. This is the minimum error value for a particular
measurement which can be detected on the basis of elevated standard residuals.

Column 10-12 Ext-Rel-*(m). External reliability is calculated by mapping the inter-
nal reliability to state-space. Columns 10-12 represent the three components (East-
North-Up) of the external reliability vector.

Column 13 Ext-Rel-Mag(m). External reliability magnitude is the magnitude of the
measurement’s external reliability vector. It is the Euclidean norm of the East, North,
and Up components listed in the preceding columns.
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Appendix F

Inverse Configuration Parsing

This chapter is meant to serve as an addendum to Chapter 9 and provide the user
with a more detailed explanation of how Salsa parses the *Inverses.cfg input con-
figuration file. Some examples will also be provided to give the user some additional
context into how the parsing works. The input configuration file is a plain text docu-
ment which has one inverse station pair per file line. The station labels are delimited
by space characters. Note that white space at the beginning and end of the lines are
not important. If the user wishes to have spaces in the labels themselves they must
encase the label string in double quotation marks (”). A table with some example
input configuration lines and how they would appear in the Station Data Dialog box
table can be seen below (note that blank is used to reference an empty string)

Table F.1: Sample Line Parse Results

Sample Line Table Output Notes

oneSite twoSite [oneSite, twoSite]

”one Site” ”two Site” [one Site, two Site] Use of quotations preserves text

oneSite two Site [oneSite, two] Not enclosing two Site with paren-
theses leads to Site getting cut

oneSite twoSite threeSite ... [oneSite, twoSite] Everything after second space is
ignored

oneSite blank [oneSite, blank] If string data is not provided on a
line, empty string will be inserted

blank blank [blank, blank]

213



214 APPENDIX F. INVERSE CONFIGURATION PARSING

Approved for public release, NGA-U-2025-01219



Appendix G

Troubleshooting

Bad Allocation

Figure G.1: Error message for bad allocation.

A failure to allocate enough memory occurs in cases where lsasolver is unable to
load the measurement data into RAM for processing. This generally occurs when
the project is large and the machine has limited physical RAM or if the machine
has already allocated much of its available RAM for other tasks. In some cases, it
is possible to circumvent a memory limitation by increasing the amount of virtual
memory available. The amount of virtual memory needed will of course depend on
the size of the least squares project. In the developers’ experience to date, projects
with up to several thousand degrees of freedom usually run fine on typical desktop
systems with a few GB of RAM, whereas projects with tens of thousands of degrees of
freedom may require something on the order of 10 GB of additional virtual memory
or more. If 10 GB proves insufficient, additional virtual memory can be added so long
as hard drive space permits.

On Windows systems, the virtual memory is maintained in what is known as a paging
file. A user with administrative privileges on a Windows 10 machine should be able
to adjust the virtual memory by performing the following actions:

1. Open Control Panel

2. Go to System
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Figure G.2: Dialog windows for setting virtual memory

3. Click on Advanced system settings on the left pane

4. Click on the Advanced tab on the dialog

5. Click on the Settings button in the Performance section

6. Click on the Advanced tab on the dialog

7. Click on the Change button

8. Specify a custom size for the paging file

9. Click on OK in all dialogs to save settings and close

Included file not found

Figure G.3: Error message from a bad filepath

A user may see a message (similar to figure H.3) indicating a failure to open/include
a file due to one or more potential reasons. First, the file may not exist. Open up a
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file explorer and navigate to the directory containing the file in question, to ensure
it does indeed exist. Second, if that file does indeed exist, the failure may be due to
the existence of special characters in the file path. SALSA does not support special
characters (e.g. £, é, ß) when opening files, and it is suggested that such files be
renamed or moved to a directory containing ASCII only characters.

Solver Outputs and Points Files

After calculating an adjustment for the first time, the user may have trouble viewing
the .csv/.pts files via actions in the View menu. If the SALSA installation is on a
Windows machine which has never had to open a .csv or .pts file, the OS may not
have an executable associated with these file types. To resolve this, try to:

1. Navigate to the project directory with the File Explorer

2. Right click on the .pts/.csv file

3. Select Open with...

4. A Windows menu (see G.4) should appear. Choose Notepad

Following the above steps, any subsequent action to view the .pts file or Solver Output
through the View menu should automatically open the file by launching Notepad.
Notepad comes installed with the Windows OS and should be sufficient. Note that
.csv files are more commonly opened with applications such as Microsoft Excel, which
can be chosen instead of Notepad if installed on the user’s machine.

Figure G.4: Windows file association dialog
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Appendix H

Third Party Software and Libraries

Eigen

The SALSA suite uses the Eigen math library [8] version 3.4.0, licensed under the
Mozilla Public License (MPL) version 2.0 [28]. A copy of the MPL2 license is available
alongside this User Manual, in the SALSA documentation folder. The Eigen source
code may be obtained from the Eigen web site, http://eigen.tuxfamily.org/.

GNSSTk

The SALSA suite employs the GNSS Toolkit (GNSSTk) version 3.18 for geodetic trans-
formations and many other functions. The GNSSTk is licensed under the GNU Lesser
General Public License version 3.0 [29]. A copy of the GNSSTk license, including
the LGPL and the GNU Public License that it references, is available alongside this
User Manual, in the SALSA documentation folder. The GNSSTk source code may be
obtained from the project web site, https://github.com/SGL-UT/GNSSTk.

HDF5

The SALSA suite makes use of the Hierarchical Data Format 5 (HDF5) software library
[30], developed by The HDF Group and by the National Center for Supercomputing
Applications at the University of Illinois at Urbana-Champaign. The HDF5 copyright
notice and license are available alongside this User Manual, in the SALSA documen-
tation folder.
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Marble

The SALSA suite uses the Marble virtual globe and mapping library [31] version 23.04,
licensed under the GNU Lesser General Public License version 2.1 or later [32]. A
copy of the Marble license is available alongside this User Manual, in the SALSA
documentation folder. The Marble source code may be obtained from the Marble web
site, https://quickgit.kde.org/?p=marble.git.

OpenSSL

SALSA includes software developed by the OpenSSL Project for use in the OpenSSL
Toolkit (http://www.openssl.org/).

Python

SALSA is distributed with Python version 3.9 and numerous Python modules. A copy
of the Python Software Foundation License is available alongside this User Manual,
in the SALSA documentation folder. Individual modules’ copyright and license texts
are retained in or alongside the modules’ source files.

QuaZIP

The SALSA suite uses the QuaZIP library version 1.4 to interface with ZIP archives.
QuaZIP is licensed under the GNU Lesser General Public License version 2.1 [32].
A copy of the QuaZIP license is available alongside this User Manual, in the SALSA
documentation folder. The QuaZIP source code may be obtained from the QuaZIP
project page, https://github.com/stachenov/quazip.

Qt

The SALSA suite uses the Qt application framework [33] version 5.18.8, licensed un-
der the GNU Lesser General Public License version 3.0 [29]. A copy of the Qt license,
including the LGPL and the GNU Public License that it references, is available along-
side this User Manual, in the SALSA documentation folder. The Qt source code may
be obtained from the Qt web site, https://www.qt.io/.
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Qwt

The SALSA suite leverages the Qwt project (http://qwt.sf.net) for 2D plotting fea-
tures. Qwt is licensed under the GNU Lesser General Public License version 2.1 [32]
with exceptions to several of the conditions normally imposed by that license. A copy
of the Qwt license is available alongside this User Manual, in the SALSA documenta-
tion folder.
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